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Important safety information
This manual contains information and warnings that must be followed by the user for safe operation and to keep the product in a
safe condition.

To safely perform service on this product, see the Service safety summary that follows the General safety summary.

General safety summary
Use the product only as specified. Review the following safety precautions to avoid injury and prevent damage to this product or
any products connected to it. Carefully read all instructions. Retain these instructions for future reference.

This product shall be used in accordance with local and national codes.

For correct and safe operation of the product, it is essential that you follow generally accepted safety procedures in addition to
the safety precautions specified in this manual.

The product is designed to be used by trained personnel only.

Only qualified personnel who are aware of the hazards involved should remove the cover for repair, maintenance, or adjustment.

Before use, always check the product with a known source to be sure it is operating correctly.

This product is not intended for detection of hazardous voltages.

Use personal protective equipment to prevent shock and arc blast injury where hazardous live conductors are exposed.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other
component manuals for warnings and cautions related to operating the system.

When incorporating this equipment into a system, the safety of that system is the responsibility of the assembler of the system.

To avoid fire or personal injury
Use proper power cord. Use only the power cord specified for this product and certified for the country of use. Do not use the
provided power cord for other products.

Ground the product. This product is grounded through the grounding conductor of the power cord. To avoid electric shock, the
grounding conductor must be connected to earth ground. Before making connections to the input or output terminals of the
product, ensure that the product is properly grounded. Do not disable the power cord grounding connection.

Power disconnect. The power cord disconnects the product from the power source. See instructions for the location. Do not
position the equipment so that it is difficult to operate the power cord; it must remain accessible to the user at all times to allow for
quick disconnection if needed.

Connect and disconnect properly. Do not connect or disconnect probes or test leads while they are connected to a voltage
source. Use only insulated voltage probes, test leads, and adapters supplied with the product, or indicated by Tektronix to be
suitable for the product.

Observe all terminal ratings. To avoid fire or shock hazard, observe all rating and markings on the product. Consult the product
manual for further ratings information before making connections to the product. Do not exceed the Measurement Category
(CAT) rating and voltage or current rating of the lowest rated individual component of a product, probe, or accessory. Use caution
when using 1:1 test leads because the probe tip voltage is directly transmitted to the product.

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.

Do not float the common terminal above the rated voltage for that terminal.

Do not operate without covers. Do not operate this product with covers or panels removed, or with the case open. Hazardous
voltage exposure is possible.
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Avoid exposed circuitry. Do not touch exposed connections and components when power is present.

Do not operate with suspected failures. If you suspect that there is damage to this product, have it inspected by qualified
service personnel.

Disable the product if it is damaged. Do not use the product if it is damaged or operates incorrectly. If in doubt about safety of the
product, turn it off and disconnect the power cord. Clearly mark the product to prevent its further operation.

Before use, inspect voltage probes, test leads, and accessories for mechanical damage and replace when damaged. Do not use
probes or test leads if they are damaged, if there is exposed metal, or if a wear indicator shows.

Examine the exterior of the product before you use it. Look for cracks or missing pieces.

Use only specified replacement parts.

Use proper fuse. Use only the fuse type and rating specified for this product.

Do not operate in wet/damp conditions. Be aware that condensation may occur if a unit is moved from a cold to a warm
environment.

Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry. Remove the input signals before you clean the product.

Provide proper ventilation. Refer to the installation instructions in the manual for details on installing the product so it has
proper ventilation.

Slots and openings are provided for ventilation and should never be covered or otherwise obstructed. Do not push objects into
any of the openings.

Provide a safe working environment. Always place the product in a location convenient for viewing the display and indicators.

Avoid improper or prolonged use of keyboards, pointers, and button pads. Improper or prolonged keyboard or pointer use may
result in serious injury.

Be sure your work area meets applicable ergonomic standards. Consult with an ergonomics professional to avoid stress injuries.

Use only the Tektronix rackmount hardware specified for this product.

Probes and test leads
Before connecting probes or test leads, connect the power cord from the power connector to a properly grounded power outlet.

Keep fingers behind the protective barrier, protective finger guard, or tactile indicator on the probes.

Remove all probes, test leads and accessories that are not in use.

Use only correct Measurement Category (CAT), voltage, temperature, altitude, and amperage rated probes, test leads, and
adapters for any measurement.

Important safety information  
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Beware of high voltages. Understand the voltage ratings for the probe you are using and do not exceed those ratings. Two
ratings are important to know and understand:

■ The maximum measurement voltage from the probe tip to the probe reference lead

■ The maximum floating voltage from the probe reference lead to earth ground

These two voltage ratings depend on the probe and your application. Refer to the Specifications section of the manual for more
information.

WARNING. To prevent electrical shock, do not exceed the maximum measurement or maximum floating voltage for the
oscilloscope input BNC connector, probe tip, or probe reference lead.

Connect and disconnect properly. Connect the probe output to the measurement product before connecting the probe to the
circuit under test. Connect the probe reference lead to the circuit under test before connecting the probe input. Disconnect the
probe input and the probe reference lead from the circuit under test before disconnecting the probe from the measurement
product.

Connect and disconnect properly. De-energize the circuit under test before connecting or disconnecting the current probe.

Connect the probe reference lead to earth ground only.

Do not connect a current probe to any wire that carries voltages or frequencies above the current probe voltage rating.

Inspect the probe and accessories. Before each use, inspect probe and accessories for damage (cuts, tears, or defects in the
probe body, accessories, or cable jacket). Do not use if damaged.

Ground-referenced oscilloscope use. Do not float the reference lead of this probe when using with ground-referenced
oscilloscopes. The reference lead must be connected to earth potential (0 V).

Service safety summary
The Service safety summary section contains additional information required to safely perform service on the product. Only
qualified personnel should perform service procedures. Read this Service safety summary and the General safety summary
before performing any service procedures.

To avoid electric shock. Do not touch exposed connections.

Do not service alone. Do not perform internal service or adjustments of this product unless another person capable of rendering
first aid and resuscitation is present.

Disconnect power. To avoid electric shock, switch off the product power and disconnect the power cord from the mains power
before removing any covers or panels, or opening the case for servicing.

Use care when servicing with power on. Dangerous voltages or currents may exist in this product. Disconnect power, remove
battery (if applicable), and disconnect test leads before removing protective panels, soldering, or replacing components.

Verify safety after repair. Always recheck ground continuity and mains dielectric strength after performing a repair.

Important safety information
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Terms in the manual
These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Terms on the product
These terms may appear on the product:

■ DANGER indicates an injury hazard immediately accessible as you read the marking.

■ WARNING indicates an injury hazard not immediately accessible as you read the marking.

■ CAUTION indicates a hazard to property including the product.

Symbols on the product

When this symbol is marked on the product, be sure to consult the manual to find out the nature of the potential
hazards and any actions which have to be taken to avoid them. (This symbol may also be used to refer the user to
ratings in the manual.)

The following symbols may appear on the product:

Important safety information
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Preface
This manual provides product safety and compliance information, describes how to connect and power on the oscilloscope, and
introduces the basic instrument features, controls, and operations. See the product Help file for more detailed information.

Key features
Welcome to the 3 Series MDO. The 3 Series MDO Oscilloscopes (MDO32 and MDO34) are 2- and 4-channel oscilloscopes,
enabling you to efficiently and cost-effectively perform mixed domain debugging.

■ A dedicated RF input channel for frequency domain measurements

■ Bandwidths from 100 MHz to 1 GHz

■ 2- and 4-channels for time domain measurements

■ Sixteen-channel digital input option

■ Large 11.6” HD (1920 x 1080 pixel) capacitive touchscreen display

■ User interface optimized for touchscreen use

■ Sample rates of 2.5 GS/s on all analog channels (5 GS/s on 1 or 2 channels for the MDO34 or MDO32 with the 1 GHz
option)

■ 10 M points record length on all channels

■ Maximum waveform capture rate: 280,000 waveforms/second, with FastAcq: >50,000 waveforms/second with normal
operation

■ Advanced triggering and analysis: I2C, SPI, USB 2.0, CAN, CAN FD, LIN, FlexRay, RS-232, RS-422, RS-485, UART, I2S,
Left Justified (LJ), Right Justified (RJ), TDM, MIL-STD-1553, ARINC429 (with the appropriate option), and Parallel

■ Power analysis (optional)

■ Arbitrary function generator and 16 digital channels (optional)

■ Digital voltmeter and trigger frequency counter free with product registration
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Related documents
Use the related documents for more information on instrument functions, how to remotely program or operate the instrument,
understand theory of operation, replace suspected modules, and other tasks.

MDO34, MDO32 documents

To learn about Use this document
How to use instrument
functions

3 Series MDO (MDO34, MDO32) Installation and Safety Manual (This document, Tektronix part
number 071-3608-xx); standard accessory with the instrument. Single document with English,
Japanese, and Simplified Chinese languages.
 
3 Series MDO Help (Printable version of the instrument Help that contains context-sensitive
descriptions of all instrument functions; available at www.tek.com/downloads)

How to remotely control the
instrument

3 Series MDO Programmer Manual (Tektronix part number 077-1498-xx; available at
www.tek.com/downloads)

Instrument specifications and
procedures to verify the
instrument meets
specifications

3 Series MDO (MDO34, MDO32) Specifications and Performance Verification Technical
Reference (Tektronix part number 077-1499-xx; available at www.tek.com/downloads)

Instrument theory of operation,
troubleshooting, disassembly,
and replaceable parts

3 Series MDO (MDO34, MDO32) Service Manual (Tektronix part number 077-1500-xx;
available at www.tek.com/downloads)

Installing the instrument in a
rack

RM3 Rack Mount Kit Instructions (Tektronix part number 071-3609-xx; available at
www.tek.com/downloads)

Preface  
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Installing your instrument

Check shipped accessories
Make sure that you received everything you ordered. If anything is missing, contact Tektronix Customer Support. In North
America, call 1-800-833-9200. Worldwide, visit www.tek.com to find contacts in your area.

Check the packing list that came with your instrument to verify that you have received all standard accessories and ordered
items. If you purchased factory options, tap Help > About to confirm that the option(s) are listed in the Installed Options table.

Standard accessories

Item Quantity Tektronix part number
3 Series MDO (MDO34, MDO32) Installation and Safety Manual 1 071-3608-xx
Passive Voltage Probe, depends on instrument bandwidth
    (1 GHz bandwidth)
    (350 MHz and 500 MHz)
    (100 MHz and 200 MHz bandwidth)

One per analog channel
TPP1000
TPP0500B
TPP0250

Accessory bag 1 016-2144-xx
Power cord 1 Depends on region
Calibration certificate 1 N/A
OpenChoice® Desktop Software (available for download from www.tek.com/
software/downloads.)

Safely rotate the handle
Use the correct process to eliminate the chance of pinching your thumb or rear-panel-connected cables while rotating the handle.

CAUTION. Hold the top of the handle to rotate the handle on the instrument. Do not hold the handle from the sides and rotate, as
this can pinch the base of your thumb between the handle and the case.

If you have routed any cables between the handle and the case, be careful when rotating the handle so that you do not pinch the
cables.
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Operating requirements
Use the oscilloscope within the required operating temperature, power, altitude, and signal input voltage ranges to provide the
most accurate measurements and safe instrument operation.

Environment requirements

Characteristic Description
Operating temperature -10 °C to +55 °C (+14 °F to +131 °F)

For proper cooling, keep the sides and rear of the instrument clear of obstructions for
2 inches (51 mm).

Operating humidity 5% to 90% relative humidity (% RH) up to +40 °C (+104 °F), Noncondensing.

5% to 60% RH above +40 °C up to +55 °C (+104 °F to +131 °F), Noncondensing.
Operating altitude Up to 3000 meters (9842 feet)

Power requirements

Characteristic Description
Power source voltage 100 V - 240 VAC RMS, ±10%, single phase
Power source frequency 50/60 Hz, 100-240 V

400 Hz ±10% at 100 to 132 V

Input signal requirements
Keep the input signals within allowed limits to ensure the most accurate measurements and prevent damage to the analog and
digital probes or instrument.

Make sure that input signals are within the following requirements.

Installing your instrument
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Table 1: Maximum analog input

Input Description
Analog input channels, 1 M Ω setting, maximum
input voltage at BNC

300 VRMS

Measurement Category II
De-rate at 20 dB/decade between 4.5 MHz and 45 MHz, De-rate 14 db
between 45 MHz and 450 MHz. Above 450 MHz, 5 VRMS.

Analog input channels, 50 Ω setting, maximum
input voltage at BNC

5 VRMS with a peak at ±20 V. (DF ≤ 6.25%).

RF input maximum input voltage Average Continuous Power: +20 dBm (0.1 W)
DC maximum before damage: ±40 VDC
Max no damage +33 dBm (2 W) CW
Peak Pulse Power: +45 dBm (32 W)
Peak Pulse Power defined as <10 μs pulse width, <1% duty cycle, and
reference level of ≥ +10 dBm

Table 2: Maximum input with a P6316 Digital Probe

Input Description
Threshold Accuracy ±(100 mV + 3% of threshold setting after calibration)
Threshold Range +25 V to –15 V
Maximum nondestructive input signal to probe +30 V to -20 V
Minimum signal swing 500 mVpeak-to-peak

Input resistance 101 kΩ
Input capacitance 8.0 pF typical
Pollution Degree 2, indoor use only
Humidity 5% to 95% relative humidity

Installing your instrument
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Secure (lock) the oscilloscope
Lock an oscilloscope to a test bench or equipment rack to prevent property loss.

Attach a standard laptop security lock to the rear panel of the oscilloscope, to secure the oscilloscope to a workbench, rack, or
other location.
 

 

Installing your instrument  
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Powering the oscilloscope
Use this procedure to connect the oscilloscope to line power and power on and off the oscilloscope. Always connect the
oscilloscope to AC power using the power cord that shipped with the instrument.

Prerequisite: Use the AC power cord that shipped with your oscilloscope.

1. Connect the supplied power cord to the oscilloscope power connector.

Figure 1: Power cord connector and power standby switch

 

2. Connect the power cord to an appropriate AC mains source.
Power is supplied to the power supply and some other boards whenever the AC power cord is connected to a live mains
circuit, putting the instrument in standby mode.

3. Push the front panel power button to power the instrument on and off.
The power button color indicates instrument power states:

Unlit – no AC power applied

Yellow – standby mode

Blue – powered on

4. To completely remove power from the instrument, disconnect the power cord.

 Installing your instrument
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Check that the oscilloscope passes power-on self tests
Power-on self tests verify that all oscilloscope modules are working correctly after power up.

1. Power on the oscilloscope and wait until the oscilloscope screen appears.

2. Select Utility > Self Test from the top-edge Menu bar to open the Self Test configuration menu.

3. Check that the status of all power-on self tests are Passed.

If one or more power-on self tests shows Failed:

a. Power cycle the oscilloscope.

b. Tap Utility > Self Test. If one or more power-on self tests still shows Failed, contact Tektronix Customer Support.

Connecting probes
Probes and cables connect the oscilloscope to your device under test (DUT). Use a probe that best matches your signal
measurement needs.

 
Figure 2: Connecting probes to the instrument

1. Tektronix Versatile Probe Interface (TekVPI)

These probes support two-way communication with the oscilloscope through on-screen menus and remotely through
programmable support. The remote control is useful in applications like ATE where you want the system to set probe
parameters.

2. Tektronix Versatile Probe Interface (TekVPI) for Passive Probes

These probes build upon the functionality of the TekVPI interface. Each probe is matched with its corresponding
oscilloscope channel, allowing the oscilloscope to optimize the signal input path. This provides AC compensation across the
frequency band.

Installing your instrument  
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3. TPA-BNC Adapter

The TPA-BNC Adapter allows you to use TEKPROBE II probe capabilities, such as providing probe power and passing
scaling and unit information to the oscilloscope.

4. BNC Interfaces

Some of these use TEKPROBE capabilities to pass the waveform signal and scaling to the oscilloscope. Some only pass
the signal and there is no other communication.

5. Logic Probe Interface

The P6316 probe provides 16 channels of digital (logical one or zero) information.

6. The TPA-N-VPI Adapter allows you to use TekVPI probes with the RF input.

Connect TPP0250, TPP0500B, TPP1000, TekVPI+, TekVPI, or other supported Tektronix analog probes by pushing them into
an input connector. The probe base latch locks with a 'click' when the probe is fully seated.

TekVPI probes automatically set the channel input parameters for that probe (bandwidth, attenuation, termination, and so on). If
a probe has a Menu button, push that button to open an on-screen configuration menu. Follow instructions provided with active
probes to set their parameters (auto zero, degauss, and so on).

Connect a BNC probe or cable by pushing it onto a channel BNC bayonet connector and turn the lock mechanism clockwise until
it locks.

For more information on the many probes available for use with 3 Series MDO oscilloscopes, visit the Oscilloscope Probe and
Accessory Selector Tool on the Tektronix website at www.tektronix.com.

NOTE. Connecting a probe does not automatically enable that channel (make it active). Use the instrument controls or
programmatic interface to turn on a channel and open its configuration menu to verify or change probe or cable settings
(bandwidth, attenuation, termination and so on).

Rackmount information
The optional RM3 Rackmount Kit lets you install the oscilloscope in standard equipment racks. The rack mount requires six rack
units (6U) of space to install.

Contact Tektronix Customer Support to purchase the rackmount kit option RM3. Follow the instructions that come with the
rackmount kit (RM3 Rackmount Kit Instructions, Tektronix part number 071-3609-xx).

Make sure to allow at least two inches of clearance on the sides for air ventilation and on the back for any cables you attach to
the rear panel.

 Installing your instrument
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Remote access from a Web browser
You can remotely access your network-connected instrument from a Web browser to display the instrument user interface on a
PC.

This procedure describes how to remotely access the UI controls and screen for the instrument.

Prerequisites:

■ The oscilloscope must be connected to, and accessible from, the network to which the PC is connected. See Connect to a
network (LAN) on page 34

■ Determine the IP address of the oscilloscope that you want to access. To determine the oscilloscope's IP address, select
Utility > IO in the oscilloscope menu bar and view the network settings in the LAN panel.

1. Open a Web browser on a PC connected to the same network as the oscilloscope.

2. Enter just the oscilloscope IP address on the URL line of the browser and press Enter. For example: 135.62.88.157. The
browser searches for and opens the Web page for the oscilloscope.

Connect the oscilloscope to a PC using a USB cable
Use a USB cable to connect the oscilloscope directly to a PC for remote instrument control.

1. On the oscilloscope, select Utility > I/O from the menu bar.

2. Tap USB Device Port.

3. Confirm that the USB Device Port control is On (default setting).

4. Connect a USB cable from the PC to the USB Device port on the rear of the instrument.

5. If using the USB connection to remotely control the oscilloscope using GPIB commands, set the GPIB Talk/Listen Address
for your configuration (0 - 30).

Cleaning
Use a dry, soft cotton cloth to clean the outside of the unit. If any dirt remains, use a cloth or swab dipped in a 75% isopropyl
alcohol solution. Use a swab to clean narrow spaces around controls and connectors. Do not use any liquid cleaning agents or
chemicals that could damage the touchscreen, case, controls, markings or labels, or possibly infiltrate the case.

Installing your instrument  
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Getting acquainted with your instrument
The following content provides a high-level description of the instrument controls and user interface.

Refer to the instrument help for detailed information on using the controls and user interface to display waveforms and take
measurements.

Front panel controls and connectors
The front panel controls provide direct access to key instrument settings such as vertical, horizontal, trigger, and cursors. The
connectors are where you input signals with probes or cables or insert USB devices.

Figure 3: 3 Series MDO controls
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1. Acquisition and Cursors controls:
 

 

■ Run/Stop starts and stops waveform acquisition. The button color indicates the acquisition status (green = running and
acquiring; red = stopped). When stopped, the oscilloscope shows waveforms from the last completed acquisition. The
Run/Stop button on the screen also shows the acquisition status.

■ Cursors button turns cursors on or off. Use the Multipurpose knobs to move the cursors. Double-tap the cursor
readouts or on a cursor bar (line) to open the configuration menu to set cursor types and functionality.

■ Fast Acq™ enables or disables the fast acquisition mode. FastAcq provides high-speed waveform capture that
reduces the dead time between waveform acquisitions, enabling the capture and display of transient events such as
glitches and runt pulses. It is helpful in finding elusive signal anomalies. Fast acquisition mode can also display
waveform phenomena at an intensity that reflects their rate of occurrence.

■ Single/Seq enables making a single waveform acquisition, or a specified number of acquisitions (as set in the
Acquisition configuration menu). Pushing Single/Seq turns off Run/Stop mode and takes a single acquisition. The
button color indicates the acquisition status (quick green flash = single acquisition acquired; solid green = waiting for
trigger event). Pushing Single/Seq again takes another single acquisition.

■ High Res mode calculates the average of all the samples for each acquisition interval. High Res provides a higher-
resolution, lower-bandwidth waveform.

■ Clear deletes the current acquisitions and measurement values from memory.

2. Multipurpose knobs:
 

 

■ Multipurpose knobs (A, B) Multipurpose knobs A and B move cursors, adjust the zoom, and set parameter values in
configuration menu input fields. Selecting a menu field that can use a Multipurpose knob assigns the indicated knob to
change the value in that input field. The ring around each knob lights when you can use that knob to do an action.

Push a Multipurpose knob to enable the Fine mode for making smaller increment changes. Push the knob again to exit
Fine mode.

NOTE. If you have a mouse attached, pressing the mouse wheel toggles between Coarse and Fine adjustments.

Getting acquainted with your instrument  
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3. Trigger controls:
 

 

■ Force forces a trigger event at a random point in the waveform and captures the acquisition.
■ Level sets the amplitude level that the signal must pass through to be considered a valid transition. The color of the

Level knob indicates the trigger source except for dual-level triggers. The Level knob is disabled when the trigger type
requires two level settings or other trigger qualifiers (set from the Trigger configuration menu). Push the knob to set the
threshold level to 50% of the peak-to-peak amplitude range of the signal.

■ Slope sets the signal transition direction to detect for a trigger (low to high, high to low, or either direction). Push the
button to cycle through the selections. The Slope button is disabled when the trigger type requires other slope
qualifiers (set from the Trigger configuration menu).

■ Mode sets how the instrument behaves in the absence or presence of a trigger event:

■ Auto trigger mode enables the instrument to acquire and display a waveform whether or not a trigger event
occurs. If a trigger event occurs, the instrument displays a stable waveform. If a trigger event does not occur, the
instrument forces a trigger event and acquisition and displays an unstable waveform.

■ Normal trigger mode sets the instrument to acquire and display a waveform only when there is a valid trigger
event. If no trigger occurs, the last waveform record acquired remains on the display. If no last waveform exists,
no waveform is displayed.

 Getting acquainted with your instrument
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4. Vertical controls:
 

 

■ Position moves the selected waveform up or down on the screen. The color of the Position knob indicates which
waveform the knob is controlling. Push the knob to center the waveform handle on the display.

■ Scale sets the amplitude units per vertical graticule division of the selected waveform. The scale values are shown on
the waveform badge. The color of the Scale knob indicates which waveform the knob is controlling.

■ Channel buttons turn on (display), select, or turn off a channel, as follows:

■ If the channel is not displayed, pushing a Channel button turns on that channel in the Waveform view.
■ If the channel is on the screen and is not selected, pushing that channel's button selects that channel.
■ If the channel is on the screen and is also selected, pushing that channel's button turns that channel off (removes

it from Waveform view).
■ The Math button adds or selects a Math waveform on the Waveform view, as follows:

■ If no Math waveform exists, pushing the Math button adds a Math waveform to the Waveform view and opens the
Math configuration menu.

■ If a Math waveform is displayed but not selected, pushing the button selects the Math waveform.
■ If a Math waveform is displayed and selected, pushing the button turns off the Math waveform (removes it from

Waveform view). Push the button again to display the waveform.
■ The Ref button adds or selects a Reference (saved) waveform on the Waveform view, as follows:

■ If no Reference waveform exists, pushing the Ref button opens the Browse Waveform Files configuration menu.
Navigate to and select a waveform file (*.isf) and tap Recall to load and display the reference waveform.

■ If only one Reference waveform is displayed, pushing the button turns off the Reference waveform (removes it
from the Waveform View). Push the button again to display the waveform.

■ If two or more Reference waveforms are displayed, pushing the button cycles through selecting each Reference
waveform.

■ The Bus button adds or selects a bus waveform on the Waveform view, as follows:

■ If no Bus waveform exists, pushing the Bus button adds a Bus waveform to the Waveform view and opens the
Bus configuration menu.

■ If only one Bus waveform is displayed, pushing the button turns off the Bus waveform (removes it from Waveform
view).

■ If two Bus waveforms are displayed, pushing the button cycles through selecting each Bus waveform.
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■ The RF button adds the RF waveform on the Waveform view and switches from the time domain to the frequency
domain. All time domain waveforms are turned off and the spectrum analyzer is turned on. When you switch back to
the time domain, the time domain waveforms are restored.

■ The Digital button adds or selects a digital waveform on the Waveform view

■ If the digital channels are not displayed, pushing a Digital button turns on the channels in the Waveform view.
■ If the digital channels are on the screen, but not selected, pushing the Digital button selects the digital channels.
■ If the digital channels are on the screen and are also selected, pushing the Digital button turns the digital

channels off (removes them from Waveform view).

5. Horizontal controls:
 

 

■ Position moves the waveform from side to side on the screen (changing the trigger point position in the waveform
record). Push the knob to center the trigger event to the center of the graticule.

■ Scale sets the time per major horizontal graticule division and samples/second parameters for the oscilloscope. Scale
applies to all waveforms.

6. Miscellaneous controls:
 

 

■ Touch Off turns touchscreen capability off. The Touch Off button is lighted when the touchscreen is turned off.
■ Save is a one-push save operation that uses the current File > Save As settings to save screen shots (including open

menus and dialog boxes), waveform files, instrument settings, and so on, as follows:

■ If a File > Save or File > Save As operation has occurred since the last instrument startup, pushing Save saves
the file types to the location last set in the Save As configuration menu.

■ If no file save operation has occurred since the last instrument startup, pushing Save opens the Save As
configuration menu. Select a tab to select the type of file to save (Screen Capture, Waveform, and so on), set any
associated parameters, and where to save it, and select OK. The specified file or files are saved. The next time
you push Save, the same type of files are saved.

■ Screen Captures capture the entire screen, including displayed configuration menus and dialog boxes.
■ Default Setup restores the oscilloscope settings (horizontal, vertical, scale, position, and so on) to the default settings.

Default Setup does not change items found in the User Preferences menu.
■ Autoset automatically displays a stable waveform.
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7. Ground and Probe Compensation connectors:
 

 

■ The Ground and Probe Compensation connectors are located at the lower right side of the instrument, near the front
panel. The Ground connector (the small hole in the case) provides an electrically grounded (through a resistor)
connection point to attach an anti-static wrist strap to reduce electrostatic damage (ESD) while you handle or probe the
DUT.

■ The Probe Compensation connections provide a ground connector (upper tab) and 1 kHz square wave source (lower
tab) for adjusting the high-frequency response of a passive probe (probe compensation). The oscilloscope uses this
signal to automatically compensate supported probes, including the ones that ship with the product. See Compensate
TPP0250, TPP0500B, or TPP1000 probes on page 33.

8. USB Host ports (USB 2.0):
 

 

■ USB ports are located at the lower right corner of the front panel and on the rear panel. Connect USB flash drives to
which you can save or recall data (such as instrument software updates, waveforms, settings, and screen captures) or
connect peripheral devices such as a mouse or keyboard.
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9. Probe connectors:
 

 
■ Analog input connectors support all TekVPI+ and TekVPI measurement probes, BNC passive probes, the P6316 Logic

Probe, and BNC cables. See Connecting probes on page 6.

Rear panel connections
The rear panel connections supply power to the oscilloscope and provide connectors for network, USB devices, video, reference
signals, and the AFG output.
 

 
1. Power cord connector. Use only the power cord specified for this product and certified for the country of use.
2. AFG Out is the signal output for the optional Arbitrary Function Generator (AFG) feature.
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3. AUX Out generates a signal transition on a trigger event or outputs a synchronization signal from the AFG.

4. LAN connector (RJ-45) connects the oscilloscope to a 10/100 Base-T local area network.

5. USB Device port lets you connect to a PC to remotely control the oscilloscope using the USBTMC protocol.

6. USB Host port lets you connect a USB memory device, keyboard, or mouse.

7. HDMI output lets you connect an external monitor or projector to show the oscilloscope screen.

8. Security lock connector lets you use a standard PC/laptop lock cable to secure the oscilloscope to a work bench or other
location.

The user interface screen
The touchscreen user interface contains waveforms, measurement readouts, and touch-based controls to access all oscilloscope
functions.

1. The Menu bar provides menus for typical operations including:

■ Saving, loading, and accessing files
■ Setting oscilloscope display and measurement preferences
■ Configuring network access
■ Running self tests
■ Erasing measurement and settings memory (TekSecure™)
■ Loading option licenses
■ Opening a Help viewer

2. The Waveform View area displays analog, digital, math, reference, and bus waveforms. The waveforms include waveform
handles (identifiers), trigger position, and level(s) indicators. See Identifying items in the time domain display on page 17.
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3. The Results Bar contains controls for displaying cursors, adding result tables to the screen, and adding measurements to
the Results bar. The controls are:
■ The Cursors button displays on-screen cursors. Touch and drag or use the Multipurpose knobs to move the cursors.

Double-tap on a cursor or on the cursor readouts to open a configuration menu to set cursor types and related
functions.

■ The Measure button opens a configuration menu from which to select and add up to four measurements to the Results
bar. Each measurement you add has a separate badge. Double-tap a measurement badge to open its configuration
menu.

■ The Results Table button adds a Measurement, Bus, Search, and Harmonics results table to the screen. The Measure
tab displays all measurements present in the Results bar. The Bus tab displays bus decode information for displayed
bus waveforms. The Search tab displays search event information. The Harmonics tab displays harmonic
measurement results.

■ The Search button lets you detect and mark a waveform where specified events occur. Tap Search to open a Search
configuration menu and set the search conditions for analog and digital channels. Search badges are added to the
Results Bar.

■ The Measurement and Search badges show measurement and search results and are displayed in the Results Bar.
See Badges on page 22.

4. The Settings Bar contains System badges for setting Horizontal, Trigger, Acquisition, and Date/Time parameters; Inactive
Channel buttons to turn on channels; Math/Ref/Bus button to add math, reference, and bus waveforms to the display; and
Channel and Waveform badges that let you configure the individual waveform parameters. Tap a channel or waveform
button to add it to the screen and display a badge. Double-tap a badge to open its configuration menu. See Badges on
page 22.

5. Configuration Menus let you quickly change the parameters of the selected user interface item. You can open
configuration menus by double-tapping on badges, screen objects, or screen areas. See Configuration menus on page 27.

Identifying items in the time domain display
Each area of the user interface has a specific function that helps manage information or controls. This topic shows and describes
the key user interface elements.
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1. The Waveform Record View is a graphical high-level view of the overall acquisition, how much of the acquisition is on the
screen (shown in brackets), the location of key time events including the trigger event, and the current position of waveforms
cursors.
 

 

If you are changing the horizontal time scale while the oscilloscope acquisition is stopped, the brackets change position to
show the part of the waveform record that is being viewed relative to the current acquisition total record length.
 

 

If cursors are active on a waveform, the Waveform Record View shows the relative cursor positions as small vertical dashed
lines.
 

 

When in Zoom mode, the Waveform Record View is replaced with the Zoom Overview. See Zoom user interface elements
on page 28.

2. The Expansion Point icon on the waveform view shows the center point around which the waveform expands and
compresses when changing horizontal settings.
 

 

3. The Trigger Position Indicator shows where the trigger event occurred in the waveform record.
 

 

4. The Zoom icon (in upper right corner of Waveform and Plot views) toggles zoom on and off.
 

 

5. The Trigger Level Indicator icon(s) shows the trigger level(s) on the trigger source waveform. Some trigger types require two
trigger levels.

6. Measurement and Search badges show measurement and search results. See Badges on page 22.

7. The Results Bar Handle opens or closes the Results bar to maximize waveform screen viewing when needed. To reopen
the Results bar, either tap the handle icon or swipe left from the right side of the display.
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8. The System badges show global instrument settings (Horizontal, Trigger, Acquisition, Run/Stop status, and Date/Time).
See Badges on page 22.

9. The Inactive Channel buttons add channel waveforms to the Waveform view and add an associated Channel badge to the
Settings bar.

The Add Math Ref Bus button expands allowing you to add a math, reference, or bus waveform to the Waveform view and
add an associated Waveform badge to the Settings bar.

The RF button activates the frequency domain display and adds an RF badge. Double-tap the badge to open the RF
configuration menu to configure the RF input. This button is only active if one of the RF options is enabled.

The AFG button opens the AFG configuration menu to set and enable the AFG output. This button is only present if the
AFG option is installed.

The DVM button lets you use an analog probe to take DC, AC RMS, or DC+AC RMS voltage measurements on your DUT.
Tap the button to add a DVM badge to the Results Bar and open a configuration menu. The DVM option also enables a
trigger frequency counter, accessible from the Mode & Holdoff panel in the Trigger badge menu. This button is only
present if the DVM option is installed.

10. Double-tap a badge to open its associated configuration menu. See Badges on page 22. See Configuration menus on
page 27.

If you add more Channel or Waveform badges than can fit in the waveform badge display area, tap the scroll buttons at
each end of the waveform badge area to scroll and display hidden badges.

11. The Waveform Handles on each waveform identify the source of that waveform (Cx for channels, M for Math, Rx for
Reference waveforms, Bx for bus waveforms). The waveform handles are at the zero-volt level of the waveform by default.
The currently selected waveform handle is a solid color; unselected waveform handles are outlined.

Double-tapping a waveform handle opens the configuration menu for that waveform.

For digital channels, the waveform handle shows the channel number, with each individual digital signal labeled D0–D15
and displayed with a different color.
 

 

Double-tapping a digital waveform handle opens the digital channel configuration menu.

Dragging a digital signal handle over another handle swaps location of the signals in the waveform view. Dragging a digital
signal handle out of the group, creates a new group. A selected digital group or signal handle can be moved using the
Vertical Position control.
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Identifying items in the frequency domain display
This topic shows and describes each element of the frequency domain display.

To activate the frequency domain display, press the front panel RF button or tap the RF button in the display .

Each area of the user interface has a specific function that helps manage information or controls.

1. Vertical graticule labels

2. Start frequency

3. Reference level

4. Vertical scale

5. Center frequency

6. Span and resolution bandwidth

7. Stop frequency

8. Reference marker
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9. Displayed trace indicators

a. An RF trace indicator is placed at the Reference Level.

b. A capital M appears if the maximum trace is turned on.

c. A capital A appears if the average trace is turned on.

d. A capital N appears if the normal trace is turned on.

e. The small m appears if the minimum trace is turned on.

Orange highlighting indicates the currently selected trace. In the figures the small m, which stands for the minimum
trace, is highlighted. This indicates that the minimum trace is currently selected.

10. Normal trace: Each acquisition is discarded as new data is acquired.

11. Max hold trace: The maximum data values are accumulated over multiple acquisitions of the Normal trace.

12. Min hold trace: The minimum data values are accumulated over multiple acquisitions of the Normal trace.

13. Average trace: Data from the Normal trace is averaged over multiple acquisitions. This is true power averaging, which
occurs before the log conversion. Each power of 2 averaging reduces the displayed noise by 3 dB.
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Badges
Badges are rectangular icons that show waveform, measurement, and instrument settings or readouts. Badges also provide fast
access to configuration menus. The badge types are Channel, Waveform, Measurement, Search, and System.

Channel and Waveform badges
Channel and Waveform (Math, Ref, Bus) badges are shown in the Settings Bar, located along the bottom left of the screen.
Each waveform has its own badge. The badges show high-level settings for each displayed channel or waveform. Double-tap a
badge to open its configuration menu.
 

 

Most Channel and Waveform badges also have Vertical Scale buttons, shown by single-tapping the badge. Use these buttons to
increase or decrease the vertical scale setting for that waveform.
 

 

You can drag or flick Channel and Waveform badges down off the display to turn them off. Swiping back up from the bottom of
the display restores them if they were accidentally deleted.

Channel badges are listed in the channel order. For more information, double-tap the badge to open its configuration menu or
search the instrument Help.

Measurement badges
Result badges are located in the Results Bar. They show measurement or search results. The badge title also shows the
measurement source or sources. To add a Measurement badge, tap the Measure button, select a measurement, and tap Add.
 

 

Double-tap a Measurement badge to open its configuration menu to change or refine settings.
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Some measurements and their badges are only available as options. For example, Power measurements are only listed in the
Add Measurement menu if the PWR option is installed.
 

 

To add statistical readouts to individual measurement badges, double-tap a measurement badge to open its configuration menu
and select Show Statistics in Badge.
 

 

You can drag or flick Measurement badges off to the right of the display to delete them. You can bring the badge back by swiping
in from the right.

Search badges
Search badges are also shown in the Results Bar, below the Measurement badges. A search badge lists the search source,
search type, and the number of search event occurrences in the current acquisition. The instrument marks the waveform where
those events occur with small down-pointing triangles along the top of the waveform graticule. Double-tap a search badge to
open its configuration menu to change or refine search settings.
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Search badges are created by tapping the Search button. Use the displayed configuration menu to set the search criteria.

Search badges have < (Previous) and > (Next) Navigation buttons that open the Zoom mode and center the waveform in the
display at the position of the previous or next search mark in the waveform record. Search badge Navigation buttons are only
usable when acquisitions are stopped.
 

 

You can drag or flick a Search badge to the right, off the display, to delete it. You can bring the badge back by swiping in from the
right.

Signal clipping and badges
Clipping causes inaccurate amplitude-related measurement results. Clipping also causes inaccurate amplitude values in saved
waveform files. If a math waveform is clipped, it will not affect amplitude measurements on that math waveform.

WARNING. Clipping is caused by excessive or dangerous voltages at the probe tip and/or a vertical scale setting that is not
adequate to display the entire vertical range of the waveform. Excessive voltage at the probe tip can injure the operator and
cause damage to the probe and/or instrument.

This instrument shows a warning triangle symbol and the word Clipping in a Channel badge when a vertical clipping condition
exists. Any measurement badges associated with that channel also indicate a clipping condition.
 

 

To close the clipping message, change the vertical scale to show the entire waveform, disconnect the probe tip from the
excessive voltage source, and check that you are probing the correct signal using the correct probe.

Getting acquainted with your instrument  

24  MDO32, MDO34 Installation and Safety Manual



Error messages and badges
This instrument shows a warning triangle symbol and an error message abbreviation in a Channel badge when an error occurs.
 

 

To remove the message from the badge, clear the error.

System badges
System badges (in the Settings bar) display the main Horizontal, Trigger, and Acquisition settings. You cannot delete System
badges.
 

 

Double-tap a System badge to open its configuration menu.

The Horizontal badge also has Scale buttons, shown by single-tapping the badge. Use the Horizontal Scale buttons to increase
or decrease the horizontal time/div setting.
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Common badge actions

Action Result Example
Single tap Immediate access controls (Scale,

Navigation).
 

 
Double tap Configuration menu with access to

all settings for the badge.
 

 
Touch and hold Right-click menu with single tap

access to common actions. Typical
actions include turning off a
channel and deleting a
measurement or search badge.

 

 

Getting acquainted with your instrument  

26  MDO32, MDO34 Installation and Safety Manual



Configuration menus
Configuration menus let you quickly set the parameters for channels, system settings (Horizontal, Trigger, Acquisition),
measurements, cursor readouts, Waveform view, and so on.

Double-tap an item (badge, Waveform View, cursor readouts, and so on) to open its configuration menu. For example, double-
tap a Channel badge in the Settings Bar to open its configuration menu.
 

 

Selections or values that you enter take effect immediately. Menu contents are dynamic and can change depending on your
selections, instrument options, or attached probes.

Related settings are grouped into 'panels.' Tap the panel name to show those settings. Changes to panel settings can change
the values and/or fields shown in that panel and other panels.
 

 

Tap anywhere outside a configuration menu to close it.
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To open Help content for a configuration menu, tap the question mark icon in the upper right corner of the menu.

Zoom user interface elements
Use the zoom tools to magnify waveforms to view signal details.
 

 

1. The Zoom Overview shows the entire waveform record.

NOTE. Using pinch and expand gestures on the Zoom Overview waveforms changes the horizontal time base settings.

2. The Zoom Box shows the area of the Zoom Overview to display in the Zoom View (see  4). You can touch and drag the box
to move the area to view.

NOTE. Moving the Zoom Box or changing its position does not change the horizontal time base settings.

3. The Zoom icon (in the upper right corner of the Waveform View) switches zoom mode on and off.

4. The Zoom View shows the zoomed waveforms as marked by the Zoom Box. Use pinch and/or drag options in the zoom
view to change the zoomed area of interest.

NOTE. Pinch, expand, and drag gestures in the Zoom View only change zoom magnification settings and Zoom Box
position.

5. Use the Zoom Title Bar controls to adjust the horizontal size and the position of the zoom area. Click or tap the + or -
buttons or use the A and B multipurpose knobs. Double tap the zoom scale and position fields to enter a value using a
numerical keypad.

NOTE. Touch the Zoom Position or Horizontal Zoom Scale fields before using the multipurpose knobs to adjust the
zoom.
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Using the touchscreen interface for common tasks
Use standard touchscreen actions, similar to those found on smart phones and tablets, to interact with most screen objects. You
can also use a mouse to interact with the UI. The equivalent mouse operation is shown for each touch operation.

See the table to quickly learn the fundamental touch operations.

 

Table 3: Common touchscreen UI tasks (with mouse equivalents)

Task Touchscreen UI action Mouse action
Add a channel, math, reference, or bus
waveform to the screen.

Tap an inactive channel button or the
Add Math Ref Bus button and select a
math, reference, or bus.

Click an inactive channel button or the
Add Math Ref Bus button and select a
math, reference, or bus.

Select a channel, math, reference, or bus
waveform to make it active.

Tap the Channel or Waveform badge or
waveform handle.

Click the Channel or Waveform badge or
waveform handle.

Display scale or navigation buttons on a
badge (waveform, measurement  1,
search, horizontal).

Tap the badge. Click the badge.

Open a configuration menu on any item
(all badges, views, cursor readouts,
labels, and so on).

Double-tap the badge, view, or other
object.

Double-click the badge, view, or other
object.

Open a right-click menu (badges, views). Touch and hold on the badge, Waveform
View, or other screen item until a menu
opens.

Right-click the object.

Close a configuration menu  2. Tap anywhere outside the menu or
dialog.

Click anywhere outside the menu or
dialog.

Move a menu. Touch and hold the menu title bar or a
blank area in the menu, then drag the
menu to new position.

Click and hold the left mouse button on
title or blank area and then drag to new
position.

Change horizontal or vertical settings
directly on a waveform.
Vertical changes only apply to the
selected channel or waveform; horizontal
changes apply to all channels and
waveforms.

Tap a badge and use the Scale buttons.
Or, use pinch/expand gestures.

Click a channel, waveform, or Horizontal
badge and click on the Scale buttons.

Increase or decrease the zoom area
(while in Zoom mode).

Touch and hold two fingertips on the
waveform view, move them together or
apart vertically or horizontally, lift from
screen, and repeat.

Click and drag the zoom area.
Click the + or - buttons on the Zoom Title
bar.

Adjust the zoom position (while in Zoom
mode).

Touch and drag in the zoom area to
adjust the position of the zoom.

Click and drag in the zoom area to adjust
the position of the zoom.

1 Not all measurement or search badges display navigation buttons.
2 Some dialog boxes will not close until you click an OK, Close, or other button in the dialog.
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Task Touchscreen UI action Mouse action
Quickly scroll or pan a waveform. Touch and drag in the waveform. Click and drag in the waveform or list.
Close or open the Results Bar to
increase the Waveform View area.

Tap on the Results Bar Handle or
anywhere in the border between the
Waveform View and the Results Bar.

Click the Results Bar Handle or
anywhere in the border between the
Waveform View and the Results Bar.
Click and drag the Results Bar divider.
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Configure the instrument

Set the date and time
Set the date and time so that saved files are marked with the correct date and time information.

1. Double-tap the Date/Time badge (bottom-right of screen) to open the configuration menu.
 

 

2. To turn off showing the date and time on the screen, tap the Display button to Off.
To turn on date/time display again, double-tap in the blank area where the date/time badge was displayed to open the
configuration menu and set the Display button to On.

3. You may also tap the Year, Day, Hour, Minute, or UTC Offset fields and use the multipurpose knobs to set the fields to the
correct time.
You may also double-tap the fields and use the numeric keypad to set the time.

4. Tap Month and select the month from the list.

5. Tap anywhere outside of the menu to close it.
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Download and install the latest firmware
Installing the latest firmware helps ensure that your instrument is equipped with all of the best available measurement and
analysis improvements.

Prerequisite: Save any important on-instrument files (waveforms, screen captures, oscilloscope setups, and so on) to a USB
drive or network. The installation process does not remove user-created files, but it is a good idea to back up important files
before an update.

Update oscilloscope firmware from a USB drive
Prerequisite: Determine the current version of firmware installed on the oscilloscope (Help > About)

1. Open up a Web browser on a PC and go to www.tek.com/product-support.

2. Enter the oscilloscope model number in the search field and click Go.

3. Scroll down the screen and click the Software tab.

4. If the listed available firmware version is newer than what is on your oscilloscope, select and download that file to your PC.

5. Copy the firmware install file to a USB drive.

6. Insert the USB drive into any oscilloscope USB Host port:

7. Power off the oscilloscope and then power on the oscilloscope.

NOTE. Do not power off the oscilloscope or remove the USB flash drive until the oscilloscope finishes installing the
firmware. The oscilloscope displays a message when it is OK to turn off the oscilloscope.

The oscilloscopes detects the USB drive with the firmware file and starts the installation process. Follow on-screen
instructions to install the firmware.

8. When the firmware install is finished, remove the USB drive and restart the oscilloscope.

To confirm the firmware installation:

a. Tap Help > About in the Menu bar.

b. Verify that the firmware version number listed on the screen is the same version that you downloaded.

Run Signal Path Compensation (SPC)
Run SPC at regular intervals for best measurement accuracy. You should run SPC whenever the ambient (room) temperature
has changed by more than 5 °C (9 °F) or once a week if you use vertical scale settings of 5 mV/div or less.

Signal Path Compensation (SPC) corrects for DC level inaccuracies in the internal signal path caused by temperature variations
and/or long-term signal path drift. Failure to run SPC on a regular basis may result in the oscilloscope not meeting warranted
performance levels at low volts per division settings.

Prerequisite: Disconnect all probes and cables from the front-panel channel inputs and rear-panel signal connectors.

1. Power on and warm up the oscilloscope for at least 20 minutes.

2. Tap Utility > Calibration.

3. Tap Run SPC. The SPC Status readout shows Running while SPC is running. SPC can take several minutes per channel
to run, so wait until the SPC Status message changes to Pass before reconnecting probes and using the oscilloscope.
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4. Close the Calibration configuration dialog when SPC has completed.

5. If SPC fails, write down any error message text. Make sure that all probes and cables are disconnected and run SPC again.
If SPC still fails, contact Tektronix Customer Support.

Compensate TPP0250, TPP0500B, or TPP1000 probes
Probe compensation adjusts the high frequency response of a probe for best waveform capture and measurement accuracy. The
oscilloscope can automatically test and store compensation values for TPP0250, TPP0500B and TPP1000 probes.

The oscilloscope stores the compensation values for each probe/channel combination and automatically recalls the
compensation values when you plug in the probe again. Probe compensation status is shown in the Probe Setup panel of the
Channel configuration menu.

■ If the Probe Compensation Status field displays Pass, the probe is compensated and ready for use.

■ If the Probe Compensation Status field displays Default, the attached probe has not been compensated and needs to have
this probe compensation procedure run.

■ If the Probe Compensation Status field displays Fail, the attached probe has failed the probe compensation procedure.
Reconnect the probe and run probe compensation again.

■ If there is no probe compensation status field shown in the panel, the oscilloscope cannot store compensation values for
that probe. See the oscilloscope Help for how to manually compensate passive probes not supported by the probe
compensation function.

■ Each compensation generates values for a specific probe and channel combination. If you want to use the probe on another
channel and desire to compensate the new probe-channel pair, you must run a new set of compensation steps.

■ Each channel can store compensation values for 10 individual probes. If you try to compensate an 11th probe on a channel,
the oscilloscope will delete the values for the least recently used probe and add the values for the new probe.

Use this procedure to compensate a TPP0250, TPP0500B, TPP1000, or other supported TPP-family probe that shows a Default
status when connected to the oscilloscope.

NOTE. A Default Setup does not delete probe compensation values. A factory calibration deletes all stored probe compensation
values.

Prerequisite: The oscilloscope must be powered on for at least 20 minutes before compensating a probe.

1. Connect a supported probe to an input channel.

2. Connect the probe tip and ground lead of the probe to the PROBE COMP terminals on the lower right of the oscilloscope
(see following image).

Figure 4: Probe Comp connections.
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Connect the probe tip to the 1 kHz source and the ground clip to the ground. For best results, remove any probe tip
accessories and hold the probe tip directly onto the 1 kHz connector.

NOTE. Connect only one probe at a time to the PROBE COMP terminals.

3. Turn off all channels.

4. Turn on the channel to which the probe is connected.

5. Push the front-panel Autoset button. The screen displays a square wave.

6. Double-tap the badge of the channel that you want to compensate.

7. Tap the Probe Setup panel.

If the Probe Compensation Status says Pass, the probe is already compensated for this channel. You can move the probe
to another channel and start again from step 1 or connect a different probe to this channel and start from step 1.

If the Probe Compensation Status says Default, continue with this procedure.

8. Tap Compensate Probe to open the Probe Compensation dialog.

9. Tap Compensate Probe to run the probe compensation.

10. The probe compensation is finished when the Probe Compensation Status displays Pass. Disconnect the probe tip and
ground from the PROBE COMP terminals.

11. Repeat these steps for each supported passive probe that you want to compensate for this channel.

12. Repeat these steps to compensate supported probes on other channels of the oscilloscope.

NOTE. For most accurate measurements, open the Probe Setup panel and verify the Probe Compensation Status is Pass
whenever you attach a probe to a channel.

NOTE. A probe compensation failure is most likely due to intermittent connection of the probe tip or ground connection
during the probe compensation operation. If a failure occurs, the oscilloscope will re-use the old probe compensation values
if they existed prior to the failed probe compensation operation.

Connect to a network (LAN)
Connecting to a network allows you to remotely access the instrument.

Work with your network administrator to obtain the required information to connect to your network (IP address, Gateway IP
address, Subnet Mask, DNS IP address, and so on).

1. Connect a CAT5 cable from the oscilloscope LAN connector to your network.

2. Select Utility > I/O on the menu bar to open the I/O configuration menu.

3. Tap the LAN panel
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4. Obtain or enter the network address information:

■ If your network is DHCP-enabled and the IP address field does not already show an address, tap Auto to obtain the IP
address information from the network. DHCP mode is the default mode.

■ If your network is not DHCP-enabled or you need a static (non-changing) IP address for this instrument, tap Manual
and enter the IP address and other values provided by your IT or system administrator resource.

5. Tap Test Connection to verify that the network connection is working. The LAN Status icon turns green when the
instrument successfully connects to your network. If you have problems connecting to your network, contact your system
administration resource for help.

 Configure the instrument
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EMC safety and environmental compliance

Compliance information
This section lists the EMC (electromagnetic compliance), safety, and environmental standards with which the instrument
complies. This product is intended for use by professionals and trained personnel only; it is not designed for use in households or
by children.

Questions about the following compliance information may be directed to the following address:

Tektronix, Inc.

PO Box 500, MS 19-045

Beaverton, OR 97077, USA

www.tek.com

EMC compliance

EU EMC Directive
Meets intent of Directive 2014/30/EU for Electromagnetic Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European Communities:

EN 61326-1, EN 61326-2-1. EMC requirements for electrical equipment for measurement, control, and laboratory use.  1 2 3 4

■ CISPR 11. Radiated and conducted emissions, Group 1, Class A

■ IEC 61000-4-2. Electrostatic discharge immunity

■ IEC 61000-4-3. RF electromagnetic field immunity

■ IEC 61000-4-4. Electrical fast transient / burst immunity

■ IEC 61000-4-5. Power line surge immunity

■ IEC 61000-4-6. Conducted RF immunity

■ IEC 61000-4-11. Voltage dips and interruptions immunity

EN 61000-3-2. AC power line harmonic emissions

EN 61000-3-3. Voltage changes, fluctuations, and flicker

1 This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic interference.
2 Emissions which exceed the levels required by this standard may occur when this equipment is connected to a test object.
3 Equipment may not meet the immunity requirements of applicable listed standards when test leads and/or test probes are connected due to coupling of electromagnetic

interference onto those leads/probes. To minimize the influence of electromagnetic interference, minimize the loop area between the unshielded portions of signal and
associated return leads, and keep leads as far away as possible from electromagnetic disturbance sources. Twisting unshielded test leads together is an effective way to
reduce loop area. For probes, keep the ground return lead as short as possible and close to the probe body. Some probes have accessory probe tip adapters to
accomplish this most effectively. In all cases, observe all safety instructions for the probes or leads used.

4 For compliance with the EMC standards listed here, high quality shielded interface cables that incorporate low impedance connection between the cable shield and the
connector shell should be used.
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Australia / New Zealand Declaration of Conformity – EMC
Complies with the EMC provision of the Radiocommunications Act per the following standard, in accordance with ACMA:

■ EN 61326-1 and EN 61326-2-1. Radiated and conducted emissions, Group 1, Class A.

Safety compliance
This section lists the safety standards with which the product complies and other safety compliance information.

EU declaration of conformity – low voltage
Compliance was demonstrated to the following specification as listed in the Official Journal of the European Union:

Low Voltage Directive 2014/35/EU.

■ EN 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1: General
Requirements.

■ EN 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part
2-030: Particular requirements for testing and measuring circuits.

U.S. nationally recognized testing laboratory listing
■ UL 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1: General

Requirements.

■ UL 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part
2-030: Particular requirements for testing and measuring circuits.

Canadian certification
■ CAN/CSA-C22.2 No. 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use

– Part 1: General Requirements.

Additional compliances
■ IEC 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1:

General Requirements.

■ IEC 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part
2-030: Particular requirements for testing and measuring circuits.

Equipment type
Test and measuring equipment.

Safety class
Class 1 – grounded product.

Pollution degree description
A measure of the contaminants that could occur in the environment around and within a product. Typically the internal
environment inside a product is considered to be the same as the external. Products should be used only in the environment for
which they are rated.

■ Pollution Degree 1. No pollution or only dry, nonconductive pollution occurs. Products in this category are generally
encapsulated, hermetically sealed, or located in clean rooms.

■ Pollution Degree 2. Normally only dry, nonconductive pollution occurs. Occasionally a temporary conductivity that is caused
by condensation must be expected. This location is a typical office/home environment. Temporary condensation occurs only
when the product is out of service.
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■ Pollution Degree 3. Conductive pollution, or dry, nonconductive pollution that becomes conductive due to condensation.
These are sheltered locations where neither temperature nor humidity is controlled. The area is protected from direct
sunshine, rain, or direct wind.

■ Pollution Degree 4. Pollution that generates persistent conductivity through conductive dust, rain, or snow. Typical outdoor
locations.

Pollution degree rating
Pollution Degree 2 (as defined in IEC 61010-1). Note: Rated for indoor, dry location use only.

IP rating
IP20 (as defined in IEC 60529).

Measurement and overvoltage category descriptions
Measurement terminals on this product may be rated for measuring mains voltages from one or more of the following categories
(see specific ratings marked on the product and in the manual).

■ Measurement Category II. For measurements performed on circuits directly connected to the low-voltage installation.
■ Measurement Category III. For measurements performed in the building installation.
■ Measurement Category IV. For measurements performed at the source of low-voltage installation.

NOTE. Only mains power supply circuits have an overvoltage category rating. Only measurement circuits have a measurement
category rating. Other circuits within the product do not have either rating.

Mains overvoltage category rating
Overvoltage Category II (as defined in IEC 61010-1)

Environmental compliance
This section provides information about the environmental impact of the product.

Restriction of hazardous substances
Complies with RoHS2 Directive 2011/65/EU.

Product end-of-life handling
Observe the following guidelines when recycling an instrument or component:

Equipment recycling. Production of this equipment required the extraction and use of natural resources. The equipment may
contain substances that could be harmful to the environment or human health if improperly handled at the product’s end of life.
To avoid release of such substances into the environment and to reduce the use of natural resources, we encourage you to
recycle this product in an appropriate system that will ensure that most of the materials are reused or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according to
Directives 2012/19/EU and 2006/66/EC on waste electrical and electronic equipment (WEEE) and batteries. For
information about recycling options, check the Tektronix Web site (www.tek.com/productrecycling).

Perchlorate materials. This product contains one or more type CR lithium batteries. According to the state of California, CR
lithium batteries are classified as perchlorate materials and require special handling. See dtsc.ca.gov/perchlorate for additional
information.

 EMC safety and environmental compliance
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E
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H
handle rotate, 1
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download, install firmware, 32
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update firmware, 32
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K
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compensation connectors, 9
compensation TPP250, 33
errors, 24
inputs, 9

probes, connecting, 6
proper handle rotate, 1

R
rack mount kit information, 7
rear panel

AFG Out, 15
AUX Out, 15
cable lock, 15
connections, 15
Ethernet port (RJ-45), 15
HDMI output, 15
LAN port (RJ-45), 15
power cord, 15
security cable lock, 15
USB Device port, 15
USB Host ports, 15

record view, waveform, 17
Ref button, 9
related documents, viii
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run signal path compensation, 32
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T
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time, how to set, 31
Touch Off button, 9
touchscreen UI tasks, 29
trigger

level indicators, 17
position indicator, 17

Trigger controls, 9
turn instrument on or off, 5

U
USB cable, connect to PC, 8
USB Device port (rear panel), 15
USB Host ports (rear panel), 15
USB ports (front panel), 9
using mouse with the touchscreen, 29

V
Vertical controls, 9

W
waveform

expansion point, 17
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Waveform View, 16

Z
Zoom box, 28

zoom icon, 17
Zoom overview, 28
Zoom title bar, 28
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3 シリーズの MDO
ミックスド・ドメイン・オシロスコープ

設置と安全性に関するマニュアル

www.tek.com
071-3608-01

警告

保守点検に関する説明は、資格のあるサービス担当者のみを
対象としています。危害がおよぶ恐れがありますので、資格
がない限り保守点検を行わないでください。保守点検を実行
する前に、すべての安全性に関するサマリをご覧ください。

3 シリーズ MDO 型製品ファームウェア V1.1 以降に対応



Copyright ©Tektronix.All rights reserved.使用許諾ソフトウェア製品は、Tektronix またはその子会社や供給者が所有するも
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当社へのお問合せ
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USA
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安全性に関する重要な情報

このマニュアルには、操作を行うユーザの安全を確保し、製品を安全な状態に保つために順守しなければ
ならない情報および警告が記載されています。

本機の点検にあたっては「安全にご使用いただくために」に続く「安全に保守点検していただくために」
を参照して、事故防止につとめてください。

安全にご使用いただくために

製品は指定された方法でのみご使用ください。人体への損傷を避け、本製品や本製品に接続されている製
品の破損を防止するために、安全性に関する次の注意事項をよくお読みください。すべての指示事項を注
意深くお読みください。必要なときに参照できるように、説明書を安全な場所に保管しておいてくださ
い。

本製品は該当する地域の条例や国内法令に従って使用しなければなりません。

本製品を正しく安全にご使用になるには、このマニュアルに記載された注意事項に従うだけでなく、一般
に認められている安全対策を徹底しておく必要があります。

本製品は訓練を受けた専門知識のあるユーザによる使用を想定しています。

製品のカバーを取り外して修理や保守、または調整を実施できるのは、あらゆる危険性を認識した専門的
知識のある適格者のみに限定する必要があります。

使用前に、既知の情報源と十分に照らし合わせて、製品が正しく動作していることを常にチェックしてく
ださい。

本製品は危険電圧の検出用にはご利用になれません。

危険な通電導体が露出している部分では、感電やアーク・フラッシュによってけがをするおそれがありま
すので、保護具を使用してください。

本製品をご使用の際に、より大きな他のシステムにアクセスしなければならない場合があります。他のシ
ステムの操作に関する警告や注意事項については、その製品コンポーネントのマニュアルにある安全に関
するセクションをお読みください。

本機器をシステムの一部としてご使用になる場合には、そのシステムの構築者が安全性に関する責任を果
たさなければなりません。

火災や人体への損傷を避けるには

適切な電源コードを使用してください. 本製品用に指定され、使用される国で認定された電源コードのみ
を使用してください。他の製品の電源コードは使用しないでください。

本製品を接地してください. 本製品は、電源コードのグランド線を使用して接地します。感電を避けるた
め、グランド線をアースに接続する必要があります。本製品の入出力端子に接続する前に、製品が正しく
接地されていることを確認してください。電源コードのグランド接続を無効にしないでください。

電源を切断してください. 電源コードの取り外しによって主電源が遮断されます。スイッチの位置につい
ては、使用説明書を参照してください。電源コードの取り扱いが困難な場所には設置しないでください。
必要に応じてすぐに電源を遮断できるように、ユーザが常にアクセスできる状態にしておく必要がありま
す。

接続と切断の手順を守ってください. プローブとテスト・リードが電圧源に接続されている間は接続また
は切断しないでください。絶縁型の電圧プローブ、テスト・リード、およびアダプタは、製品に付属する
製品か、または当社により特別に指定された製品のみを使用してください。
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すべての端子の定格に従ってください. 発火や感電の危険を避けるために、本製品のすべての定格とマー
キングに従ってください。本製品に電源を接続する前に、定格の詳細について、製品マニュアルを参照し
てください。測定カテゴリ（CAT）の定格および電圧と電流の定格については、製品、プローブ、または
アクセサリのうちで も低い定格を超えないように使用してください。1：1 のテスト・リードを使用する
ときは、プローブ・チップの電圧が直接製品に伝わるため注意が必要です。

コモン端子を含むいかなる端子にも、その端子の 大定格を超える電圧をかけないでください。

端子の定格電圧を超えてコモン端子をフローティングさせないでください。

カバーを外した状態では使用しないでください. カバーやパネルを外した状態やケースを開いたまま動作
させないでください。危険性の高い電圧に接触してしまう可能性があります。

露出した回路への接触は避けてください. 電源が投入されているときに、露出した接続部分やコンポーネ
ントに触れないでください。

故障の疑いがあるときは使用しないでください. 本製品に故障の疑いがある場合には、資格のあるサービ
ス担当者に検査を依頼してください。

製品が故障している場合には、使用を停止してください。製品が故障している場合や正常に動作していな
い場合には、製品を使用しないでください。安全上の問題が疑われる場合には、電源を切って電源コード
を取り外してください。誤って使用されることがないように、問題のある製品を区別しておいてくださ
い。

使用前に、電圧プローブ、テスト・リード、およびアクセサリに機械的損傷がないかを検査し、故障して
いる場合には交換してください。金属部が露出していたり、摩耗インジケータが見えているなど、損傷が
見られるプローブまたはテスト・リードは使用しないでください。

使用する前に、製品の外観に変化がないかよく注意してください。ひび割れや欠落した部品がないことを
確認してください。

指定された交換部品のみを使用するようにしてください。

適切なヒューズを使用してください。. 本製品用に指定されたヒューズ・タイプおよび定格のみを使用し
てください。

湿気の多いところでは動作させないでください. 機器を寒い場所から暖かい場所に移動する際には、結露
にご注意ください。

爆発性のガスがある場所では使用しないでください.

製品の表面を清潔で乾燥した状態に保ってください. 製品の清掃を開始する前に、入力信号を取り外して
ください。

適切に通気してください. 適切な通気が得られるように製品を設置できるように、マニュアルの設置手順
を参照してください。

製品には通気用のスロットや開口部があります。その部分を覆ったり、通気が妨げられたりすることがな
いようにしてください。開口部には異物を入れないでください。

安全な作業環境を確保してください. 製品は常にディスプレイやインジケータがよく見える場所に設置し
てください。

キーボードやポインタ、ボタン・パッドを不適切に使用したり、長く押しすぎたりしないでください。キ
ーボードやポインタの使用を誤ると、大けがにつながる可能性があります。

作業場が該当する人間工学規格を満たしていることを確認してください。ストレスに由来するけががな
いように、人間工学の専門家に助言を求めてください。

本製品には指定された当社のラック取り付け金具のみを使用してください。

安全性に関する重要な情報  
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プローブとテスト・リード

プローブやテスト・リードを接続する前に、電源コネクタからの電源コードを適切に接地されたコンセン
トに接続してください。

感電を避けるために、常に指はプローブの指ガードまたは触覚段差より後方に保ってください。

使用しないプローブ、テスト・リード、アクセサリはすべて取り外してください。

測定に使用するプローブ、テスト・リード、アダプタは、測定カテゴリ（CAT）、電圧、温度、高度、アン
ペア数の定格が適切なもののみを使用してください。

高電圧に注意. 使用するプローブの電圧定格について理解し、その定格を超えないようにしてください。
特に次の 2 つの定格についてはよく理解しておく必要があります。

■ プローブ・チップとプローブの基準リード間の 大測定電圧

■ プローブ基準リードとアース間の 大フローティング電圧

上記の 2 つの電圧定格はプローブと用途によって異なります。詳細については、プローブのマニュアルの
仕様関連セクションを参照してください。

WARNING. 感電を防止するために、オシロスコープの入力 BNC コネクタ、プローブ・チップ、またはプロ
ーブ基準リードの 大測定電圧や 大フローティング電圧を超えないように注意してください。

接続と切断の手順を守ってください. プローブ出力を測定器に接続してから、プローブを被測定回路に接
続してください。被測定回路にプローブの基準リードを接続してから、プローブ入力を接続してくださ
い。プローブ入力とプローブの基準リードを被測定回路から切断した後で、プローブを測定器から切断し
てください。

接続と切断の手順を守ってください. 被測定回路の電源を切ってから、電流プローブの接続あるいは切断
を行ってください。

プローブの基準リードは、グランドにのみ接続してください。

電流プローブを、その定格電圧を超える電圧または周波数がかかっている電線に接続しないでください。

プローブとアクセサリを検査してください. 使用前には必ずプローブとアクセサリに損傷がないことを確
認してください（プローブ本体、アクセサリ、ケーブル被覆などの断線、裂け目、欠陥）。損傷がある場
合には使用しないでください。

グランド基準のオシロスコープの使用. グランド基準のオシロスコープで使用する場合、プローブの基準
リードはフローティングさせないでください。基準リードは接地電位（0V）に接続しなければなりませ
ん。

安全性に関する重要な情報
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安全に保守点検していただくために

「安全に保守点検していただくために」のセクションには、製品の保守点検を安全に行うために必要な詳
細な情報が記載されています。資格のあるサービス担当者以外は、保守点検手順を実行しないでくださ
い。保守点検を行う前には、この「安全に保守点検していただくために」と「安全にご使用いただくため
に」をお読みください。

感電を避けるため、： 露出した接続部には触れないでください。

保守点検は単独で行わないでください。： 応急処置と救急蘇生ができる人の介在がない限り、本製品の内
部点検や調整を行わないでください。

電源を切断してください。： 保守点検の際にカバーやパネルを外したり、ケースを開く前に、感電を避け
るため、製品の電源を切り、電源コードを電源コンセントから抜いてください。

電源オン時の保守点検には十分注意してください。： 本製品には、危険な電圧や電流が存在している可能
性があります。保護パネルの取り外し、はんだ付け、コンポーネントの交換をする前に、電源の切断、バ
ッテリの取り外し（可能な場合）、テスト・リードの切断を行ってください。

修理後の安全確認。： 修理を行った後には、常にグランド導通と電源の絶縁耐力を再チェックしてくださ
い。

本マニュアル内の用語

本マニュアルでは以下の用語を使用しています。

警告： 人体や生命に危害をおよぼすおそれのある状態や行為を示します。

注意： 本機やその他の接続機器に損害を与えるおそれのある状態や行為を示します。

本機に関する用語

本機では次の用語を使用します。

■ 危険： ただちに人体や生命に危険をおよぼす可能性があることを示します。

■ 警告： 人体や生命に危険をおよぼす可能性があることを示します。

■ 注意： 本製品を含む周辺機器に損傷を与える可能性があることを示します。

安全性に関する重要な情報
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本製品に使用される記号

製品にこの記号が表記されているときは、マニュアルを参照して、想定される危険性とそれら
を回避するために必要な行動について確認してください（マニュアルでは、この記号はユーザ
に定格を示すために使用される場合があります。）

本製品では、次の記号を使用します。

安全性に関する重要な情報
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まえがき

本マニュアルには、製品の安全とコンプライアンス、オシロスコープの接続方法と電源供給方法、機器の
基本的な機能、制御、および操作に関する情報が記載されています。詳細については、製品の Help（ヘル
プ）ファイルを参照してください。

主な特長

3 シリーズ MDO をお買い求めいただきありがとうございます。3 シリーズの MDO 型オシロスコープ
（MDO32 型および MDO34）は 2 チャンネルおよび 4 チャンネルのオシロスコープであり、効率よく、コス
トも抑えて混在ドメインのデバッグを実行できます。

■ 周波数領域測定専用の RF 入力チャンネル

■ 帯域幅 100MHz～1GHz

■ 時間領域測定用に 2 チャンネルおよび 4 チャンネル

■ 16 チャンネルのデジタル入力オプション

■ 大型 11.6 インチ HD（1920 x 1080 ピクセル）容量性タッチ・スクリーン・ディスプレイ

■ タッチ・スクリーンに 適化されたユーザ・インタフェース

■ すべてのアナログ・チャンネルにおいて、2.5 GS/s のサンプル・レート（1 GHz のオプションを持つ
MDO34 型または MDO32 型では、1 チャンネルまたは 2 チャンネルで 5 GS/s）

■ すべてのチャンネルにおいて、10M ポイントのレコード長

■ 大波形取込レート: FastAcq 操作で 280,000 波形/秒、またはノーマル操作で 50,000 波形/秒超

■ 高度なトリガおよび解析：I2C、SPI、USB 2.0、CAN、CAN FD、LIN、FlexRay、RS-232、RS-422、RS-485、
UART、I2S、左詰め（LJ）、右詰め（RJ）、TDM、MIL-STD-1553、ARINC429（適切なアプリケーション）、
およびパラレル

■ パワー解析（オプション）

■ 任意関数発生器と 16 のデジタル・チャンネル（オプション）

■ デジタル・ボルトメータおよび周波数カウンタ（製品登録により無料で提供）
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関連するマニュアル

関連するマニュアルを使用して、機器の機能や機器の遠隔プログラミングおよび遠隔操作方法、操作理論
の理解方法、疑わしいモジュールの交換方法、その他のタスクの実行方法に関する情報を入手してくださ
い。

MDO34 型および MDO32 型のマニュアル

知りたい情報 使用するマニュアル

機器の機能の使用方法 3 シリーズ MDO（MDO34 型および MDO32 型）のインストールおよび安全性に関
するマニュアル（本書。当社部品番号 071-3608-xx。機器に標準で付属）。英語
版、日本語版、簡体字中国語版の 1 冊のマニュアル。

3 シリーズ MDO のヘルプ（機器のすべての機能が説明されている印刷可能バー
ジョンの状況依存ヘルプ。www.tek.com/downloads より入手可能）

機器を遠隔で操作する方
法

3 シリーズ MDO 型のプログラマ・マニュアル（当社部品番号 077-1498-xx。
www.tek.com/downloads より入手可能）

機器の仕様および機器の
仕様への適合性を確認す
る手順

3 シリーズ MDO（MDO34 型および MDO32 型）の仕様および性能確認用テクニカ
ル・リファレンス（当社部品番号 077-1499-xx。www.tek.com/downloads より入手可
能）

機器の動作理論、トラブ
ルシューティング、分解、
交換部品

3 シリーズ MDO（MDO34 型および MDO32 型）のサービス・マニュアル（当社部
品番号 077-1500-xx。www.tek.com/downloads より入手可能）

機器のラックへの設置 RM3 ラック・マウント・キット取扱説明書（当社部品番号 071-3609-xx。
www.tek.com/downloads より入手可能）

まえがき
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本機の設置

同梱アクセサリの確認

注文したものがすべてお手元に届いたことを確認してください。足りないものがある場合には、当社カス
タマ・サポートにお問い合わせください。北米：1-800-833-9200 までお電話ください。世界の他の地域で
は、www.tek.com にアクセスし、お近くの代理店をお探しください。

本機の付属品一覧を見て、注文品とスタンダード・アクセサリがすべて届いているか確認してください。
工場出荷時オプションを購入した場合には、Help（ヘルプ）> About（概要）をタップして、そのオプショ
ンが Installed Options（実装オプション）表に掲載されているかを確認してください。

スタンダード・アクセサリ

項目 数量 当社部品番号

3 シリーズ MDO（MDO34 型、MDO32 型）の設置と安全性に関す
るマニュアル

1 071-3608-xx

機器の帯域幅に応じたパッシブ電圧プローブ
    （周波数帯域：1GHz）
    （350MHz/500MHz）
    （周波数帯域：100MHz/200MHz）

アナログ・チャンネ
ルにつき 1 本

TPP1000 型
TPP0500B 型
TPP0250 型

アクセサリ・バッグ 1 016-2144-xx
電源ケーブル 1 リージョンにより異

なる

校正証明書 1 －

OpenChoice®デスクトップ・ソフトウェア（www.tek.com/software/
downloads から入手可能）

ハンドルの安全な回転

正しいプロセスを使用することで、ハンドルを回している時に親指や後部パネル接続ケーブルが挟まれな
いようにします。

注意： 本機のハンドルの上部をつかんで回します。ハンドルの側部をつかんで回さないでください。親指
の付け根がハンドルとケースの間に挟まれる可能性があります。

ハンドルとケースの間にケーブルを巻き付けている場合には、ハンドルを回すときにケーブルが挟まれな
いように注意してください。
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動作の要件

高い測定精度と安全な機器動作を確保するために、動作温度、電力、高度、信号入力電圧の各必須範囲内
でこのオシロスコープを使用してください。

環境要件

特性 説明

動作温度 10℃～＋ 55℃（+14°F～＋ 131°F）

正しく冷却するために、本機の側面と背面から 2 インチ（51mm）の範
囲には障害物を置かないでください。

動作湿度 ＋ 40℃（＋ 104ﾟF）以下で相対湿度 5%～90%（RH）（結露のない状態）

＋ 40 ℃（＋ 104 ﾟF）～ ＋ 55 ℃（＋ 131 ﾟF）で相対湿度 5% ～ 60% （RH）
（結露のない状態）

動作高度 3,000m（9,842 フィート）以下

電力要件

特性 説明

電源電圧 100V～240VAC RMS、±10%、単相

電源周波数 50/60Hz、100-240V

100～132V で 400Hz ±10%

本機の設置
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入力信号要件

入力信号を許容制限内に収めることで、正確な測定を確保し、アナログとデジタルのプローブまたは機器
への損傷を防ぎます。

入力信号が以下の要件の範囲内にあることを確認します。

表 1 : 大アナログ入力

入力 説明

アナログ入力チャンネル、1MΩ、BNC で
大入力電圧

300VRMS

測定カテゴリ II
4.5MHz から 45MHz までの範囲では 20 dB/decade、45MHz から
450MHz の範囲では 14 dB の低下。450MHz 超では 5VRMS。

アナログ入力チャンネル、50Ω 設定、BNC
で 大入力電圧

5VRMS ピーク±20V。（DF ≤ 6.25%）。

RF 入力 大入力電圧 平均連続パワー: +20dBm （0.1W）
非破壊 大 DC 電圧: ±40VDC
大（無破損）電力：+ 33dBm（2W）CW

ピーク・パルス電力: +45dBm （32W）
ピーク・パルス電力は、パルス幅 10μs 未満、デューティ・サイ
クル 1%未満、リファレンス・レベル＋ 10dBm 以上

表 2 : 大入力、P6316 デジタル・プローブ

入力 説明

スレッショルド確度 ±（100mV + 校正後のスレッショルド値設定の 3%）

スレッショルド・レンジ +25V ～ –15V
プローブに対する 大非破壊入力信号 +30V～-20V
小信号スイング 500mVp-p

入力抵抗 101kΩ
入力キャパシタンス 8.0pF（代表値）

汚染度 2、ただし、屋内使用のみ

湿度 相対湿度 5 ～ 95%

本機の設置
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オシロスコープの固定（ロック）

プロパティの損失を防ぐために、オシロスコープをテスト・ベンチや設備ラックにロックします。

標準的なノートパソコン用セキュリティ・ロックをオシロスコープの後部パネルに取り付けて、オシロス
コープを作業台やラック、その他の場所に固定します。

本機の設置
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オシロスコープの電源投入

この手順では、オシロスコープをライン電源に接続し、オシロスコープへの電源の投入と遮断を行いま
す。オシロスコープを AC 電源に接続する時には必ず、本機に同梱されている電源コードを使用してくだ
さい。

前提条件：オシロスコープに同梱されている AC 電源コードを使用してください。

1. 付属の電源コードをオシロスコープの電源コネクタに接続します。

図 1 : 電源コード・コネクタと電源スタンバイ・スイッチ

2. 電源コードを適切な AC 電源に接続します。

AC 電源コードが導通状態の電源回路に接続されると、電力が電源供給部とその他の基盤に供給され、
本機が Standby（スタンバイ）モードに入ります。

3. 本機の電源をオンまたはオフにするには、前面パネルの電源ボタンを押します。

電源ボタンの色は本機の電源ステータスを示します：

無灯–AC 電力が投入されていない

黄色–Standby（スタンバイ）モード

青色–電源オン

4. 本機の電源を完全に切るには、電源コードを抜きます。

本機の設置
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パワーオン・セルフ・テストでのオシロスコープの合格の確認

パワーオン・セルフ・テストでは、オシロスコープの全機種が起動後に正常に作動するかを確認します。

1. オシロスコープの電源を入れて、オシロスコープのスクリーンに表示が出るまで待ちます。

2. 上端のメニュー・バーで Utility（ユーティリティ）> Self Test（セルフ・テスト）を選択し、Self Test（セ
ルフ・テスト）のコンフィグレーション・メニューを開きます。

3. すべてのパワーオン・セルフ・テストのステータスが Passed（合格）になっていることを確認しま
す。

いずれかのパワーオン・セルフ・テストの結果がエラー（Failed）と表示されている場合：

a. オシロスコープの電源を入れ直します。

b. Utility（ユーティリティ）> Self Test（セルフ・テスト）をタップします。それでもいずれかのパワ
ーオン・セルフ・テストの結果が Failed（エラー）と表示される場合には、当社カスタマ・サポー
トに問い合わせてください。

プローブの接続

プローブとケーブルを使ってオシロスコープを被測定装置（DUT）に接続します。プローブは信号測定の
ニーズに 適なものを使用してください。

図 2 : プローブの機器への接続

1. Tektronix 汎用プローブ・インタフェース（TekVPI）

これらのプローブは、画面上のメニューおよびリモート設定可能な機能を通して、オシロスコープと
の双方向通信をサポートしています。リモート・コントロールは、システムからプローブのパラメー
タをプリセットする ATE のようなアプリケーションで役に立ちます。

2. 受動プローブ用テクトロニクス汎用プローブ・インタフェース（TekVPI）

本機の設置
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これらのプローブは TekVPI インタフェースの機能に基づいています。各プローブをオシロスコープ
の対応するチャンネルとマッチさせ、オシロスコープの入力パスを 適化します。これにより、全周
波数帯域に AC 補正が適用されます。

3. TPA-BNC アダプタ

TPA-BNC アダプタにより、プローブに電源を供給したりスケーリング情報や単位情報をオシロスコー
プに送るような、TEKPROBE II プローブの機能が使用可能になります。

4. BNC インタフェース

これらのインタフェースの中には TEKPROBE 機能を使用して波形信号とスケーリング情報をオシロス
コープに送るものがあります。波形信号のみを送りその他の通信は行わないものもあります。

5. ロジック・プローブ・インタフェース

P6316 型プローブは、16 チャンネルのデジタル（論理型の 1/0）情報を提供します。

6. TPA-N-VPI アダプタを使用すると、RF 入力で TekVPI プローブを使用できます。

TPP0250 型、TPP0500B 型、TPP1000 型、TekVPI+、TekVPI、またはサポートされているその他の当社アナロ
グ・プローブを入力コネクタに挿入して接続します。プローブは完全に挿入されると、プローブのベー
ス・ラッチがカチッと音を立ててロックされます。

TekVPI プローブについては、このプローブのチャンネル入力パラメータ（帯域幅、減衰比、ターミネーシ
ョンなど）が自動で設定されます。プローブに Menu（メニュー）ボタンがある場合、そのボタンを押し
てスクリーン上のコンフィグレーション・メニューを開きます。アクティブなプローブの取扱説明書に従
ってパラメータ（自動ゼロ、デガウスなど）を設定します。

BNC のプローブまたはケーブルをチャンネル BNC 差し込みコネクタに挿入して接続し、ロック・メカニズ
ムがロックされるまで時計回りに回します。

3 シリーズの MDO オシロスコープでは、多くのプローブを使用できます。当社の Web サイト
（www.tektronix.com）で、オシロスコープのプローブおよびアクセサリのセレクタツール をご利用ください。

注： プローブを接続しても、そのチャンネルは自動的に有効にはなりません（アクティブにしてくださ
い）。プローブまたはケーブルの設定（帯域幅、減衰、ターミネーションなど）の確認や変更を行うには、
チャンネル（Channel）バッジを 2 回タップしてそのコンフィグレーション・メニューを開きます。

ラックマウント情報

オプションの RM3 ラックマウント・キットを使用すると、標準的な設備ラックにオシロスコープを取り付
けることができます。ラックマウントには、取り付けスペースとして 6 つのラック・ユニット（6U）が必
要です。

ラックマウント・キット・オプション（RM3）のご購入については、当社のカスタマ・サポートにお問い
合わせください。ラックマウント・キットの取扱説明書（RM3 ラックマウント・キット取扱説明書、当社
部品番号 071-3609-xx）に従います。

通気のために両サイドに少なくとも 2 インチ程度のスペースがあることを確認してください。また、後部
パネルにケーブルを取り付けるので、背面にも適度なスペースを確保できることを確認してください。
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Web ブラウザからのリモート・アクセス

Web ブラウザを使用して、ネットワークに接続された機器にリモート・アクセスし、PC 上に本機のユー
ザ・インタフェースを表示できます。

以下の手順では、機器の UI コントロールやスクリーンにリモート・アクセスをする方法について説明しま
す。

前提条件：

■ オシロスコープは、その PC が接続されているネットワークに接続されており、そのネットワークか
らアクセスできる状態でなければなりません。ネットワークヘの接続（LAN）(39 ページ)を参照して
ください。

■ アクセスするオシロスコープの IP アドレスを確認しておきます。オシロスコープの IP アドレスを確
認するには、オシロスコープのメニュー・バーから Utility（ユーティリティ）> IO（入出力）を選択
し、LAN パネルのネットワーク設定を確認します。

1. オシロスコープと同じネットワークに接続されている PC 上で Web ブラウザを開きます。

2. ブラウザの URL ラインにオシロスコープの IP アドレスを入力して Enter キーを押します。たとえば、
「135.62.88.157」のように入力します。ブラウザでオシロスコープの Web ページを検索して開きます。

USB ケーブルによるオシロスコープの PC への接続

USB ケーブルを使用してオシロスコープを PC に直接接続すると、オシロスコープの遠隔操作が可能にな
ります。

1. オシロスコープのメニュー・バーからユーティリティ(Utility) > I/O（入出力）を選択します。

2. USB デバイス・ポート(USB Device Port)をタップします。

3. USB デバイス・ポート・コントロールが On（オン）（デフォルト設定）になっていることを確認しま
す。

4. USB ケーブルを PC から、本機後部の USB デバイス・ポートに接続します。

5. GPIB コマンドを用いて USB 接続によるオシロスコープの遠隔操作を行う場合には、コンフィグレーシ
ョンの GPIB Talk/Listen Address（GPIB トーク／リスン・アドレス）を設定します（0～30）。

クリーニング

機器の外部の清掃には、乾いた柔らかい綿布を使用してください。汚れが落ちない場合は、75%のイソプ
ロピル・アルコール溶液をしみ込ませた布または綿棒を使用してください。コントロールやコネクタの周
りの狭い部分のクリーニングには、綿棒を使用してください。化学洗浄剤は使用しないでください。タッ
チ・スクリーン、ケース、コントロール類、マーキングやラベルが損傷したり、ケースの中に染み込む恐
れがあります。
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機器の詳細

以下の説明は、本機のコントロールとユーザ・インタフェースについての概要を示すものです。

コントロールとユーザ・インタフェースを使用した波形の表示および測定の実施に関する詳細について
は、本機のヘルプを参照してください。

前面パネル・コントロールおよびコネクタ

前面パネルのコントロールを使うと、垂直軸、水平軸、トリガ、カーソルなどといった主要機器設定に直
接アクセスできます。これらのコネクタは、プローブまたはケーブルで信号を入力した位置か、または
USB デバイスを挿入した位置にあります。

図 3 : 3 シリーズ MDO コントロール
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1. アクイジションとカーソルのコントロール：
 

 

■ Run/Stop（実行／停止）は、波形の取り込み（アクイジション）の開始と停止を行う機能です。ボ
タンの色はアクイジションのステータスを示します（緑色＝アクイジション実行中、赤色＝停
止）。停止時、オシロスコープには 後に完了したアクイジションの波形が表示されます。スクリ
ーン上の Run/Stop（実行／停止）ボタンにもアクイジション・ステータスが表示されます。

■ Cursors（カーソル）ボタンはカーソルをオンまたはオフにする機能です。カーソルを移動させる
には汎用ノブを使用します。カーソルのタイプと機能を設定するには、カーソルのリードアウト
を 2 回タップするか、またはカーソル・バー（ライン）上を 2 回タップして、コンフィグレーシ
ョン・メニューを開きます。

■ Fast Acq™は Fast acquisition（高速アクイジション）モードの有効化と無効化を行う機能です。FastAcq
では、波形のアクイジションが行われる間のデッド・タイムが短縮されるため、グリッチやラン
ト・パルスなどの過渡的イベントであっても、取り込み、表示することができます。捉えるのが
困難な信号異常の検出に役立ちます。また、高速アクイジション（Fast Acquisition）モードでは、
発生頻度に応じた輝度で波形現象を表示できます。

■ Single/Seq（単発／連続）を使うと、単発の波形アクイジションや、指定した回数のアクイジショ
ンを実行できます（Acquisition（アクイジション）のコンフィグレーション・メニューで設定）。
Single/Seq（単発／連続）を押すと Run/Stop（実行／停止）モードがオフになり、単発のアクイジ
ションが実行されます。ボタンの色はアクイジションのステータスを示します（緑色の高速点滅
＝単発アクイジション実行、緑色の点灯＝トリガ・イベント待ち）。もう一度 Single/Seq（単発／
連続）を押すと別の単発アクイジションが実行されます。

■ High Res（ハイレゾ）モードでは、各アクイジション・インターバルのすべてのサンプルの平均が
算出されます。High Res（ハイレゾ）は、高分解能で低帯域幅の波形を表示します。

■ Clear（クリア）は現在のアクイジションと測定値をメモリから消去する機能です。

2. 汎用ノブ；
 

 

■ 汎用ノブ（A、B）：汎用ノブ A および B は、カーソルを移動したり、ズームを調整する場合や、
コンフィグレーション・メニューの入力ボックス内でパラメータ値を設定する場合に使用します。
汎用ノブを使用できる入力ボックスを選択すると表示されたノブが割り当てられ、そのノブでそ
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の入力ボックス内の値を変更できます。各ノブは、アクションの実行に使用できる時にリングが
点灯します。

汎用ノブを押すと、増分変化が小さい Fine（微調整）モードが有効になります。Fine（微調整）モ
ードを終了するには、そのノブをもう一度押します。

注： マウスを取り付けている場合、マウスホイールのトグルを Coarse（粗調整）と Fine（微調整）
の間で押します。

3. Trigger（トリガ）コントロール：
 

 

■ Force（強制）は、波形の任意のポイントでトリガ・イベントを強制し、アクイジションをキャプ
チャする機能です。

■ Level（レベル）は、信号が通過する時の振幅レベルが有効なトランジションとみなされるように
設定する機能です。Level（レベル）ノブの色は、デュアルレベルのトリガ以外のトリガ・ソース
を示します。トリガ・タイプに対して 2 つのレベル設定またはその他のトリガ・クオリファイア
が必要なときに（Trigger（トリガ）のコンフィグレーション・メニューから設定する）、Level（レ
ベル）ノブは無効です。このノブを押して、スレッショルド・レベルを信号の p-p 振幅範囲の 50%
に設定します。

■ Slope（スロープ）は検出する信号トランジションの方向（低～高、高～低、または一方方向）を
設定する機能です。選択を繰り返すにはこのボタンを押します。トリガ・タイプに対して別のス
ロープ・クオリファイアが必要なときには（Trigger（トリガ）のコンフィグレーション・メニュ
ーから設定する）、Slope（スロープ）ボタンは無効です。

■ Mode（モード）は、トリガ・イベントの有無による機器の挙動を設定するための機能です。

■ Auto（オート）トリガ・モードでは、トリガ・イベントの発生の有無に関係なく、波形のアク
イジションと表示が行われます。トリガ・イベントが発生した場合には、安定した波形が表
示されます。トリガ・イベントが発生しない場合には、本機がトリガ・イベントを強制的に
発生させ、不安定な波形が表示されます。

■ Normal（ノーマル）トリガ・モードでは、有効なトリガ・イベントが存在するときのみ波形の
アクイジションと表示が行われるように、本機が設定されます。トリガが発生しない場合は、
前に取り込んだ波形レコードがそのまま表示されます。前の波形がない場合、波形は表示さ
れません。
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4. Vertical（垂直軸）コントロール：
 

 

■ Position（位置）は、選択した波形やその目盛をスクリーン上で上下に移動させる機能です。Position
（位置）ノブの色は、このノブで制御している波形を示しています。ノブを押して、波形ハンドル
をディスプレイの中央にします。

■ Scale（スケール）は、選択した波形の垂直目盛区分ごとに振幅単位を設定する機能です。スケー
ル値は、波形バッジに表示されます。Scale（スケール）ノブの色は、このノブで制御している波
形を示しています。

■ Channel（Channel）・ボタンを使うと、次のようにチャンネルのオン（表示）、選択、オフを実行で
きます。

■ チャンネルが表示されていない場合、チャンネル・ボタンを押すとそのチャンネルが波形ビ
ューに表示されます。

■ チャンネルがスクリーン上になく、選択されていない場合、そのチャンネルのボタンを押す
とそのチャンネルが選択されます。

■ チャンネルがスクリーン上にあって選択されている場合、そのチャンネルのボタンを押すと、
そのチャンネルがオフ（波形ビューから削除）になります。

■ Math（演算）ボタンを使うと、次のように波形ビュー上での演算波形の追加や選択を実行できま
す。

■ 演算波形がない場合、Math（演算）ボタンを押すと波形ビューに演算波形が追加され、Math
（演算）のコンフィグレーション・メニューが開きます。

■ 演算波形が表示されていても選択されていない場合、このボタンを押すと演算波形が選択さ
れます。

■ 演算波形が 1 つだけ表示されて選択されている場合、このボタンを押すと演算波形がオフ（波
形ビューから削除）になります。波形を表示するにはこのボタンをもう一度押します。

■ Ref（リファレンス）ボタンを使うと、次のように波形ビュー上でのリファレンス（保存済み）波
形の追加や選択を実行できます。

■ リファレンス波形がない場合、Ref（リファレンス）ボタンを押すと Browse Waveform Files（波
形ファイルの参照）のコンフィグレーション・メニューが開きます。波形ファイル（*.isf）を
見つけて選択し、Recall（リコール）をタップすると、リファレンス波形がロードされて表示
されます。

■ リファレンス波形が 1 つだけ表示されている場合、このボタンを押すとリファレンス波形がオ
フ（波形ビューから削除）になります。波形を表示するにはこのボタンをもう一度押します。

■ 複数のリファレンス波形が表示されている場合、このボタンを押すと各リファレンス波形の
選択が繰り返されます。
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■ Bus（バス）ボタンを使うと、次のように波形ビュー上でのバス波形の追加や選択を実行できま
す。

■ バス波形がない場合、Bus（バス）ボタンを押すと波形ビューにバス波形が追加され、Bus（バ
ス）のコンフィグレーション・メニューが開きます。

■ バス波形が 1 つだけ表示されている場合、このボタンを押すとバス波形がオフ（波形ビューか
ら削除）になります。

■ 2 つのバス波形が表示されている場合、このボタンを押すと各バス波形の選択が繰り返されま
す。

■ RF ボタンは、波形ビュー上に RF 波形を追加し、時間ドメインから周波数ドメインへの切り替え
を行います。時間ドメインの波形はすべてオフとなり、スペクトラム・アナライザがオンになり
ます。時間ドメインに切り替えた場合、時間ドメインの波形がリストアされます。

■ Digital（デジタル）ボタンにより波形ビューにデジタル波形が追加される、または波形ビューのデ
ジタル波形が選択されます。

■ デジタル・チャンネルが表示されない場合は Digital（デジタル）ボタンを押すと波形のチャン
ネルがオンになります。

■ デジタル・チャンネルがスクリーン上にっても選択されていない場合、Digital（デジタル）ボ
タンを押すとデジタル・チャンネルが選択されます。

■ デジタル・チャンネルがスクリーン上にあり選択されている場合、Digital（デジタル）ボタン
を押すとデジタル・チャンネルがオフになります（波形ビューから削除されます）。

5. Horizontal（水平軸）コントロール：
 

 

■ Position（位置）は、波形をスクリーン上で左右に移動させる（波形レコードのトリガ・ポイント
の位置を変更する）機能です。このノブを押すと、トリガ・イベントが目盛の中央に移動します。

■ Scale（スケール）は、オシロスコープの主要水平目盛区分ごとの時間パラメータとサンプル数/秒
パラメータを設定する機能です。Scale（スケール）はすべての波形に適用されます。
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6. その他のコントロール：
 

 

■ Touch Off（タッチ・オフ）を有効にするとタッチ・スクリーン機能がオフになります。タッチ・
スクリーンがオフになると Touch Off（タッチ・オフ）ボタンが点灯します。

■ Save（保存）を使用すると、ボタンを 1 回押すだけで、現在の File（ファイル） > Save As（名前を
付けて保存）の設定を使用して、スクリーン・ショット（オープン・メニューとダイアログ・ボ
ックスを含む）、波形ファイル、機器設定などを保存できます。

■ 機器を前回起動した後に、File（ファイル） > Save（保存）または File（ファイル） > Save As
（名前を付けて保存）の操作が行われている場合には、Save（保存）を押すと、前回 Save As
（名前を付けて保存）のコンフィグレーション・メニューで設定した場所にその種類のファイ
ルが保存されます。

■ 機器を前回起動した後にファイル保存操作を行わなかった場合には、Save（保存）を押すと、
Save As（名前を付けて保存）のコンフィグレーション・メニューが開きます。保存するファ
イルのタイプ（スクリーン・キャプチャ、波形など）を選択するためのタブを選択し、関連
パラメータと保存先を設定して、OK を選択します。指定した 1 つまたは複数のファイルが保
存されます。次回 Save（保存）を押すと、同じ種類のファイルが保存されます。

■ Screen Captures（スクリーン・キャプチャ）は、表示されるコンフィグレーション・メニュー
やダイアログ・ボックスなどを含めたスクリーン全体をキャプチャする機能です。

■ Default Setup（デフォルト・セットアップ）は、オシロスコープ設定（水平軸、垂直軸、スケー
ル、位置など）をデフォルト設定に戻す機能です。デフォルト・セットアップはユーザ設定内に
ある項目の変更を行いません。

■ Autoset（オートセット）は安定した波形を自動表示する機能です。
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7. グランド・コネクタとプローブ補正コネクタ：
 

 

■ グランド・コネクタとプローブ補正コネクタは、本機の右下、前面パネル付近にあります。グラ
ンド・コネクタ（ケース内の小さな穴）は、（レジスタを通じて）電気的に接地された接続ポイン
トで、DUT の取り扱い時または精査時に静電気損傷（ESD）を防ぐための静電気防止リスト・スト
ラップをこの接続ポイントに取り付けます。

■ プローブ補正用接続部には、グランド・コネクタ（上側のタブ）と 1kHz の方形波ソース（下側の
タブ）があり、受動プローブの高周波数応答の調整（プローブ補正）に使用します。オシロスコ
ープはこの信号を利用して、サポートされているプローブ（本製品に同梱されているプローブを
含む）の自動補正を行います。TPP0250 型、TPP0500B 型、または TPP1000 型のプローブの補正(37
ページ)を参照してください。

8. USB ホスト・ポート（USB 2.0）：
 

 

■ USB ポートは前面パネルの右下と後部パネルにあります。データ（機器のソフトウェア更新、波
形、設定、スクリーン・キャプチャなど）の保存やリコールが可能な USB フラッシュ・ドライブ
を接続するか、またはマウスやキーボードなどの周辺機器を接続してください。
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9. プローブ・コネクタ：
 

 

■ アナログ入力コネクタは、TekVPI+測定プローブ、TekVPI 測定プローブ、BNC 受動プローブ、P6316
ロジック・プローブ、BNC ケーブルのすべてに対応しています。プローブの接続(6 ページ)を参照
してください。

後部パネルの接続部

後部パネルの接続部は、オシロスコープへの電源供給と、ネットワーク、USB デバイス、ビデオ、リファ
レンス信号、AFG 出力の接続のために使用します。
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1. 電源コード・コネクタ：本製品用に指定され、使用される国で認定された電源コードのみを使用して
ください。

2. AFG Out は、オプションの任意波形／ファンクション・ジェネレータ（AFG）用の信号出力です。

3. AUX Out は、トリガ・イベントで信号トランジションを生成する、または AFG から同期信号を出力し
ます。

4. LAN コネクタ（RJ-45）は、オシロスコープを 10/100 Base-T ローカル・エリア・ネットワークに接続し
ます。

5. USB デバイス・ポートにより、USBTMC プロトコルを使用してオシロスコープを遠隔操作する場合に
PC に接続します。

6. USB ホスト・ポートにより、USB メモリ・デバイス、キーボード、またはマウスを接続します。

7. HDMI 出力により、外部のモニタまたはプロジェクタに接続してオシロスコープの画面を表示します。

8. セキュリティ・ロック・コネクタにより、標準的な PC およびノートパソコン用のロック・ケーブル
を使用して、オシロスコープを作業台やその他の場所に固定します。

ユーザ・インタフェース・スクリーン

タッチ・スクリーン式のユーザ・インタフェースには、波形、測定リードアウト、オシロスコープの全機
能にアクセスできるタッチベースのコントロールが含まれています。

1. メニュー・バーには次の通常処理用メニューが含まれます。

■ ファイルの保存、ロードおよびアクセス

■ オシロスコープのディスプレイ設定と測定のユーザ設定

■ ネットワークアクセスの構築

■ セルフ・テストの実施

■ 測定と設定メモリ（TekSecure™）の消去
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■ オプション・ライセンスのロード

■ Help（ヘルプ）ビューアの操作

2. 波形ビュー領域には、アナログ波形、デジタル波形、演算波形、リファレンス波形、およびバス波形
が表示されます。波形には、波形ハンドル（識別子）、トリガ位置、ラベル表示が含まれます。時間領
域表示の項目(19 ページ)を参照してください。

3. 結果（Results）バーには、カーソルの表示、スクリーンへの結果表の追加、結果（Results）バーへの
測定の追加を実行するコントロールがあります。具体的には以下の通りです。

■ Cursors（カーソル）ボタンを使用すると、オンスクリーン・カーソルを表示できます。Multipurpose
（汎用）ノブをタッチしてドラッグするか、使用すると、カーソルを移動できます。カーソルまた
はカーソルのリードアウトを 2 回タップすると、コンフィグレーション・メニューが開き、カー
ソルのタイプや関連機能を設定できます。

■ Measure（測定）ボタンを使うと、コンフィグレーション・メニューが開き、そこから 大 4 つの
測定を選択して結果（Results）バーに追加できます。追加する各測定には個別のバッジがありま
す。測定バッジを 2 回タップすると、そのコンフィグレーション・メニューが開きます。

■ Results Table（結果表）ボタンを使うと、測定、バス、検索および高調波の結果表をスクリーンに
追加できます。Measure（測定）タブには、結果（Results）バーに存在するすべての測定が表示さ
れます。Bus（バス）タブには、表示されているバス波形に関するバス・デコード情報が表示され
ます。Search（検索）タブには、検索イベントの情報が表示されます。Harmonics（高調波）タブに
は、高調波の測定結果が表示されます。

■ Search（検索）ボタンを使うと、指定したイベントが発生している波形を検出してマークできま
す。Search（検索）をタップすると Search（検索）コンフィグレーション・メニューが開き、アナ
ログ・チャンネルとデジタル・チャンネルの検索条件を設定できます。Search（検索）バッジが結
果バーに追加されます。

■ Measurement（測定）バッジと Search（検索）バッジは、測定結果と検索結果を示し、結果（Results）
バーに表示されます。バッジ(24 ページ)を参照してください。

4. 設定（Settings）バーには、Horizontal（水平軸）パラメータ、Trigger（トリガ）パラメータ、Acquisition
（取り込み）パラメータ、Date/Time（日付と時間）パラメータを設定できる System（システム）バッ
ジ、チャンネルをオンにする Inactive Channel（無効チャンネル）ボタン、演算波形、リファレンス波
形、バス波形をディスプレイに追加する Math（演算）、Ref（ファレンス）、Bus（バス）ボタン、波形
パラメータを個別に設定できる Channel（チャンネル）バッジと Waveform（波形）バッジがあります。
チャンネル・ボタンまたは波形ボタンをタップすると、チャンネルまたは波形がスクリーンに追加さ
れてバッジが表示されます。バッジを 2 回タップすると、そのコンフィグレーション・メニューが開
きます。バッジ(24 ページ)を参照してください。

5. Configuration Menus（コンフィグレーション・メニュー）を使うと、選択したユーザ・インタフェース
項目のパラメータを簡単に変更できます。コンフィグレーション・メニューは、バッジ、スクリーン・
オブジェクトまたはスクリーン領域を 2 回タップすれば開きます。コンフィグレーション・メニュー
(30 ページ)を参照してください。
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時間領域表示の項目

ユーザ・インタフェースの各領域には、情報やコントロールの管理に役立つ特殊機能があります。このト
ピックでは、ユーザ・インタフェースの主要要素を示して説明します。
 

 

 

1. 波形レコード・ビューは、全体のアクイジション、画面に表示されているアクイジションの量（カッ
コ内に表示）、トリガ・イベントを含む主要時間イベントの場所、波形カーソルの現在の位置を図示し
たハイレベルなビューです。
 

 

オシロスコープでのアクイジションの停止時に水平軸時間スケールを変更している場合、現在のアク
イジション・レコード長さに関連して表示されている波形レコードの一部が表示されるようにカッコ
の位置が変更されます。
 

 

波形上でカーソルがアクティブである場合、波形レコード・ビューには小さな垂直破線として関連カ
ーソル位置が表示されます。
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Zoom（ズーム）モードのとき、波形レコード・ビューはズーム概観になります。ズーム・ユーザ・イ
ンタフェース要素(31 ページ)を参照してください。

2. 波形ビューの拡張ポイント・アイコンは、水平軸設定を変更するときの波形の拡張と圧縮の中心点を
示します。
 

 

3. トリガ位置インジケータは波形レコードで発生したトリガ・イベントの位置を示します。
 

 

4. ズーム・アイコン（波形ビューとプロット・ビューの右上にある）を使うと、ズームのオンとオフを
切り替えることができます。
 

 

5. トリガ・レベル・インジケータ・アイコンは、トリガ・ソース波形上のトリガ・レベルを示します。
一部のトリガ・タイプに対しては、トリガ・レベルが 2 つ必要です。

6. Measurement（測定）／Search（検索）バッジはそれぞれ測定結果と検索結果を示します。バッジ(24
ページ)を参照してください。

7. 結果（Results）バーのハンドルは結果バーを開閉する機能で、必要に応じて波形スクリーンの表示を
大化できます。結果（Results）バーをもう一度開くには、このハンドル・アイコンをタップするか、

ディスプレイの右側から左に向かってスワイプします。

8. System（システム）バッジを使うと、機器のグローバル設定（Horizontal（水平軸）、Trigger（トリガ）、
Acquisition（アクイジション）、Run/Stop（実行／停止）ステータス、Date/Time（日時））を表示できま
す。バッジ(24 ページ)を参照してください。

9. Inactive Channel（無効チャンネル）ボタンを使うと、チャンネル波形を波形ビューに、関連するチャン
ネル・バッジを設定バーに追加できます。

Add Math Ref Bus（演算リファレンスバスを追加）ボタンを使うと、演算波形や基準波形、バス波形を
波形ビューに追加し、関連する波形バッジを Settings（設定）バーに追加できます。

RF ボタンで、周波数ドメインのディスプレイを有効にし、RF バッジを追加します。バッジを 2 回タ
ップして RF コンフィギュレーション・メニューを開き、RF 入力を設定します。このボタンは RF オプ
ションが有効時のみアクティブになります。

AFG ボタンを使うと、AFG コンフィグレーション・メニューを開いて AFG 出力を設定し、それを有効
化できます。このボタンが存在するのは、AFG オプションがインストールされている場合に限ります。

DVM ボタンを使うと、アナログ・プローブを使って DUT 上で DC 電圧測定、AC RMS 電圧測定、または
DC+AC RMS 電圧測定を実施できます。このボタンをタップして DVM バッジを結果（Results）バーに追
加し、コンフィグレーション・メニューを開きます。DVM オプションを使うと、Trigger （トリガ）バ
ッジ・メニューの Mode & Holdoff（モード&ホールドオフ）パネルからトリガ周波数カウンタにアクセ
スして有効化することもできます。このボタンが存在するのは、DVM オプションがインストールされ
ている場合に限ります。
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10. バッジを 2 回タップすると、そのコンフィグレーション・メニューが開きます。バッジ(24 ページ)を
参照してください。コンフィグレーション・メニュー(30 ページ)を参照してください。

Channel（チャンネル）バッジまたは Waveform（波形）バッジを追加して、波形バッジ領域に納まりき
らなくなった場合には、波形バッジ表示領域の両端にあるスクロール・ボタンをタップし、スクロー
ルすることで、隠れているバッジを表示させることができます。

11. それぞれの波形の波形ハンドルによって、その波形のソースを識別できます（チャンネルは Cx、演算
は M、リファレンス波形は Rx、バス波形は Bx ）。この波形ハンドルは、デフォルトでは、波形の 0 電
圧レベルにあります。現在選択されている波形ハンドルは着色され、選択されていない波形ハンドル
は線のみが表示されます。

波形ハンドルを 2 回タップするとその波形のコンフィグレーション・メニューが開きます。

デジタル・チャンネルの場合、波形ハンドルにはチャンネル番号と D0～D15 の個別のデジタル信号が
異なる色のラベルで表示されます。
 

 

デジタル波形ハンドルをダブルクリックすると、デジタル・チャンネルのコンフィグレーション・メ
ニューが開きます。

デジタル信号ハンドルを別のハンドルにドラッグすると、波形ビュー内でこれらの信号の位置が入れ
替わります。デジタル信号ハンドルをグループからドラッグすると、新しいグループが作成されます。
選択したデジタル・グループまたは信号ハンドルは、垂直軸位置（Vertical Position）コントロールで動
かすことができます。
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周波数領域に表示される項目

このトピックは、周波数ドメインの各ディスプレイ要素を示し、説明します。

周波数ドメインの表示を有効にするには、前面パネルの RF ボタンを押すか、ディスプレイの RF ボタンを
タップしてください。

ユーザ・インタフェースの各領域には、情報やコントロールの管理に役立つ特殊機能があります。

1. 垂直目盛りラベル

2. 開始周波数（Start Frequency）

3. 基準レベル（Reference Level）

4. 垂直軸スケール（Vertical Scale）

5. 中心周波数（Center Frequency）

6. スパンおよび分解能の帯域幅

7. 停止周波数（Stop frequency）

8. 基準マーカ
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9. 表示されるトレース・インジケータ

a. RF トレース・インジケータが基準レベルに置かれています。

b. 大文字 M は、 大値トレースがオンの場合に表示されます。

c. 大文字 A は、平均値トレースがオンの場合に表示されます。

d. 大文字 N は、ノーマル・トレースがオンの場合に表示されます。

e. 小文字 m は、 小値トレースがオンの場合に表示されます。

現在選択されているトレースはオレンジ色でハイライト表示されます。図では、 小値トレース
を示す小文字 m がハイライト表示されています。これは、 小値トレースが現在選択されている
ことを示しています。

10. ノーマル（Normal）トレース。各アクイジション結果は、新規データの取り込みとともに破棄されま
す。

11. マックスホールド（Max hold）トレース。ノーマル・トレースの複数回のアクイジションにわたって
大データ値が累積されます。

12. ミニマムホールド（Min hold）トレース。ノーマル・トレースの複数回のアクイジションにわたって
小データ値が累積されます。

13. アベレージ（Average）トレース。複数回のアクイジションにわたってノーマル・トレースのデータの
平均値を算出します。これが対数変換前の真の電力平均値です。各 2 乗平均により、表示ノイズが
3dB 減衰します。
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バッジ

バッジとは、波形、測定、機器の設定やリードアウトを示す四角形のアイコンです。バッジを使うとコン
フィグレーション・メニューにもすばやくアクセスできます。バッジのタイプには、チャンネル
（Channel）、波形（Waveform）、測定（Measurement）、検索（Search）、システム（System）があります。

チャンネル・バッジと波形バッジ

チャンネル・バッジと波形バッジ（演算（Math）、基準値（Ref）、バス（Bus））は、スクリーン左下の設定
（Settings）バーに表示されます。波形にはそれぞれ固有のバッジがあります。これらのバッジには、表示
されている各チャンネルまたは波形のハイレベルの設定が表示されます。バッジを 2 回タップすると、そ
のコンフィグレーション・メニューが開きます。
 

 

大半のチャンネル（Channel）バッジと波形（Waveform）バッジには垂直軸スケール（Scale）ボタンがあり、
バッジを 1 回タップするとこのボタンが表示されます。これらのボタンを使って、その波形の垂直軸スケ
ール設定を増減させることができます。
 

 

チャンネル・バッジと波形バッジはディスプレイの下側に向けてドラッグするかフリックすることでオフ
にできます。画面の下から上にむけてスワイプバックすることで、間違って消去してしまった場合に復帰
させることができます。

チャンネル・バッジはチャンネルの番号順に並びます。詳細については、バッジを 2 回タップしてコンフ
ィグレーション・メニューを開くか、ヘルプを検索してください。
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測定バッジ

Result（結果）バッジは結果バーにあります。これらのバッジには測定結果や検索結果が表示されます。バ
ッジのタイトルにも測定ソースまたはソースが表示されます。測定バッジを追加するには、測定
（Measure）ボタンをタップして追加（Add）を選択します。

 

 

測定バッジを 2 回タップしてそのコンフィグレーション・メニューを開き、設定内容の変更または微調整
を行います。

一部の測定やそのバッジは、オプション使用時にのみ利用できます。たとえば、PWR オプションがインス
トールされている場合にのみ、新規測定を追加（Add Measurement）メニューにパワー測定の項目が表示さ
れます。
 

 

個別の測定バッジに統計リードアウトを追加するには、測定バッジを 2 回タップしてコンフィグレーショ
ン・メニューを開き、Show Statistics in Badge（統計値をバッジに表示）を選択します。
 

 

測定バッジをディスプレイの右側に向けてドラッグまたはフリックすると削除できます。右側からスワ
イプするとバッジを戻すことができます。
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検索バッジ

検索（Search）バッジも結果のバーに位置しており、測定（Measurement）バッジの下に表示されます。検
索バッジには、現在のアクイジションの検索ソース、検索タイプ、検索イベントの発生件数が表示されま
す。機器はそれらのイベントが発生した場所の波形をマークし、波形目盛の上部に小さな逆三角形を表示
します。検索バッジを 2 回タップしてそのコンフィグレーション・メニューを開き、検索設定の変更また
は微調整を行います。
 

 

検索バッジを作成するには Search（検索）ボタンをタップします。表示されたコンフィグレーション・メ
ニューを利用して検索基準を設定します。

検索バッジには<（戻る）と>（進む）のナビゲーション・ボタンがあり、これらを使うと Zoom（ズーム）
モードが開き、波形レコードの「戻る」マークと「進む」マークの位置で波形がディスプレイの中央に表
示されます。検索バッジのナビゲーション・ボタンは、アクイジションが停止中にのみ使用できます。
 

 

検索バッジをディスプレイの右側に向けてドラッグまたはフリックすると削除できます。右側からスワ
イプするとバッジを戻すことができます。

信号クリッピングと信号バッジ

クリッピングが発生すると、振幅に関連する測定の結果が不正確になります。さらに、保存した波形ファ
イルの振幅値も不正確になります。演算波形がクリッピングされている場合、その演算波形の振幅測定に
は影響を与えません。
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警告： プローブ･チップの電圧が過剰または危険な状態になった場合や、波形の垂直領域全体が表示され
るように垂直軸スケールが設定されていない場合には、クリッピングが発生します。プローブ･チップの
過電圧は、オペレータの負傷、プローブや機器の破損を招く恐れがあります。

垂直軸がクリッピング状態になると、本機のチャンネル・バッジに三角形の警告マークと”クリッピング”
（Clipping）の文字が表示されます。チャンネルに関連づけられる測定バッジには、クリッピング条件も示
されます。

 

 

クリッピングのメッセージを閉じるには、波形全体が表示されるように垂直軸を変更し、過電圧ソースか
らプローブ･チップを取り外し、適切なプローブを使用して正しい信号をプロービングしているかを確認
します。

エラー・メッセージとバッジ

本機では、エラーが発生すると、チャンネル・バッジに警告を示す三角形のシンボルとエラー・メッセー
ジ（略語）が表示されます。
 

 

バッジのメッセージを消去するには、エラーを解消します。
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システム・バッジ

設定バーにある System（システム）バッジを使うと、Horizontal（水平軸）、Trigger（トリガ）、Acquisition（ア
クイジション）の主要設定を表示できます。System（システム）バッジは消去できません。
 

 

システム（System）バッジを 2 回タップすると、そのコンフィグレーション・メニューが開きます。

水平軸（Horizontal）バッジにもスケール（Scale）ボタンがあり、バッジを 1 回タップするとこのボタンが
表示されます。水平軸スケール（Horizontal Scale）ボタンを使うと、水平時間設定や div を増減できます。
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共通バッジ・アクション

アクション 結果 例

1 回タップ 即時アクセス・コントロール
（スケール（Scale）、ナビゲー
ション（Navigation））

 

 
2 回タップ バッジの全設定にアクセスで

きるコンフィグレーション・
メニュー

 

 
タッチしてホ
ールド

1 回タップでメニューを右ク
リックし、共通の操作にアク
セスします。一般的なアクシ
ョンとしては、チャンネルの
オフ、測定や検索バッジの消
去があります。
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コンフィグレーション・メニュー

コンフィグレーション・メニューから、チャンネルのパラメータ、システム設定（Horizontal（水平軸）、
Trigger（トリガ）、Acquisition（アクイジション））、測定、カーソルのリードアウト、波形ビュー、などをす
ばやく設定できます。

項目（バッジ、波形ビュー、カーソルのリードアウトなど）を 2 回タップすると、そのコンフィグレーシ
ョン・メニューが開きます。たとえば、設定（Setttings）バーのチャンネル・バッジを 2 回タップすると、
そのチャンネルのコンフィグレーション・メニューが開きます。
 

 

選択や入力した値は直ちに反映されます。メニューの内容は動的で、選択内容や機器オプション、接続さ
れたプローブの種類に合わせて変わります。

関連する設定は「パネル」でグループ分けされています。パネル名をタップすると設定内容が表示されま
す。パネル設定を変更すると、そのパネルと他のパネルに表示されている値やフィールドが変更される場
合があります。
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コンフィグレーション・メニューの外の任意の部分をタップしてこのメニューを閉じます。

コンフィグレーション・メニューの Help（ヘルプ）の内容を開くには、このメニューの右上隅にあるクエ
スチョン・マークのアイコンをタップします。

ズーム・ユーザ・インタフェース要素

Zoom ツールを使用して波形を拡大し、信号の細部を表示します。
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1. Zoom Overview（ズーム概観）には波形記録全体が表示されます。

注： Zoom Overview（ズーム概観）の波形上でつまむジェスチャや拡大のジェスチャをすると、水平時
間ベース設定を変更できます。

2. Zoom Box（ズーム・ボックス）には、Zoom View（ズーム・ビュー）に表示する Zoom Overview（ズーム
概観）の領域が表示されます（ 4 を参照）。ボックスにタッチしてドラッグすればその領域をビューに
移動できます。

注： Zoom Box（ズーム・ボックス）の移動や位置変更を実行しても、水平時間ベース設定は変わりま
せん。

3. 波形ビューの右上隅にある Zoom（ズーム）・アイコンで、ズーム・モードのオンとオフを切り替える
ことができます。

4. Zoom View（ズーム・ビュー）には、Zoom Box（ズーム・ボックス）によりマークされている拡大波形
が表示されます。ズーム・ビューでピンチやドラッグのオプションを使用して、拡大された対象領域
を変更できます。

注： Zoom View（ズーム・ビュー）でピンチ、拡大、ドラッグのジェスチャをすると、ズーム拡大設定
と Zoom Box（ズーム・ボックス）の位置のみを変更できます。

5. Zoom Title Bar（ズーム・タイトル・バー）のコントロールを使用してズーム領域の横のサイズと位置
を調整します。＋または－ボタンをクリックまたはタップするか、または A および B の汎用ノブを使
用します。ズームのスケールおよび位置のフィールドを 2 回タップし、ダブルタップ数値キーパッド
を使用して、値を入力します。

注： 汎用の歩を使用してズームを調整する前に、Zoom Position（ズーム位置）または Horizontal Zoom
Scale（水平ズーム・スケール）をタッチします。

一般タスクにタッチ・スクリーン・インタフェースを使用

スマート・フォンやタブレットのような標準的なタッチ・スクリーン・アクションを使用して、ほとんど
のスクリーン・オブジェクトとのインタラクティブな操作を実現します。UI のインタラクティブ操作には
マウスを使うこともできます。マウス操作はそれぞれのタッチ操作に相当します。

基本的なタッチ操作の簡単な説明については、表を参照してください。

 

表 3 : 一般的なタッチスクリーン UI タスク（マウス等を使用）

タスク タッチスクリーン UI でのアクシ
ョン

マウスでのアクション

チャンネル、演算波形、リファレ
ンス波形またはバス波形をスクリ
ーンに追加します。

無効なチャンネル・ボタンまたは
Add Math Ref Bus（演算、基準値、
バスを追加）のボタンをタップし
て演算、リファレンス、またはバ
スを選択します。

無効なチャンネル・ボタンまたは
Add Math Ref Bus（演算、基準値、
バスを追加）のボタンをクリック
して演算、リファレンス、または
バスを選択します。

チャンネル、演算波形、リファレ
ンス波形またはバス波形を選択し
て有効化します。

チャンネル・バッジ、波形バッジ
または波形ハンドルをタップしま
す。

チャンネル・バッジ、波形バッジ
または波形ハンドルをクリックし
ます。
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タスク タッチスクリーン UI でのアクシ
ョン

マウスでのアクション

バッジ（波形、測定
 1、検索、水平

軸）にスケール・ボタンまたはナ
ビゲーション・ボタンを表示しま
す。

バッジをタップします。 バッジをクリックします。

項目（あらゆるバッジ、ビュー、
カーソルのリードアウト、ラベル
など）のコンフィグレーション・
メニューを開く。

バッジ、ビューまたはその他のオ
ブジェクトを 2 回タップします。

バッジ、ビューまたはその他のオ
ブジェクトをダブルクリックしま
す。

右クリックメニュー（バッジ、ビ
ュー）を開きます。

バッジ、波形ビュー、プロット・
ビューまたはその他のスクリーン
項目をタッチし、メニューが開く
までホールドします。

オブジェクトを右クリックしま
す。

コンフィグレーション・メニュー
 2

を閉じる。
メニューまたはダイアログの外の
任意の部分をタップします。

メニューまたはダイアログの外の
任意の部分をクリックします。

メニューを移動させる。 メニューのタイトル・バーまたは
メニューの空白領域をタッチして
ホールドし、新たな位置にメニュ
ーをドラッグします。

タイトルまたは空白領域をマウス
の左ボタンでクリックしてホール
ドし、新たな位置にドラッグしま
す。

水平軸設定または垂直軸設定を波
形上で直接変更します。
垂直軸の変更は選択したチャンネ
ルまたは波形のみに適用され、水
平軸の変更は全チャンネルと全波
形に適用されます。

バッジをタップして Scale（スケー
ル）ボタンを使用します。もしく
は、ピンチ/拡大ジェスチャーを使
用します。

チャンネル・バッジ、波形バッジ
または水平軸（Horizontal）バッジを
クリックし、スケール（Scale）ボ
タンをクリックします。

ズーム領域を拡大または縮小しま
す（Zoom （ズーム）モード時）

波形ビューを 2 本の指でタッチし
てホールドし、それらを同時に移
動させるか、または垂直方向か水
平方向に引き離し、スクリーンか
ら削除します。一連の動作を繰り
返してください。

ズーム・エリアをクリックしてド
ラッグします。
ズーム（Zoom）タイトル・バーの
＋ボタンまたは－ボタンをクリッ
クします。

（ズーム・モード時に）ズーム位置
を調整します。

ズーム・エリアをタッチ&ドラッグ
して、ズームの位置を調整します。

ズームエリアをクリック&ドラッ
グして、ズームの位置を調整しま
す。

波形をすばやくスクロールまたは
パンします。

対象の波形をタッチしてドラッグ
します。

対象の波形かリストをクリックし
てドラッグします。

結果バーを閉じて、または開いて、
波形ビュー領域を拡大する。

結果バー・ハンドル、または波形
ビューと結果バーの間の境界の任
意の位置をタップします。

結果バー・ハンドル、または波形
ビューと結果バーの間の境界の任
意の位置をクリックします。
結果（Results）バーのデバイダをク
リックしてドラッグします。

1 すべての測定バッジや検索バッジがナビゲーション・ボタンを表示しているとは限りません。
2 一部のダイアログ・ボックスは、ダイアログの OK、Close（閉じる）またはその他のボタンをクリックするまで閉じません。

 機器の詳細

MDO32 型および MDO34 型の設置と安全性に関するマニュアル 33



機器の詳細  

34  MDO32 型および MDO34 型の設置と安全性に関するマニュアル



本機の設定

日時の設定

保存したファイルに正しい日時情報がマークされるように日付と時間を設定します。

1. 画面右下にある Date/Time（日時）バッジを 2 回タップしてコンフィグレーション・メニューを開きま
す。
 

 

2. 画面上の日時を非表示にするには、Display（表示）ボタンをタップして Off（オフ）にします。

日時を再び表示するには、日時バッジが表示されていた部分の空白のエリアを 2 回タップしてコンフ
ィグレーション・メニューを開き、Display（表示）ボタンを On（オン）にします。

3. Year（年）、Day（日付）、Hour（時刻）、Minute（分）、または UTC Offset（UTC オフセット）のフィール
ドをタップして汎用ノブでフィールドを正しい時刻に設定することもできます。

フィールドを 2 回タップして数字キーパッドを使用し時刻を設定することもできます。

4. Month（月）をタップしてリストから任意の月を選択します。

5. メニューの外の任意の部分をタップしてメニューを閉じます。
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新ファームウェアのダウンロードおよびインストール

新のファームウェアをインストールすると、利用可能な 高の測定および解析の改善すべてが機器に備
わります。

前提条件：機器上の重要ファイル（波形、スクリーン・キャプチャ、オシロスコープの設定など）は必
ず、USB ドライブまたはネットワークに保存しておいてください。インストールのプロセスでは、ユーザ
が作成したファイルは削除されませんが、重要なファイルについては更新前にバックアップを行ってくだ
さい。

USB ドライブ経由のオシロスコープ・ファームウェアの更新

前提条件：必ず、オシロスコープにインストールされているファームウェアの現在のバージョンを確認し
ておいてください（Help（ヘルプ）> About（概要））。

1. PC で Web ブラウザを起動して、www.tek.com/product-support にアクセスします。

2. 検索フィールドにオシロスコープの型名を入力して Go をクリックします。

3. スクリーンを下へスクロールし、Software（ソフトウェア）タブをクリックします。

4. 掲載されている入手可能なファームウェア・バージョンが、お使いのオシロスコープのものよりも新
しい場合には、そのファイルを選択して PC にダウンロードしてください。

5. ファームウェア・インストール・ファイルを USB ドライブにコピーします。

6. USB ドライブをオシロスコープの USB ホスト・ポートに挿入します。

7. オシロスコープの電源を切り、その後、オシロスコープの電源を入れます。

注： ファームウェアのインストールが完了するまでは、オシロスコープの電源を切ったり、USB フラ
ッシュ・ドライブを取り外したりしないでください。オシロスコープの電源を切ってよい時期を知ら
せるメッセージがオシロスコープに表示されます。

オシロスコープが、ファームウェア・ファイルが保存されている USB ドライブを検出してインストー
ル処理を開始します。画面の指示に従ってファームウェアをインストールします。

8. ファームウェアのインストールが完了したら、USB ドライブを取り外し、オシロスコープを再起動し
ます。

ファームウェアが正しくインストールされたことを確認するには、メニュー・バーから

a. Help（ヘルプ）> About（概要）をタップします。

b. 画面に表示されているファームウェア・バージョン番号が、ダウンロードしたバージョンの番号
と同じであることを確認します。
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信号経路補正（SPC）の実行

高い測定精度を確保するために定期的に SPC を実行してください。周囲（室内）温度が 5℃（9°F）以上変
化した場合は必ず SPC を実行してください。また、5mV/div 以下の垂直軸スケール設定を使用する場合に
も、週に一度、SPC を実行してください。

信号経路補正（SPC）は、周囲温度の変化や長期ドリフトによって生じる内部信号経路の DC レベルの確度
の誤差を修正します。SPC を定期的に実行しない場合、低い V/div 設定で保証されているオシロスコープ性
能を得られない可能性があります。

前提条件：必ず、前面パネルのチャンネル入力とリアパネルの信号コネクタからプローブとケーブルをす
べて取り外してください。

1. オシロスコープの電源をオンにし、20 分以上ウォーム・アップします。

2. Utility（ユーティリティ）> Calibration（校正）をタップします。

3. Run SPC（SPC の実行）をタップします。SPC の実行中は、SPC Status（SPC ステータス）のリードア
ウトに Running（実行中）と表示されます。1 チャンネルあたりの SPC の実行には数分かかる場合があ
るため、SPC ステータスのメッセージが Pass（合格）に変わるまで待ってから、プローブを再接続し
てオシロスコープを使用するようにしてください。

4. SPC が完了したら Calibration（校正）コンフィグレーション・ダイアログを閉じます。

5. SPC に失敗した場合にはエラー・メッセージ・テキストを書き留めておいてください。プローブとケ
ーブルがすべて取り外されていることを確認し、SPC をもう一度実行します。それでも SPC に失敗し
た場合には、当社カスタマ・サポートに問い合わせてください。

TPP0250 型、TPP0500B 型、または TPP1000 型のプローブの補正

高度な波形取り込みと高精度の測定を確保するために、プローブ補正によりプローブの高周波応答を調整
します。本オシロスコープでは、TPP0250 型、TPP0500B 型、および TPP1000 型のプローブに対する補正値
の試験と保存を自動で実行できます。

本オシロスコープでは、プローブとチャンネルの組み合わせごとに補正値が保存され、プローブを再接続
すると自動で補正値が呼び出されます。Channel（チャンネル）コンフィグレーション・メニューの Probe
Setup（プローブ・セットアップ）パネルには、プローブ補正ステータスが表示されます。

■ Probe Compensation Status（プローブ補正ステータス）フィールドに Pass（合格）と表示されている場
合、そのプローブは補正されており使用可能な状態です。

■ Probe Compensation Status（プローブ補正ステータス）フィールドに Default（デフォルト）と表示されて
いる場合、取り付けたプローブはまだ補正されていないため、このプローブ補正手順を実行する必要
があります。

■ Probe Compensation Status（プローブ補正ステータス）フィールドに Fail（不合格）と表示されている場
合、取り付けたプローブへのプローブ補正手順が失敗しています。そのプローブを接続し直して、も
う一度プローブ補正を実行してください。

■ パネルにプローブ補正ステータス・フィールドが表示されていない場合は、このオシロスコープでは
そのプローブの補正値を保存できません。本オシロスコープの Help（ヘルプ）から、プローブ補正機
能にサポートされていない受動プローブを手動で補正する方法を確認してください。

■ 補正では、特定のプローブとチャンネルの組み合わせに応じて、複数の値が生成されます。そのプロ
ーブを他のチャンネルで使用するために、プローブとチャンネルの新たな組み合わせで補正する場合
は、一連の新規補正ステップを実行しなければなりません。

■ 各チャンネルには、プローブ 10 本分の補正値が保存されます。特定のチャンネルで 11 本目のプロー
ブの補正を行うと、使用された も古いプローブの値が削除され、新しいプローブの値が追加されま
す。
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TPP0250 型、TPP0500B 型、または TPP1000 型のプローブ、またはサポートされているその他の TPP シリー
ズのプローブをこのオシロスコープに接続するとステータスが Default（デフォルト）と表示された場合
に、この手順を用いてプローブの補正を行います。

注： Default Setup（デフォルト・セットアップ）によりプローブ補正値が消去されることはありません。
工場校正では保存されたプローブ補正値がすべて消去されます。

前提条件：プローブ補正を行う時には必ず、オシロスコープに電源を入れて少なくとも 20 分間待ってか
ら補正を開始してください。

1. サポートされているプローブを入力チャンネルに接続します。

2. プローブ・チップとそのプローブのグランド・リードを、オシロスコープの右下 にある PROBE COMP
（プローブ補正）端子に接続します（下図を参照）。

図 4 : プローブ補正の接続

プローブ・チップを 1kHz ソースに接続し、グランド・クリップをグランドに接続します。 良の結果
を得るために、プローブ・チップのアクセサリをすべて取り外し、プローブ・チップを 1kHz コネクタ
に直接取り付けます。

注： PROBE COMP（プローブ補正）端子に同時に複数のプローブを接続することはできません。

3. すべてのチャンネルをオフにします。

4. プローブが接続されているチャンネルをオンにします。

5. 前面パネルの Autoset（オートセット）ボタンを押します。スクリーンに方形波が表示されます。

6. 補正するチャンネルのバッジを 2 回タップします。

7. Probe Setup（プローブ・セットアップ）パネルをタップします。

Probe Compensation Status（プローブ補正ステータス）に Pass（合格）と表示されている場合、そのプロ
ーブはこのチャンネルに対してすでに補正されています。このプローブを別のチャンネルに移動させ
てステップ 1 からもう一度始めるか、または別のプローブをこのチャンネルに接続してステップ 1 か
ら始めることができます。

Probe Compensation Status（プローブ補正ステータス）に Default（デフォルト）と表示されている場合は
そのままこの手順を続けます。

8. Compensate Probe（プローブの補正）をタップして Probe Compensation（プローブ補正）ダイアログを
開きます。

9. Compensate Probe（プローブの補正）をタップしてプローブ補正を実行します。

10. Probe Compensation Status（プローブ補正ステータス）に Pass（合格）と表示されたら、プローブ補正は
完了です。PROBE COMP（プローブ補正）端子からプローブ・チップとグランドを取り外します。
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11. 上記ステップを繰り返して、サポートされているそれぞれの受動プローブをこのチャンネルに対して
補正します。

12. 上記ステップを繰り返して、サポートされている受動プローブをこのオシロスコープのその他のチャ
ンネルに対して補正します。

注： 高精度の測定を実現するために、プローブをチャンネルに取り付けたときには、Probe Setup（プ
ローブ・セットアップ）パネルを開いて、Probe Compensation Status（プローブ補正ステータス）に Pass

（合格）と表示されているかを確認してください。

注： プローブの補正が失敗した場合、その原因の多くは、プローブ・チップまたはグランド接続の補
正中の断続的な接続不良です。補正に失敗した場合、プローブ補正の失敗前に補正値が存在すれば、
その補正値が引き続き使用されます。

ネットワークヘの接続（LAN）
ネットワークに接続すると、本機への遠隔アクセスが可能になります。

ネットワーク管理者と協力して、ネットワーク接続に必要な情報（IP アドレス、ゲートウェイ IP アドレ
ス、サブネット・マスク、DNS IP アドレスなど）を取得します。

1. オシロスコープの LAN コネクタの CAT5 ケーブルをネットワークに接続します。

2. メニュー・バーの Utility（ユーティリティ）> I/O（入出力）を選択して入出力コンフィグレーション・
メニューを開きます。

3. LAN パネルをタップします。

4. ネットワーク・アドレスの情報を取得または入力します。

■ DHCP が有効なネットワークで、IP アドレスのフィールドにアドレスが表示されていない場合は、
オート（Auto）をタップすると、ネットワークから IP アドレス情報を取得できます。デフォルト
のモードは DHCP モードです。

■ DHCP 対応ネットワークではない場合、または本機に固定（変化しない）IP アドレスが必要な場合
には、Manual（手動）をタップして、IT 担当者またはシステム管理者から取得した IP アドレスな
どの値を入力します。

5. Test Connection（テスト接続）をタップしてネットワーク接続が機能していることを確認します。本機
がネットワークに正常に接続されている時には LAN ステータス・アイコンが緑色に点灯します。ネッ
トワークの接続に問題がある場合、システム管理者に問い合わせてください。

 本機の設定
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EMC、安全、環境に関する適合性

適合性に関する情報

このセクションでは、本製品が適合している EMC 基準、安全基準、および環境基準について説明します。
この製品は専門家および訓練を受けた人のみが使用することを目的としています。家庭での使用や子供
による使用に対応して設計されていません。

以下の適合性に関するご質問は、以下の住所宛に、直接お問い合わせいただくこともできます：

Tektronix, Inc.

PO Box 500, MS 19-045

Beaverton, OR 97077, USA

www.tek.com

EMC 適合性

欧州 EMC 指令

指令 2014/30/EU 電磁環境両立性に適合します。『Official Journal of the European Communities』に記載の以下の基
準に準拠します。

EN 61326-1、EN 61326-2-1. 測定、制御、および実験用途の電子機器を対象とする EMC 基準：  1 2 3 4

■ CISPR 11：グループ 1、クラス A、放射および伝導エミッション

■ IEC 61000-4-2：静電気放電イミュニティ

■ IEC 61000-4-3：RF 電磁界イミュニティ

■ IEC 61000-4-4：電流高速トランゼント／バースト・イミュニティ

■ IEC 61000-4-5：電力線サージ・イミュニティ

■ IEC 61000-4-6：伝導 RF イミュニティ

■ IEC 61000-4-11：電圧低下と瞬時停電イミュニティ

EN 61000-3-2. AC 電源ライン高調波エミッション

EN 61000-3-3. 電圧の変化、変動、およびフリッカ

1 本製品は住居区域以外での使用を目的としたものです。住居区域で使用すると、電磁干渉の原因となることがあります。
2 本製品をテスト対象に接続した状態では、この規格が要求するレベルを超えるエミッションが発生する可能性があります。
3 機器にテスト・リードまたはテスト・プローブが接続されているときには、これらのリード／プローブに電磁干渉がカップリングされる

ため、ここに記載されている標準により規定されたイミュニティ要件を満たせるとは限りません。電磁干渉による影響を 小限に抑える
には、信号の非シールド部分と対応するリターン・リードの間のループ領域を 小にします。また、電波障害の発生源からできるだけ遠
ざけるようにします。ループ領域を少なくするための効率的な方法は、非シールド部分のテスト・リードをツイストペアにすることです。
プローブの場合、グランド・リターン・リードをできるだけ短くし、プローブ本体に近づけるようにします。そうした処置を効率的に行
えるように、プローブによっては、アクセサリとしてプローブ・チップ・アダプタが提供されている機種もあります。いずれの場合も、
使用するプローブまたはリードの取扱説明書を十分に読むようにしてください。

4 ここに記載されている EMC 規格に準拠するには、ケーブル・シールドとコネクタ・シェル間の低インピーダンス接続を実現する高品質シ
ールド付きインタフェース・ケーブルを使用する必要があります。
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オーストラリア／ニュージーランド適合宣言 - EMC
ACMA に従い、次の規格に準拠することで Radiocommunications Act の EMC 条項に適合しています。

■ EN 61326-1 および EN 61326-2-1：グループ 1、クラス A、放射および伝導エミッション

安全性

このセクションでは、製品が適合している安全規格およびその他の基準について説明します。

EU 適合宣言 - 低電圧

『Official Journal of the European Union』にリストされている次の仕様に準拠します。

低電圧指令 2014/35/EU：

■ EN 61010-1： 測定、制御、および実験用途の電子装置に対する安全基準 – 第 1 部：一般要件。

■ EN 61010-2-030： 測定、制御、および実験用途の電子装置に対する安全基準 – 第 2-030 部：試験回路お
よび測定回路の特定要求事項。

米国の国家認定試験機関のリスト

■ UL 61010-1： 測定、制御、および実験用途の電子装置に対する安全基準 – 第 1 部：一般要件。

■ UL 61010-2-030： 測定、制御、および実験用途の電子装置に対する安全基準 – 第 2-030 部：試験回路お
よび測定回路の特定要求事項。

カナダ規格

■ CAN/CSA-C22.2 No. 61010-1： 測定、制御、および実験用途の電子装置に対する安全基準 – 第 1 部：一般
要件。

その他の基準に対する適合性

■ IEC 61010-1： 測定、制御、および実験用途の電子装置に対する安全基準 – 第 1 部：一般要件。

■ IEC 61010-2-030： 測定、制御、および実験用途の電子装置に対する安全基準 – 第 2-030 部：試験回路お
よび測定回路の特定要求事項。

機器の種類

テスト機器および計測機器。

安全クラス

クラス 1 - アース付き製品。

汚染度について

製品内部およびその周辺で発生する可能性がある汚染度の尺度です。通常、製品の内部環境は外部環境と
同じ規定が適用されるものとみなされます。製品は、その製品に指定されている環境でのみ使用してくだ
さい。

■ 汚染度 1：汚染なし、または乾燥した非伝導性の汚染のみが発生します。このカテゴリの製品は、通
常、被包性、密封性のあるものか、クリーン・ルームでの使用を想定したものです。

■ 汚染度 2：通常、乾燥した非導電性の汚染のみが発生します。ただし、結露によって一時的な導電性
が発生することもまれにあります。これは、標準的なオフィスや家庭内の環境に相当します。一時的
な結露は製品非動作時のみ発生します。
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■ 汚染度 3：伝導性のある汚染、または結露のために伝導性のある汚染となる乾燥した非伝導性の汚染。
これらは、温度、湿度のいずれも管理されていない屋内環境に相当します。日光や雨、風に対する直
接の曝露からは保護されている領域です。

■ 汚染度 4：伝導性のある塵、雨、または雪により持続的に伝導性が生じている汚染。これは一般的な
屋外環境に相当します。

汚染度

汚染度 2（IEC 61010-1 の定義による）注：乾燥した屋内でのみ使用できます。

IP 定格

IP20（IEC 60529 で定義）。

測定および過電圧カテゴリについて

本製品の測定端子は、測定する電源電圧について次の 1 つまたは複数のカテゴリに評価されます（製品や
マニュアルへの特定の評価を参照）。

■ 測定カテゴリ II：低電圧インストレーションに直接接続された回路で実施する測定用。

■ 測定カテゴリ III：建築物の屋内配線で実施する測定

■ 測定カテゴリ IV：低電圧電源を使用して実施する測定

NOTE. 過電圧カテゴリ定格に該当するのは主電源回路のみです。測定カテゴリ定格に該当するのは測定回
路のみです。製品内部のその他の回路にはいずれの定格も該当しません。

主電源過電圧カテゴリ定格

過電圧カテゴリ II（IEC 61010-1 の定義による）

環境基準に対する適合性

このセクションでは本製品が環境におよぼす影響について説明します。

有害物質に関する規制

RoHS2 指令 2011/65/EU に適合。

使用済み製品の処理方法

機器またはコンポーネントをリサイクルする際には、次のガイドラインを順守してください。

機器のリサイクル. 本製品の製造には天然資源が使用されています。この製品には、環境または人体に有
害となる可能性のある物質が含まれているため、製品を廃棄する際には適切に処理する必要があります。
有害物質の放出を防ぎ、天然資源の使用を減らすため、本製品の部材の再利用とリサイクルの徹底にご協
力ください。

このマークは、本製品が WEEE（廃棄電気・電子機器）およびバッテリに関する指令 2012/19/
EC および 2006/66/EC に基づき、EU の諸要件に準拠していることを示しています。リサイクル
方法については、当社の Web サイトのサービス・セクション（www.tek.com/productrecycling）を
参照してください。

過塩素酸塩の取り扱い. 本製品には CR リチウム電池が搭載されています。CR リチウム電池はカリフォル
ニア州法により過塩素酸塩材として規定され、特別な取り扱いが求められています。詳細については、 を
参照してください。
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3 系列 MDO
混合域示波器

安装和安全手册

www.tek.com
071-3608-01

警告

保养说明仅供合格人员使用。为避免人身伤害，除非您有资格
执行保养，否则请勿执行保养。在执行保养工作之前，请参阅
所有安全摘要。

支持 3 系列 MDO 产品固件 V1.1 及以上版本
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重要安全信息

本手册包含用户必须遵守的信息和警告，以确保安全操作并保证产品安全。

若要安全执行关于本产品的服务，请参阅常规安全概要后面的服务安全概要。

常规安全概要

请务必按照规定使用产品。详细阅读下列安全性预防措施，以避免人身伤害，并防止损坏本产品或与本产品
连接的任何产品。认真阅读所有说明。保留这些说明以供日后参考。

应根据当地和相应国家法规的要求使用本产品。

为了正确、安全地操作产品，除本手册规定的安全性预防措施外，还必须遵守公认的安全规程。

产品仅限经过培训的人员使用。

只有了解相关危险的合格人员才能进行开盖维修、保养或调整。

使用前，请务必检查产品是否来自已知来源，以确保正确操作。

本产品不适用于检测危险电压。

如果存在危险带电导体暴露，请使用个人保护装备以防电击和电弧爆炸伤害。

使用本产品时，您可能需要使用一套大型系统的其他部件。有关操作这类系统的警告和注意事项，请阅读其
他器件手册的安全性部分。

将本设备集成到某系统时，该系统的安全性由系统的组装者负责。

避免火灾或人身伤害

使用合适的电源线. 只能使用本产品专用并经所在国家/地区认证的电源线。不要使用为其他产品提供的电源
线。

将产品接地. 本产品通过电源线的接地导线接地。为避免电击，必须将接地导线与大地相连。在对本产品的
输入端或输出端进行连接之前，请务必将本产品正确接地。不要切断电源线的接地连接。

断开电源. 电源线可以使产品断开电源。请参阅有关位置的说明。请勿将设备放在难以操作电源线的位置；
必须保证用户可以随时操作电源线，以便需要时快速断开连接。

正确连接并正确断开连接. 探头或测试导线连接到电压源时请勿插拔。仅使用产品附带的或 Tektronix 指明适
合产品使用的绝缘电压探头、测试导线和适配器。

遵守所有终端额定值. 为避免火灾或电击危险，请遵守产品上的所有额定值和标记说明。在连接产品之前，
请先查看产品手册，了解额定值的详细信息。请勿超过产品、探头或附件中各器件中额定值 低者的测量类
别 (CAT) 额定值和电压或电流额定值。在使用 1:1 测试导线时要小心，因为探头端部电压会直接传输到产品
上。

对任何终端（包括公共终端）施加的电势不要超过该终端的 大额定值。

请勿将公共终端的电压浮动到该终端的额定电压以上。

请勿开盖操作. 请勿在外盖或面板拆除或机壳打开的状态下操作本产品。可能有危险电压暴露。

远离外露电路. 电源接通后请勿接触外露的接头和器件。

怀疑产品出现故障时，请勿进行操作. 如果怀疑本产品已损坏，请让合格的维修人员进行检查。

产品损坏时请勿使用。本产品损坏或运行错误时请勿使用。如果怀疑产品存在安全问题，请关闭产品并断开
电源线。在产品上做清晰标记以防其再被使用。
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在使用之前，请检查电压探头、测试导线和附件是否有机械损坏，如损坏则予以更换。如果探头或测试导线
损坏、金属外露或出现磨损迹象，请勿使用。

在使用之前请先检查产品外表面。查看是否有裂纹或缺失部件。

仅使用规定的替换部件。

使用合适的保险丝. 只能使用为本产品指定的保险丝类型和额定值。

请勿在潮湿环境下操作. 请注意，如果某个单元从冷处移到暖处，则可能产生冷凝水。

请勿在易燃易爆的环境下操作.

请保持产品表面清洁干燥. 清洁本产品前，请移除输入信号。

请适当通风. 有关如何安装产品使其保持适当通风的详细信息，请参阅手册中的安装说明。

所提供的狭槽和开口用于通风，不得遮盖或阻挡。请勿将物体放进任何开口。

提供安全的工作环境. 始终将产品放在方便查看显示器和指示器的地方。

避免对键盘、指针和按钮盘使用不当或长时间使用。键盘或指针使用不当或长时间使用可能导致严重损伤。

请确保工作区符合适用的人体工程学标准。请咨询人体工程学专家，以避免应激损伤。

仅限使用为本产品指定的泰克机架安装硬件。

探头和测试导线
连接探头或测试导线之前，请将电源线从电源连接器连接到正确接地的电源插座。

请将手指放在探头上保护屏障、手指防护装置或触觉指示器的后面。

拔掉所有不用的探头、测试导线和附件。

仅使用正确的测量类别 (CAT)、电压、温度、海拔高度和电流额定的探头、测试导线和适配器进行测量。

小心高电压. 了解您正在使用的探头的额定电压，请不要超出这些额定值。重要的是知道并理解两个额定值：

■ 探头端部到探头参考导线的 大测量电压
■ 探头参考导线到大地的 大浮动电压
这两个额定电压取决于探头和您的应用。请参阅手册的“技术规格”部分了解更多详情。

WARNING. 为防止电击，请不要超出示波器输入 BNC 连接器、探头端部或探头参考导线的 大测量电压或
大浮动电压。

正确连接并正确断开连接. 将探头连接到被测电路之前，先将探头输出端连接到测量产品。在连接探头输入
端之前，请先将探头参考导线与被测电路连接。将探头与测量产品断开之前，请先将探头输入端及探头参考
导线与被测电路断开。

正确连接并正确断开连接. 连接电流探头或断开电流探头的连接之前请先将被测电路断电。

只能将探头参考导线连接到大地。

不要将电流探头连接到电压或频率超过电流探头额定电压的任何导线。

检查探头和附件. 在每次使用之前，请检查探头和附件是否损坏（探头本体、附件、电缆外壳等的割裂、破
损、缺陷）。如果损坏，请勿使用。

使用以地为参考的示波器. 在使用以地为参考的示波器时，不要将此探头的参考引线浮地。参考引线必须连
接到大地电势 (0 V)。

重要安全信息  
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维修安全概要

维修安全概要部分包含安全执行维修所需的其他信息。只有合格人员才能执行维修程序。在执行任何维修
程序之前，请阅读此维修安全概要和常规安全概要。

避免电击： 接通电源时，请勿触摸外露的连接。

请勿单独进行维修： 除非现场有他人可以提供急救和复苏措施，否则请勿对本产品进行内部维修或调整。

断开电源： 为避免电击，请先关闭仪器电源并断开与市电电源的电源线，然后再拆下外盖或面板，或者打开
机壳以进行维修。

带电维修时要小心操作： 本产品中可能存在危险电压或电流。在卸下保护面板，进行焊接或更换元件之前，
请先断开电源，卸下电池（如适用）并断开测试导线。

维修后验证安全性： 请务必在维修后重新检查接地连续性和市电介电强度。

手册中的术语
本手册中可能出现这些术语：

警告： “警告”声明指出可能会造成人身伤害或危及生命安全的情况或操作。

注意： “注意”声明指出可能对本产品或其他财产造成损坏的情况或操作。

产品上的术语
产品上可能出现这些术语：

■ DANGER（危险）表示您看到该标记时可直接导致人身伤害的危险。

■ WARNING（警告）表示您看到该标记时不会直接导致人身伤害的危险。

■ CAUTION（注意）表示可能会对本产品或其他财产带来的危险。

产品上的符号

产品上标示此符号时，请确保查阅手册，以了解潜在危险的类别以及避免这些危险需采取的措施。
（此符号还可能用于指引用户参阅手册中的额定值信息。）

产品上可能出现以下符号：

重要安全信息

MDO32、MDO34 安装和安全手册 v



重要安全信息

vi  MDO32、MDO34 安装和安全手册



前言

本手册提供产品安全和一致性信息，说明示波器连接和通电方法并介绍基本仪器功能、控件和操作。有关更
多详细信息，请参阅产品帮助文件。

主要功能

欢迎使用 3 系列 MDO。3 系列 MDO 示波器（MDO32 和 MDO34）是 2 通道和 4 通道示波器，能够经济高效地执
行混合域调试。

■ 专用的射频输入通道，用于频域测量

■ 带宽 100 MHz 至 1 GHz

■ 用于时域测量的 2 通道和 4 通道

■ 16 通道数字输入选件

■ 大型 11.6 英寸高清（1920 x 1080 像素）电容触摸显示屏

■ 针对触摸屏使用优化的用户界面

■ 所有模拟通道取样速率为 2.5 GS/s（对于带 1 GHz 选件的 MDO34 或 MDO32，在 1 个或 2 个通道上为 5 GS/
s）

■ 所有通道上的记录长度均为 10 M 点

■ 大波形捕获速率：使用 FastAcq 时：280,000 个波形/秒；正常工作时 >50,000 个波形/秒

■ 高级触发和分析：I2C、SPI、USB 2.0、CAN、CAN FD、LIN、FlexRay、RS-232、RS-422、RS-485、UART、
I2S、左对齐 (LJ)、右对齐 (RJ)、TDM、MIL-STD-1553、ARINC429（带合适选件）和并行

■ 功率分析（可选）

■ 任意函数发生器和 16 个数字通道（可选）

■ 通过注册产品免费获得数字电压表和触发频率计数器
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相关文档

请使用相关文档了解仪器功能的更多信息、如何远程编程或操作仪器、了解工作原理、更换可能出现故障的
模块以及其他任务。

MDO34、MDO32 文档

需了解的信息 使用此文档

如何使用仪器功能 3 系列 MDO（MDO34、MDO32）安装和安全手册（本文档，泰克部件编号 071-3608-
xx）；仪器标配附件。使用英文、日文和简体中文语言的单个文档。

3 系列 MDO 帮助（仪器帮助的可打印版本，仪器帮助包含所有仪器功能的上下文
相关说明；可从 www.tek.com/downloads 获取）

如何远程控制仪器 3 系列 MDO 程序员手册（泰克部件编号 077-1498-xx；可从 www.tek.com/downloads 获
取）

仪器技术规格以及验证仪
器是否符合技术规格的流
程

3 系列 MDO（MDO34、MDO32）技术规格和性能验证技术参考（泰克部件编号
077-1499-xx；可从 www.tek.com/downloads 获取）

仪器工作原理、故障排除、
拆卸和可更换部件

3 系列 MDO（MDO34、MDO32）维修手册（泰克部件编号 077-1500-xx；可从
www.tek.com/downloads 获取）

在机架中安装仪器 RM3 机架安装套件说明（泰克部件编号 071-3609-xx；可从 www.tek.com/downloads 获
取）

前言
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安装仪器

检查附带的附件

确保您已收到所有订购物品。如果有任何缺失，请联系泰克客户支持。在北美地区，请拨打 1-800-833-9200。
其他地区用户请访问 www.tek.com 查找当地的联系信息。

请核对仪器随附的装箱单，以确认是否收到所有标配附件和订购物品。如果您购买了出厂选件，请点击 Help
（帮助）> About（关于）以确认选件已在 Installed Options（已安装选件）表中列出。

标配附件

项目 数量 泰克部件编号

3 系列 MDO（MDO34、MDO32）安装和安全手册 1 071-3608-xx
无源电压探头，取决于仪器带宽
    （1 GHz 带宽）
    （350 MHz 和 500 MHz）
    （100 MHz 和 200 MHz 带宽）

每条模拟通道一个 TPP1000
TPP0500B
TPP0250B

附件包 1 016-2144-xx
电源线 1 取决于区域

校准证书 1 不适用

OpenChoice® 桌面软件（可从 www.tek.com/software/downloads 下载。）

安全旋转手柄

旋转手柄时请采用正确的流程以避免夹到手指或损坏后面板连接电缆。

注意： 请握住手柄上部旋转仪器上的手柄。请勿握住手柄侧面进行旋转，这可能会夹到您放在手柄和机箱之
间的手指。

如果已在手柄与机箱间布设任何电缆，请小心旋转手柄，以免损坏电缆。
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操作要求

请根据操作温度、电源、海拔高度和信号输入电压范围要求使用示波器，以提供 准确的测量并确保仪器操
作安全。

环境要求

特性 说明

工作温度 -10℃ 至 +55℃（+14℉ 至 +131℉）

为确保正常散热，请不要在仪器两侧和背面 2 英寸 (51 mm) 范围内堆放物
品。

工作湿度 在不高于 +40 °C (+104 °F) 时，相对湿度为 5% 到 90% (% RH)，无冷凝。

在 +40℃ 至 +55℃（+104 °F 至 +131℉）时，相对湿度为 5% 至 60%，无冷
凝。

工作海拔高度 高 3,000 米（9,842 英尺）

电源要求

特性 说明

电源电压 100 V - 240 VAC RMS，±10%，单相

电源频率 50/60 Hz，100-240 V

100 至 132 V 时为 400 Hz ± 10%

输入信号要求

将输入信号控制在允许的限制范围内，以确保 精确的测量并防止损坏模拟或数字探头或仪器。

确保输入信号满足以下要求。

表 1: 大模拟输入

输入 说明

模拟输入通道，1 M Ω 设置，BNC 上的 大
输入电压

300 VRMS

测量类别 II
在 4.5 MHz 和 45 MHz 之间额定值以 20 dB/倍频程下降；在 45 MHz
和 450 MHz 之间额定值按 14 db 下降。高于 450 MHz 时 5 VRMS。

模拟输入通道，50 Ω 设置，BNC 上的 大
输入电压

5 V RMS，峰值为 ±20 V。(DF ≤ 6.25%)。

RF 输入 大输入电压 平均连续功率：+20 dBm (0.1 W)
损坏前 大直流：±40 VDC
大无损功率 +33 dBm (2 W) CW

峰值脉冲功率：+45 dBm (32 W)
峰值脉冲功率定义为：脉宽 <10 μs、占空比 <1% 且参考电平 ≥
+10 dBm

安装仪器
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表 2: 使用 P6316 数字探头的 大输入

输入 说明

阈值精度 ±(100 mV + 校准后阈值设置的 3%)
阈值范围 +25 V 至 –15 V
探头的 大无损输入信号 +30 V 至 -20 V
小信号摆幅 500 mV 峰峰值

输入电阻 101 kΩ
输入电容 8.0 pF（典型值）

污染度 2 级，仅室内使用

湿度 5% 至 95% 相对湿度

确保示波器安全（将其锁定）

将示波器锁定到测试工作台或设备机架以防止造成财产损失。

将标准笔记本电脑安全锁连接示波器后面板，以便将示波器固定到工作台、机架或其他位置。
 

 

 安装仪器
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接通示波器电源

使用此步骤将示波器连接到市电电源，然后打开和关闭示波器。请始终使用仪器附带的电源线将示波器连接
到交流电源。

前提条件：使用示波器附带的交流电源线。

1. 将附带的电源线连接示波器电源连接器。

图 1: 电源线连接器和电源待机开关

 

2. 将电源线连接合适的交流电网电源。

每当将交流电源线连接到市电供电电路并将仪器置于待机模式时，将会为电源和其他一些电路板供电。

3. 按下前面板电源按钮来打开和关闭仪器电源。

电源按钮颜色指示仪器电源状态：

不亮 – 未提供交流电源

黄色 – 待机模式

蓝色 – 已通电

4. 要完全切断仪器的电源，请拔下电源线。

安装仪器  
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确认示波器通过开机自检
开机自检将确认所有示波器模块在开机后是否正常工作。

1. 打开示波器电源并等到出现示波器屏幕。

2. 从顶部菜单栏中选择 Utility（辅助功能）> Self Test（自检）来打开 Self Test（自检）配置菜单。

3. 确认开机自检的状态为 Passed（通过）。

如果一次或多次开机自检均显示 Failed（失败）：

a. 重新接通示波器电源。

b. 点击 Utility（辅助功能）> Self Test（自检）。如果一次或多次开机自检均显示未通过，请联系泰克客
户支持部门。

连接探头
探头和电缆将示波器连接到您的被测设备 (DUT)。使用能够 好匹配您的信号测量要求的探头。

 
图 2: 将探头连接仪器

1. 泰克通用型探头接口 (TekVPI)

这些探头支持通过屏幕菜单与示波器进行双向通信，也支持通过可编程支持与示波器远程进行双向通信。
在希望系统设置探头参数的应用（如 ATE）中，远程控制十分有用。

2. 适合无源探头的泰克通用型探头接口 (TekVPI)

这些探头建立在 TekVPI 接口功能的基础之上。每个探头均配有其相应的示波器通道，以使示波器优化信
号输入路径。这将为频带提供 AC 补偿。

3. TPA-BNC 适配器
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TPA-BNC 适配器允许使用 TekProbe II 探头功能，例如向探头供电以及将刻度信息和单位传给示波器。

4. BNC 接口

有些使用 TEKPROBE 功能将波形信号和刻度传给示波器。有些仅传递信号，不进行其他通信。

5. 逻辑探头接口

P6316 探头提供 16 个通道的数据（逻辑 1 或 0）信息。

6. TPA-N-VPI 适配器供您在射频输入中使用 TekVPI 探头。

将 TPP0250、TPP0500B、TPP1000、TekVPI+、TekVPI 或其他支持的泰克模拟探头推入输入连接器进行连接。探
头完全到位后，将会听到“咔”的声音，探头底部的闭锁将锁紧。

TekVPI 探头自动设置该探头的通道输入参数（带宽、衰减、端接等）。如果探头包含 Menu（菜单）按钮，按
下该按钮可打开屏幕上配置菜单。请按照有源探头附带的说明设置参数（自动调零、消磁等）。

将 BNC 探头或电缆推入通道 BNC 卡口连接器将其连接，然后，顺时针旋转锁定装置直至锁紧。

有关适用于 3 系列 MDO 示波器众多探头的详细信息，请访问泰克网站 (www.tektronix.com) 上的 Oscilloscope
Probe and Accessory Selector Tool（示波器探头和附件选择工具）。

注意： 连接探头时不会自动启用（激活）该通道。使用仪器控件或编程接口启用通道并打开其配置菜单以确
认或更改探头或电缆设置（带宽、衰减、端接等）。

机架安装信息

可选的 RM3 机架安装套件用于在标准设备机架中安装示波器。机架将需要六个机架单元 (6U) 的安装空间。

请联系泰克客户支持部门以购买机架安装套件选件 RM3。请遵循机架安装套件随附的说明（RM3 机架安装套
件说明，泰克部件编号 071-3609-xx）。

务必在侧面留出两英寸空隙以便进行通风，在后面也留出两英寸空隙以便将所有电缆接到后面板上。

从 Web 浏览器远程访问
您可以从 Web 浏览器远程访问联网仪器以便在 PC 上显示仪器用户界面。

此过程介绍如何远程访问仪器的 UI 控件和屏幕。

前提条件：

■ 示波器必须连接 PC 所连接的网络并通过该网络进行访问。请参阅 连接网络 (LAN)第34 页

■ 确定要访问的示波器的 IP 地址。要确定示波器的 IP 地址，请在示波器菜单栏中选择辅助功能 > IO，然
后，在 LAN 面板中查看网络设置。

1. 在与示波器连接同一网络的 PC 上打开 Web 浏览器。

2. 只需在浏览器的 URL 行输入示波器 IP 地址，并按下 Enter（回车）。例如：135.62.88.157。浏览器将搜索并
打开示波器的网页。
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使用 USB 电缆将示波器连接 PC
使用一根 USB 电缆直接将示波器连接到 PC 以远程控制仪器。

1. 在示波器上，从菜单栏中选择辅助功能 > I/O。

2. 点击 USB 设备端口。

3. 确认 USB 设备端口控制为开（默认设置）。

4. 将与 PC 相连的 USB 电缆连接仪器后部的 USB 设备端口。

5. 如果使用 USB 连接通过 GPIB 命令远程控制示波器，请根据具体配置设置 GPIB 通话/侦听地址 (0 - 30)。

清洁
使用柔软的干棉布清洁设备外部。如果仍有任何污垢，请用软布或棉签蘸 75% 的异丙基酒精溶液清洁。使用
棉签清洁控件和连接器周围的狭小空间。请勿使用任何可能损坏触摸屏、外壳、控件、标记或标签或者可能
渗入外壳的液体清洁剂或化学品。
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熟悉仪器

以下内容概述仪器控件和用户界面。

有关使用控件和用户界面来显示波形及进行测量的详细信息，请参阅仪器帮助。

前面板控件和连接器

前面板控件用于直接访问关键仪器设置，如垂直、水平、触发和光标。连接器是使用探头或电缆输入信号或
插入 USB 设备的位置。

图 3: 3 系列 MDO 控件

   

 

 

 

 

 

 

 

 

 
1. Acquisition（采集）和 Cursors（光标）控件：
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■ Run/Stop（运行/停止）开始和停止波形采集。按钮颜色可指示采集状态（绿色 = 正在运行和采集；
红色 = 已停止）。停止时，示波器将显示上次完成采集的波形。屏幕上的 Run/Stop（运行/停止）按钮
还可显示采集状态。

■ Cursors（光标）按钮可打开或关闭光标。使用多功能旋钮移动光标。双击光标读数或光标条（线）
打开配置菜单以设置光标类型和功能。

■ Fast Acq™（快速采集）可启用或禁用快速采集模式。FastAcq（快速采集）提供高速波形捕获功能，
可减少波形采集之间的死区时间，从而能够捕获和显示瞬态事件，如毛刺和欠幅脉冲。这有助于发
现难检的信号异常。快速采集模式还可以按反映其发生率的辉度显示波形现象。

■ Single/Seq（单次/序列）可标记单次波形采集或特定数量的采集（如 Acquisition（采集）配置菜单中
所设置）。按下 Single/Seq（单次/序列）按钮将关闭 Run/Stop（运行/停止）模式并进行单次采集。按
钮颜色可指示采集状态（绿色快速闪烁 = 捕获到单次采集；恒绿色 = 等待触发事件）。再次按下
Single/Seq（单次/序列）按钮将进行另一次采集。

■ High Res（高分辨率）模式为每个捕获间隔计算所有采样的平均值。High Res（高分辨率）模式提供
分辨率较高但带宽较低的波形。

■ Clear（清除）可从内存中删除当前采集和测量值。

2. 多功能旋钮：
 

 

■ 多功能旋钮（A、B）多功能旋钮 A 和 B 可移动光标并在配置菜单输入框中设置参数值。选择可使用
多功能旋钮的菜单字段时，将使所指示的旋钮更改此输入字段中的值。可使用旋钮执行操作时，该
旋钮周围的灯将亮起。

按下多功能旋钮可启用 Fine（微调）模式，用于进行细微更改。再次按下旋钮将退出 Fine（微调）
模式。

注意： 如果已经连接鼠标，按下鼠标滑轮可在 Coarse（粗调）和 Fine（细调）间切换。
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3. Trigger（触发）控件：
 

 

■ Force（强制）可在波形中任意点强制执行触发事件并捕获采集。

■ Level（电平）可设置信号必须通过以被视为有效过渡的幅度电平。Level（电平）旋钮的颜色可指示
双电平触发之外的其他触发源。当触发类型要求两种电平设置或其他触发限定时（从 Trigger（触发）
配置菜单设置），Level（电平）旋钮将被禁用。按下旋钮可将门限电平设置为信号峰峰值幅度范围
的 50%。

■ Slope（斜率）可设置触发的待检测信号过渡方向（由低到高、由高到低或者任意方向）。按下按钮可
循环显示选项。当触发类型要求其他斜率限定时（从 Trigger（触发）配置菜单设置），Slope（斜率）
按钮将被禁用。

■ Mode（模式）设置仪器在存在或不存在触发事件时的行为：

■ Auto（自动）触发模式供仪器采集并显示波形（不论是否发生触发事件）。如果发生触发事件，
仪器将显示稳定波形。如果未发生触发事件，仪器将强制触发事件和采集并显示不稳定的波形。

■ Normal（正常）触发模式将设置仪器在只有存在有效触发事件的情况下采集和显示波形。如果没
有任何触发，则显示屏将一直显示上一次采集的波形记录。如果上次未采集波形，则不显示波
形。
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4. Vertical（垂直）控件：
 

 

■ Position（位置）将在屏幕中上、下移动所选的波形及其刻度。Position（位置）旋钮的颜色指示旋钮
所控制的波形。按下此旋钮将波形手柄放在显示屏幕上的中心。

■ Scale（刻度）可设置所选波形每个垂直刻度格的幅度单位。标度值在波形标记上显示。Scale（刻
度）旋钮的颜色指示旋钮所控制的波形。

■ Channel（通道）按钮打开（显示）、选择或关闭通道，如下所示：

■ 如果未显示通道，按下 Channel（通道）按钮可在“波形”视图中打开该通道。

■ 如果在屏幕中显示但未选中通道，按下该通道按钮将选中该通道。

■ 如果在屏幕中显示且已选中通道，按下该通道按钮会将其关闭（将其从“波形”视图中删除）。

■ Math（数学）按钮在“波形”视图中添加或选择“数学”波形，如下所示：

■ 如果不存在“数学”波形，按下 Math（数学）按钮可向“波形”视图中添加“数学”波形并打开“数学”配
置菜单。

■ 如果已经显示但未选择“数学”波形，按下此按钮将选择“数学”波形。

■ 如果已经显示并选择“数学”波形，按下该按钮可关闭该“数学”波形（将其从“波形”视图中删除）。
再次按下该按钮可显示波形。

■ Ref（参考）按钮在“波形”视图中添加或选择“参考”（已保存）波形，如下所示：

■ 如果不存在“参考”波形，按下 Ref（参考）按钮可打开 Browse Waveform Files（浏览波形文件）配
置菜单。转到波形文件 (*.isf) 并选择，然后，点击 Recall（调出）加载和显示参考波形。

■ 如果只显示一个“参考”波形，按下该按钮可关闭该“参考”波形（将其从“波形”视图中删除）。再次
按下该按钮可显示波形。

■ 如果显示至少两个“参考”波形，按下该按钮可轮流选择每个“参考”波形。

■ Bus（总线）按钮在“波形”视图中添加或选择“总线”波形，如下所示：

■ 如果不存在“总线”波形，按下 Bus（总线）按钮可在“波形”视图中添加“总线”波形并打开“总线”配置
菜单。

■ 如果只显示一个“总线”波形，按下该按钮可关闭该“总线”波形（将其从“波形”视图中删除）。

■ 如果显示至少两个“总线”波形，按下该按钮可轮流选择每个“总线”波形。

■ RF（射频）按钮可在“波形”视图中添加射频波形，并从时域切换为频域。所有时域波形均关闭，频谱
分析仪启动。在切换回时域后，将恢复时域波形。

■ Digital（数字）按钮在“波形”视图中添加或选择数字波形

■ 如果为显示数字通道，按下 Digital（数字）按钮将在“波形”视图中打开通道。
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■ 如果在屏幕上显示但未选中数字通道，按下 Digital（数字）按钮将选择数字波形。

■ 如果在屏幕上显示并选中数字通道，按下 Digital（数字）按钮将关闭数字通道（将其从“波形”视
图中删除）。

5. Horizontal（水平）控件：
 

 

■ Position（位置）将波形从屏幕一侧移到另一侧（将更改波形记录中的触发点位置）。按下旋钮可将触
发事件居于刻度中心。

■ Scale（标度）设置示波器的每个主要水平刻度格的时间以及采样率参数。标度适用于所有波形。

6. 其他控件：
 

 

■ Touch Off（触摸关闭）按钮禁用触摸屏功能。在触摸屏熄灭时，Touch Off（触摸关闭）按钮亮起。

■ Save（保存）为一键保存操作，其使用当前 File > Save As（文件 > 另存为）设置保存屏幕截图（包括
打开菜单和对话框）、波形文件、仪器设置等，如下所示：

■ 如果在上次仪器启动后进行过 File > Save（文件 > 保存）或 File > Save As（文件 > 另存为）操作，
按下 Save（保存）可向上次在 Save As（另存为）配置菜单中设置的位置中保存文件类型。

■ 如果上次仪器启动后未发生过文件保存操作，按下 Save（保存）可打开 Save As（另存为）配置
菜单。选择一个选项卡以选择要保存的文件类型（截屏、波形等），设置任何相关参数以及保存
的位置，然后选择 OK（确定）。指定的文件将被保存。下次按下 Save（保存）时，将保存同一
类型的文件。

■ Screen Captures（截屏）将捕获整个屏幕，包括显示的配置菜单和对话框。

■ Default Setup（默认设置）可将示波器设置（水平、垂直、标度、位置等）恢复为默认设置。默认设
置不会更改“用户首选项”菜单中的项目。

■ Autoset（自动设置）可自动显示稳定的波形。
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7. 接地和探头补偿连接器：
 

 

■ 接地和探头补偿连接器位于仪器右下方的前面板附近。接地连接器（机箱中的小孔）提供一个电气
接地（通过电阻器）连接点，以便连接防静电腕带在您搬运或探测 DUT 时降低静电损坏 (ESD)。

■ 探头补偿连接提供一个接地连接器（上面的连杆）和 1kHz 方波源（下面的连杆），可用于调节无源
探头的高频率响应（探头补偿）。示波器使用该信号自动补偿支持的探头，包括产品附带的探头。请
参阅 补偿 TPP0250、TPP0500B 或 TPP1000 探头第33 页。

8. USB 主控端口 (USB 2.0)：
 

 

■ USB 端口位于前面板右下角和后面板上。连接可保存或调出数据（如仪器软件更新、波形、设置和
截屏）的 U 盘，或连接鼠标或键盘等外围设备。
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9. 探头连接器：
 

 

■ 模拟输入连接器支持所有 TekVPI+ 和 TekVPI 测量探头、BNC 无源探头、P6316 逻辑探头和 BNC 电缆。
请参阅 连接探头第 5 页。

后面板连接

后面板连接可为示波器供电并提供网络、USB 设备、视频、参考信号和 AFG 输出的连接器。
 

 

1. 电源线连接器。只能使用本产品专用并经所在国家/地区认证的电源线。

2. AFG Out 是可选任意函数发生器 (AFG) 的信号输出。

 熟悉仪器
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3. AUX Out 可针对触发事件生成信号跳变或从 AFG 输出同步信号。

4. LAN 连接器 (RJ-45) 将示波器连接 10/100 Base-T 局域网。

5. USB 设备端口用于连接 PC，以使用 USBTMC 协议远程控制示波器。

6. USB 主控端口用于连接 USB 闪存设备、键盘或鼠标。

7. HDMI 输出用于连接外部显示器或投影仪来显示示波器屏幕。

8. 安全锁连接器用于使用标准 PC/笔记本电脑锁电缆将示波器固定到工作台或其他位置。

用户界面屏幕

触摸屏用户界面包含波形、测量读数和可访问所有示波器功能的触摸型控件。

1. 菜单栏提供典型操作的菜单，这些操作包括：

■ 保存、加载和访问文件

■ 设置示波器显示和测量预置

■ 配置网络访问

■ 运行自检

■ 擦除测量和设置内存 (TekSecure™)
■ 加载选件许可

■ 打开帮助视图

2. Waveform View（波形视图）区域显示模拟、数字、数学、参考和总线波形。波形包括波形手柄（标识符）、
触发位置和电平指示器。请参阅 认识时域显示屏幕中的项目第17 页。

3. Results（结果）栏包含显示光标、向屏幕中添加结果表以及向 Results（结果）栏中添加测量的控件。控
件包括：

■ 光标按钮显示屏幕光标。通过触摸并拖动或使用多功能旋钮来移动光标。双击光标或光标读数打开
配置菜单以设置光标类型及相关功能。

■ 测量按钮将打开配置菜单，以便选择测量或向 Results（结果）栏中添加 多四种测量。所添加的每
个测量都包含单独的标记。双击测量标记打开其配置菜单。
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■ Results Table（结果表）按钮向屏幕中添加 Measurement Results（测量结果）、Bus Results（总线结果）
和 Search Results（搜索结果）和 Harmonics Results（谐波结果）表。“Measure”（测量）选项卡显示 Results

（结果）栏中出现的所有测量。“Bus”（总线）选项卡显示所显示总线波形的总线解码信息。“搜索”选项
卡显示搜索事件信息。“谐波”选项卡显示谐波测量结果。

■ 搜索按钮用于检测并标记发生特定事件的波形。点击搜索打开“搜索”配置菜单并设置模拟和数字通
道的搜索条件。“搜索”标记将被添加到 Results（结果）栏中。

■ 测量和搜索标记显示测量和搜索结果并在 Results（结果）栏中显示。请参阅 标记第22 页。

4. Settings（设置）栏包含设置“水平”、“触发”、“采集”和“日期/时间”参数的系统标记；用于打开通道的 Inactive
Channel（未激活通道）按钮；在显示屏中添加数学、参考和总线波形的 MathRef/Bus（数学/参考/总线）
按钮；以及用于配置各波形参数的“通道”和“波形”标记。点击通道或波形按钮将其添加到屏幕中并显示标
记。双击标记可打开其配置菜单。请参阅 标记第22 页。

5. Configuration Menus（配置菜单）用于快速更改所选用户界面项目的参数。可以通过双击标记、屏幕对象
或屏幕区域打开配置菜单。请参阅 配置菜单第27 页。

认识时域显示屏幕中的项目

每个用户界面区域都包含特定的功能，可帮助管理信息或控件。本主题介绍和说明主要用户界面元素。
 

 

 

1. Waveform Record View（波形记录视图）为图形化高级视图，包括整个采集、屏幕上的采集部分（在括号
内显示）、包括触发事件在内的主要时间事件位置以及当前波形光标位置。
 

 

如果您在示波器采集停止时更改水平时间标度，括号将改变位置，以显示正在查看的相对于当前采集总
记录长度的波形长度部分。
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如果波形上的光标处于活动状态，Waveform Record View（波形记录视图）会以短垂直虚线显示相关光标
位置。
 

 

处于 Zoom（缩放）模式时，Waveform Record View（波形记录视图）将会替换为 Zoom Overview（缩放概述）。
请参阅 缩放用户界面元素第28 页。

2. 波形视图中的扩展点图标将显示更改水平设置时波形进行缩放的中心点。
 

 

3. 触发位置指示器显示波形记录中发生触发事件的位置。
 

 

4. 缩放图标（位于波形和绘图视图右上角）可开启和关闭缩放。
 

 

5. 触发电平指示器图标显示触发源波形上的触发电平。某些触发类型需要两种触发电平。

6. Measurement（测量）和 Search（搜索）标记显示测量和搜索结果。请参阅 标记第22 页。

7. 结果栏手柄可打开或关闭 Results（结果）栏，以根据需求 大化波形屏幕视图。要重新打开 Results（结
果）栏，请点击手柄图标或从显示器右侧向左滑动。

8. System（系统）标记显示全局仪器设置（Horizontal（水平）、Trigger（触发）、Acquisition（采集）、Run/
Stop（运行/停止）状态和 Date/Time（日期/时间））。请参阅 标记第22 页。

9. Inactive Channel（未激活通道）按钮向“波形”视图中添加通道波形并向“设置”栏中添加相关通道标记。

Add Math Ref Bus（添加新数学、添加新参考、添加新总线）按钮展开，以便向波形视图中添加数学、参
考或总线波形并向 Settings（设置）栏中添加相关波形标记。

RF（射频）按钮激活频域显示屏幕并添加射频标记。双击标记打开射频配置菜单以便配置射频输入。仅
在已启用一个 RF 选件时，此按钮才有效。

AFG 按钮可打开 AFG 配置菜单以设置和启用 AFG 输出。此按钮仅在装有 AFG 选件时显示。

DVM 按钮用于使用模拟探头在 DUT 上进行 DC、AC RMS 或 DC+AC RMS 电压测量。点击该按钮向 Results
（结果）栏中添加 DVM 标记并打开配置菜单。DVM 选件还可启用触发频率计数器，可通过 Trigger（触发）
标记菜单下的 Mode & Holdoff（模式和释抑）面板进行访问。此按钮仅在装有 DVM 选件时显示。

10. 双击标记可打开其相关配置菜单。请参阅 标记第22 页。请参阅 配置菜单第27 页。
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如果所添加的通道或波形标记超过波形标记区域的显示范围，请点击波形标记区域边缘的滚动按钮滚动
并显示隐藏标记。

11. 各波形上的波形手柄确定波形源（Cx 为通道，M 为波形，Rx 为参考波形，Bx 为总线波形）。波形手柄默
认位于波形零电压电平位置。当前选中的波形手柄为实色；而未选中的波形手柄为虚色。

双击波形手柄可打开该波形的配置菜单。

对于数字通道，波形手柄显示通道编号，每个数字信号带 D0–D15 标记并使用不同颜色显示。
 

 

双击数字波形手柄可打开数字通道配置菜单。

如果将一个信号手柄拖放在另一手柄上，将交换信号在波形视图中的位置。将数字信号手柄拖出组后，
会创建一个新组。可以使用“垂直位置”控件移动选定的数字组或信号手柄。

认识频域显示屏幕中的项目

此主题显示并介绍频域显示屏幕中的各元素。

要激活频域显示屏幕，请按下前面板 RF（射频）按钮或点击显示屏幕中的“射频”按钮。

每个用户界面区域都包含特定的功能，可帮助管理信息或控件。

 熟悉仪器
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1. 垂直刻度标记

2. 起始频率

3. 参考电平

4. 垂直刻度

5. 中心频率

6. 频宽和分辨率带宽

7. 截止频率

8. 参考标记
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9. 所显示的迹线指示

a. RF 迹线指示位于“参考电平”处。

b. 大写 M 在开启 大迹线的情况下显示。

c. 大写 A 在开启平均迹线的情况下显示。

d. 大写 N 在开启正常迹线的情况下显示。

e. 小写 m 在开启 小迹线的情况下显示。

高亮橙色指示当前选定的迹线。图中高亮的小写 m 表示 小迹线。这表示当前选择了 小迹线。

10. 正常迹线：每次采集随着新数据的采集而被丢弃。

11. 大值保持迹线：多次采集的“正常”迹线的 大数据值的累计值。

12. 小值保持迹线：多次采集的“正常”迹线的 小数据值的累计值。

13. 平均迹线：多次采集的“正常”迹线的数据的平均值。这是对有效功率求平均值，在对数转换前进行。对每
个 2 的幂求平均值会将显示的噪声减少 3 dB。
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标记
标记为显示波形、测量以及仪器设置或读数的矩形窗图标。标记还可用于快速访问配置菜单。标记类型包括
通道、波形、测量、搜索和系统。

通道和波形标记
通道和波形（数学、参考、总线）标记位于屏幕左下方的设置栏中。每个波形都有自己的标记。这些标记显
示每个所显示通道或波形的高级设置。双击标记可打开其配置菜单。
 

 

大多数通道和波形标记还包含垂直刻度按钮。可通过点击标记显示这些按钮。使用这些按钮可增加或减小
该波形的垂直刻度设置。
 

 

您可以将通道和波形标记向下拖出或滑出显示屏幕以便关闭。如果意外删除，从显示屏幕底部上滑即可将其
恢复。

通道标记按通道顺序列出。有关更多信息，请双击标记以打开其配置菜单或在仪器“帮助”中搜索。

测量标记
结果标记位于结果栏中。这些标记将显示测量结果或搜索结果。标记标题还可显示测量源。要添加测量标
记，请点击 Measurement（测量）按钮，选择测量并点击添加。
 

 

双击测量标记打开其配置菜单以更改或调整设置。
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一些测量及其标记仅用作选件。例如，只有安装 PWR 选件后，功率测量才会在 Add Measurement（添加测量）
菜单中列出。
 

 

要向各测量标记中添加统计读数，请双击测量标记打开其配置菜单并选择 Show Statistics in Badge（在标记中
显示统计数字）。

 

 

您可以将“测量”标记向右拖出或滑出显示屏幕以便将其删除。从右侧滑入即可恢复标记。

搜索标记
搜索标记显示在“结果”栏中的“测量值”标记下面。搜索标记列出当前采集中的搜索源、搜索类型和搜索事件的
数量。仪器使用小倒三角沿着波形刻度线的顶部标记发生这些事件的波形。双击搜索标记打开其配置菜单
以更改或调整搜索设置。

 

 

点击搜索按钮搜索已创建的标记。使用所显示的配置菜单设置搜索条件。
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搜索标记包含 <（上一个）和 >（下一个）导航按钮，可打开缩放模式并将波形在显示中按波形记录中上一
个或下一个搜索标记的位置居中。仅在已停止采集时，搜索标记导航按钮才可用。
 

 

您可以将“搜索”标记向右拖出或滑出显示屏幕以将其删除。从右侧滑入即可恢复标记。

信号限幅和标记
限幅会造成幅度相关的测量结果不准确。限幅还会造成已保存波形文件中的幅度值不准确。如果数学波形
被限幅，则不会影响该数学波形上的幅度测量。

警告： 探头端部电压过高或危险和/或垂直刻度设置不足以显示波形的整个垂直范围会导致限幅。探头端部
电压过高可能导致操作人员受伤并损坏探头和/或仪器。

当存在垂直限幅情况时，该仪器将在通道标记中显示警告三角形符号和“限幅”一词。此通道的所有相关测量
标记也指示限幅情况。

 

 

要关闭限幅消息，请更改垂直刻度以显示整个波形，将探头端部与过高电压源断开并确认您正使用合适的探
头探测合适的信号。
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错误消息和标记
发生错误时，此仪器在通道标记中显示警告三角形符号和错误消息缩写。
 

 

要从标记中删除消息，请清除错误。

系统标记
System（系统）标记（位于 Settings（设置）栏）显示主要的 Horizontal（水平）、Trigger（触发）和 Acquisition
（采集）设置。无法删除 System（系统）标记。

 

 

双击“系统”标记以打开其配置菜单。

水平标记还包含“刻度”按钮，可通过单击标记显示。使用“水平刻度”按钮可增加或减小水平时间/格设置。
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常用标记操作

操作 结果 示例

单击 立即访问控件（刻度、导航）。 

 
双击 可访问标记所有设置的“配置”

菜单。

 

 
触摸并按住 点击一下即可访问常用操作的

右键菜单。典型操作包括关闭
通道以及删除测量或搜索标
记。
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配置菜单
配置菜单用于快速设置通道、系统设置（“水平”、“触发”、“采集”）、测量、光标读数、波形等参数。

双击一个项目（标记、Waveform View（波形视图）、光标读数等）以打开其配置菜单。例如，双击设置栏中
的通道标记以打开其配置菜单。
 

 

所输入的选项或值将立即生效。菜单内容是动态的，可能会根据所选内容、仪器选件或附带探头发生变化。

相关设置均被分入“面板”组。点击面板名称显示这些设置。面板设置更改可能会更改该面板及其他面板中所
显示的值和/或字段。
 

 

点击配置菜单外任何地方将其关闭。

要打开配置菜单的“帮助”内容，请点击菜单右上角的问号图标。
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缩放用户界面元素

使用缩放工具放大波形以查看信号详细信息。
 

 

1. Zoom Overview（缩放概述）显示整个波形记录。

注意： 在“缩放概述”波形中使用捏拉和松开手势将更改水平时基设置。

2. Zoom Box（缩放框）显示要在缩放视图中显示的缩放概述的区域（请参阅  4）。您可以触摸并拖动该框来
移动查看区域。

注意： 移动缩放框或更改其位置不会更改水平时基设置。

3. Zoom（缩放）图标（位于 Waveform View（波形视图）右上角）用于打开和关闭缩放模式。

4. Zoom View（缩放视图）将显示缩放框所标记的缩放波形。在缩放视图中使用捏拉和/或拖动选项来更改感
兴趣的缩放区域。

注意： 在缩放视图中使用手指开合和/或拖动选项手势只会更改缩放设置和缩放框位置。

5. 使用 Zoom Title Bar（缩放标题栏）控件调整缩放区域的水平尺寸和位置。单击或点击 + 或 - 按钮或使用 A
和 B 多功能旋钮。双击缩放标度和位置字段，使用数字键盘输入值。

注意： 使用多功能旋钮调节缩放前，触摸 Zoom Position（缩放位置）或 Horizontal Zoom Scale（水平缩放
标度）字段。
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使用触摸屏界面处理常规任务
使用类似于智能手机和平板电脑的标准触摸屏操作与大多数屏幕对象进行互动。您还可以使用鼠标与 UI 互
动。每个触摸操作的功能等同于鼠标操作。

请参阅下表快速了解基本的触摸操作。

 

表 3: 常见的触摸屏 UI 任务（包括与鼠标等同的功能）

任务 触摸屏 UI 操作 鼠标操作

向屏幕中添加通道以及数学、参考
和总线波形。

点击 Inactive Channel（未激活通道）
按钮或 Add Math Ref Bus（添加新数
学、添加新参考、添加新总线）按
钮并选择数学、参考或总线。

单击 Inactive Channel（未激活通道）
或 Add Math Ref Bus（添加新数学、
添加新参考、添加新总线）按钮并
选择数学、参考或总线。

选择通道、数学、参考或总线波形，
使其处于活跃状态。

点击通道或波形标记或者波形手
柄。

单击通道或波形标记或者波形手
柄。

在标记上显示刻度或导航按钮（波
形、测量

 1、搜索、水平）。
点击标记。 单击标记。

打开任何项目中的配置菜单（所有
标记、视图、光标读数、标签等）。

双击标记、视图或其他对象。 双击标记、视图或其他对象。

打开右键菜单（标记、视图）。 触摸并按住标记、“波形”视图或其他
屏幕项目直至菜单打开。

右键单击项目。

关闭配置菜单 2。 点击菜单或对话框外任何地方。 单击菜单或对话框外任何地方。

移动菜单。 触摸并按住菜单中的菜单标题栏或
空白区域，然后，将菜单拖到新位
置。

在标题或空白区域中单击并按住鼠
标左键，然后，拖到新位置。

在波形上直接更改水平或垂直设
置。
垂直更改仅适用于所选通道或波
形；水平更改适用于所有通道和波
形。

点击标记并使用“标度”按钮。或者，
使用捏拉/松开手势。

单击通道、波形或水平标记，然后，
单击“刻度”按钮。

增大或缩小缩放区域（在缩放模式
下）。

在波形视图上触摸并按住两个手
指，一起移动或者垂直或水平分开，
从屏幕上离开，如此重复操作。

单击并拖动缩放区域。
单击缩放标题栏中的 + 或 - 按钮。

调整缩放位置（在缩放模式下）。 触摸并拖动缩放区域以调整缩放的
位置。

单击并拖动缩放区域以调整缩放的
位置。

快速滚动或平移波形。 触摸并拖动波形。 单击并拖动波形或列表。

关闭或打开 Results Bar（结果栏）
以增加 Waveform View（波形视图）
区域。

点击结果栏手柄或波形视图与结果
栏之间边界上的任何地方。

单击结果栏手柄或波形视图与结果
栏之间边界上的任何地方。
单击并拖动结果栏分割线。

1 并非所有测量或搜索标记都显示导航按钮。
2 某些对话框只有在单击“确定”、“关闭”或其他按钮的情况下才会关闭。
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配置仪器

设置日期和时间
设置日期和时间使已保存文件标有正确的日期和时间信息。

1. 双击 Date/Time（日期/时间）标记（屏幕右下方）打开配置菜单。
 

 

2. 要停止在屏幕上显示日期和时间，请点击以便将显示按钮设为关。

要再次打开日期/时间显示，请双击日期/时间标记的显示屏幕的空白区域打开配置菜单，然后，将显示按
钮设为开。

3. 您也可以点击 Year（年）、Day（日）、Hour（小时）或 Minute（分钟）或者 UTC 偏置字段并使用多功能旋
钮将这些字段设为正确时间。

您也可以双击这些字段并使用数字键盘设置时间。

4. 点击月并从列表中选择月份。

5. 点击菜单外任何位置将其关闭。
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下载并安装 新固件

安装 新估计有助于确保仪器配有所有可用的 佳测量和分析改进项。

前提条件：将所有重要的仪器文件（波形、截屏、示波器设置等）保存到 U 盘或网络。在安装过程中，不会
删除用户创建的文件，但是， 好在更新前备份重要文件。

从 U 盘更新示波器固件

前提条件：确定示波器上已安装的当前固件版本（Help（帮助）> About（关于））

1. 打开 PC 中的 Web 浏览器并访问 www.tek.com/product-support。

2. 在搜索字段中输入示波器型号并单击 Go（前往）。

3. 向下滚动屏幕并单击 Software（软件）选项卡。

4. 如果列出的可用固件版本高于示波器中的版本，请选择并下载该文件到您的 PC。

5. 将固件安装文件复制到 U 盘。

6. 将 U 盘插入任何示波器 USB 主控端口：

7. 关闭示波器电源，然后打开示波器电源。

注意： 在示波器完成固件安装前，请勿关闭示波器电源或移除 U 盘。示波器将在可以关闭示波器时显示
一条消息。

示波器将检测到含固件文件的 U 盘并开始安装过程。按照屏幕说明安装固件。

8. 完成固件安装后，请移除 U 盘并重启示波器。

要确认固件安装，请执行以下操作：

a. 在菜单栏中点击 Help（帮助）> About（关于）。

b. 请确认屏幕上列出的固件版本号与已下载的版本相同。

运行信号路径补偿 (SPC)
定期运行 SPC，以获得 佳测量精度。每当环境（室内）温度变化超过 5℃ (9℉) 时都应执行 SPC，如果使用
5 毫伏/格或更低的垂直刻度设置，则应每周执行一次 SPC。

信号路径补偿 (SPC) 修正温度变化和/或长期信号路径漂移引起的内部信号路径的直流电平误差。如果无法
定期运行 SPC，可能导致示波器不能达到低伏/格设置时所保证的性能水平。

前提条件：从前面板通道输入和后面板信号连接器断开所有探头和电缆。

1. 打开示波器电源并预热至少 20 分钟。

2. 点击 Utility（辅助功能）> Calibration（校准）。

3. 点击 Run SPC（运行 SPC）。SPC 运行时 SPC Status（SPC 状态）读数显示 Running（正在运行）。SPC 在
每个通道需要数分钟的运行时间，因此请等待直到 SPC Status（SPC 状态）消息更改为 Pass（通过）才能
重新连接探头和使用示波器。

4. 请在完成 SPC 时关闭 Calibration（校准）配置对话框。

5. 如果 SPC 失败，请记下所有错误消息文字内容。确认已断开所有探头和电缆，然后重新运行 SPC。如果
SPC 仍然失败，请联系泰克客户支持部门。
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补偿 TPP0250、TPP0500B 或 TPP1000 探头
探头补偿将调整探头的高频率响应，以获得 佳波形捕获和测量精度。示波器可自动测试和存储 TPP0250、
TPP0500B 和 TPP1000 探头的补偿值。

示波器存储每个探头/通道组合的补偿值并在再次插入探头时自动调出补偿值。探头补偿状态在“通道”配置菜
单的“探头设置”面板中显示。

■ 如果 Probe Compensation Status（探头补偿状态）字段显示 Pass（通过），则探头已被补偿并可以使用。

■ 如果 Probe Compensation Status（探头补偿状态）字段显示 Default（默认），则所连接的探头不会得到补偿
并需要运行该探头补偿程序。

■ 如果 Probe Compensation Status（探头补偿状态）字段显示 Fail（失败），则对所连接的探头运行探头补偿
程序失败。重新连接探头并再次运行探头补偿。

■ 如果面板中未显示探头补偿状态字段，则示波器无法存储该探头的补偿值。请参阅示波器帮助以了解如
何手动补偿探头补偿功能不支持的无源探头。

■ 每次补偿均为特定探头和通道组合生成对应的值。如果您想在其他通道上使用探头并补偿新的探头-通
道组合，则必须重新执行一组补偿步骤。

■ 每条通道能存储 10 个探头的补偿值。如果尝试在通道上补偿第 11 个探头，示波器将删除 早使用的探
头的值，然后，添加新探头的值。

使用此过程补偿连接示波器时显示默认状态的 TPP0250、TPP0500B、TPP1000 或其他支持的 TPP 系列探头。

注意： 默认设置不会删除探头补偿值。出厂校准将删除存储的所有探头补偿值。

前提条件：示波器必须通电至少 20 分钟以上才能补偿探头。

1. 将支持的探头连接输入通道。

2. 将探头端部和探头的接地导线连接示波器右下方的探头补偿终端（如下图所示）。

图 4: 探头补偿连接。

将探头端部连接 1 kHz 信号源并将接地夹接地。为获得 佳效果，请取下所有探头端部附件并将探头端部
直接连接 1 kHz 连接器。

注意： 每次只能将一个探头连接探头补偿终端。

3. 关闭所有通道。

4. 打开与探头连接的通道。

5. 按前面板 Autoset（自动设置）按钮。屏幕显示一个方波。

6. 双击要补偿的通道的标记。

 配置仪器
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7. 点击探头设置面板。

如果 Probe Compensation Status（探头补偿状态）为通过，则探头已补偿该通道。您可以将探头移到另一个
通道并从第 1 步重新开始操作，或者，将不同的探头连接该通道并从第 1 步开始操作。

如果 Probe Compensation Status（探头补偿状态）为默认，请继续该过程。

8. 点击 Compensate Probe（补偿探头）打开 Probe Compensation（探头补偿）对话框。

9. 点击 Compensate Probe（补偿探头）运行探头补偿。

10. 当 Probe Compensation Status（探头补偿状态）显示 Pass（通过）时，探头补偿将完成。从 Probe Comp（探
头补偿）终端拔下探头端部和地线。

11. 为要补偿该通道的所有支持的无源探头重复这些步骤。

12. 重复这些步骤补偿示波器其他通道所支持的探头。

注意： 为了进行 准确的测量，每当将探头连接到通道时，请打开探头设置面板并确认 Probe Compensation
Status（探头补偿状态）为通过。

注意： 探头补偿失败的 常见原因是在探头补偿操作过程中探头端部或接地连接出现间歇性中断。如果
失败，示波器将重新使用旧探头补偿值（如果它们在失败的探头补偿操作前已经存在）。

连接网络 (LAN)
连接到网络可以远程访问仪器。

向您的网络管理员获取所需的信息以连接到网络（IP 地址、网关 IP 地址、子网掩码、DNS IP 地址等）。

1. 将示波器 LAN 连接器的 CAT5 电缆连接到您的网络。

2. 在菜单栏上选择辅助功能> I/O 以打开 I/O 配置菜单。

3. 点击 LAN 面板

4. 获取或输入网络地址信息：

■ 如果网络已经启用 DHCP 且 IP 地址字段未显示地址，请点击自动获取此网络的 IP 地址信息。DHCP
模式为默认模式。

■ 如果网络未启用 DHCP 或者需要为该仪器设置静态（不变的）IP 地址，请点击手动并输入 IT 或系统
管理员提供的 IP 地址及其他值。

5. 点击 Test Connection（测试连接）以确认网络连接正常工作。仪器成功连接网络后，LAN 状态图标将变为
绿色。如果在连接网络时遇到问题，请联系系统管理员以获取帮助。

配置仪器  

34  MDO32、MDO34 安装和安全手册



EMC 安全和环境合规性

合规性信息

此部分列出仪器遵循的 EMC（电磁兼容性）、安全和环境标准。本产品仅供专业人员和受过培训的人员使用；
不得在家中或供儿童使用。

如果对以下合规性信息存在疑问，可以联系以下地址：

Tektronix, Inc.

PO Box 500, MS 19-045

Beaverton, OR 97077, USA

www.tek.com

EMC 合规性

EU EMC 指令

符合 Directive 2014/30/EU 有关电磁兼容性的要求。已证明符合《欧洲共同体公报》中所列的以下技术规格：

EN 61326-1、EN 61326-2-1. 测量、控制和实验室用电气设备的 EMC 要求。  1 2 3 4

■ CISPR 11。放射和传导辐射量，组 1，A 类

■ IEC 61000-4-2。对静电放电的抗干扰能力

■ IEC 61000-4-3。对射频电磁场的抗干扰能力

■ IEC 61000-4-4。对电快速瞬态/突发性的抗干扰能力

■ IEC 61000-4-5。对电源线电涌的抗干扰能力

■ IEC 61000-4-6。对传导射频的抗干扰能力

■ IEC 61000-4-11。对电压骤降和中断的抗干扰能力

EN 61000-3-2. 交流电源线谐波辐射

EN 61000-3-3. 电压变化、波动和闪变

1 本产品仅在非居民区内使用。在居民区内使用可能造成电磁干扰。
2 当该设备与测试对象连接时，可能产生超过此标准要求的辐射级别。
3 测试导线和/或测试探头由于电子干扰耦合而发生连接时，设备可能无法满足所列适用标准的抗干扰能力要求。为了将电磁干扰的影响降到

低，需 小化信号无屏蔽部分与关联返回导线之间的环路面积，同时尽量让导线远离电磁干扰源。将未屏蔽的测试导线缠绕在一起是减小环
路面积的有效方法。探头方面，需要使接地回路导线的长度尽可能得短，并靠近探头主体。为了 有效地达到这一目的，一些探头配备了附
件探头端部适配器。在一切情况下，都应遵守所用探头或导线的所有安全说明。

4 为确保符合上面列出的 EMC 标准，应使用在电缆护套和连接器外壳间包含低阻抗连接的高质量屏蔽接口电缆。
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澳大利亚/新西兰一致性声明 – EMC
根据 ACMA，符合《无线电通信法》有关 EMC 规定的以下标准：

■ EN 61326-1 和 EN 61326-2-1。放射和传导辐射量，组 1，A 类。

安全标准

本部分列出了产品遵循的安全标准及其他安全合规性信息。

EU 一致性声明 – 低电压
经证明符合《欧盟官方公报》中所列的以下技术规格：

低电压指令 2014/35/EU。

■ EN 61010-1。 测量、控制和实验室用电气设备安全要求 – 第 1 部分：总体要求。

■ EN 61010-2-030。 测量、控制和实验室用电气设备安全要求 – 第 2-030 部分：关于测试和测量电路的特殊
要求。

美国国家认可的测试实验室列表

■ UL 61010-1。 测量、控制和实验室用电气设备安全要求 – 第 1 部分：总体要求。

■ UL 61010-2-030。 测量、控制和实验室用电气设备安全要求 – 第 2-030 部分：关于测试和测量电路的特殊
要求。

加拿大认证
■ CAN/CSA-C22.2 No. 61010-1。 测量、控制和实验室用电气设备安全要求 – 第 1 部分：总体要求。

其他合规性

■ IEC 61010-1。 测量、控制和实验室用电气设备安全要求 – 第 1 部分：总体要求。

■ IEC 61010-2-030。 测量、控制和实验室用电气设备安全要求 – 第 2-030 部分：关于测试和测量电路的特殊
要求。

设备类型

测试和测量设备。

安全级别
1 级 – 接地产品。

污染度说明

对产品周围和产品内部环境中可能出现的污染的一种量度。通常认为产品的内部环境与外部环境相同。产
品只应该在其规定环境中使用。

■ 污染度 1。无污染或仅发生干燥、非导电性污染。此类别产品通常予以封装、密封或被置于干净的房间
中。

■ 污染度 2。通常只发生干燥、非导电性污染。偶尔会发生由凝结引起的临时传导。典型的办公室/家庭环
境属于这种情况。只有当产品处于非使用状态时，才会发生临时凝结。

■ 污染度 3。导电性污染，或干燥、非导电性污染，由于凝结后者会变成导电性污染。此类场所为温度和
湿度不受控制的建有遮盖设施的场所。此类区域不受阳光、雨水或自然风的直接侵害。

■ 污染度 4。通过传导性的尘埃、雨水或雪产生永久性可导性的污染。户外场所通常属于这种情况。
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污染度评级
污染度 2（如 IEC 61010-1 中定义）。注：仅适合在室内的干燥场所使用。

IP 额定值
IP20（如 IEC 60529 中定义）。

测量和过压类别说明

本产品上的测量端子可能适合测量以下一种或多种类别的市电电压（请参阅产品和手册中标示的具体额定
值）。

■ 测量类别 II。用于在与低电压安装直接相连的电路上执行的测量。

■ 测量类别 III。用于在建筑安装中执行的测量。

■ 测量类别 IV。用于在低电压安装电源处执行的测量。

NOTE. 仅市电电源电路具有过压类别额定值。仅测量电路具有测量类别额定值。产品中的其他电路不具有其
中任何一种额定值。

主线过压类别额定值
过压类别 II（如 IEC 61010-1 中定义）

环境合规性

本部分提供有关产品对环境影响的信息。

有害物质限制

符合 RoHS2 指令 2011/65/EU。

产品报废处理

回收仪器或器件时，请遵守下面的规程：

设备回收. 生产本设备需要提取和使用自然资源。如果对本产品的报废处理不当，则该设备中包含的某些物
质可能会对环境或人体健康有害。为避免将有害物质释放到环境中，并减少对自然资源的使用，建议采用适
当的方法回收本产品，以确保大部分材料可以得到恰当的重复使用或回收。

此符号表示该产品符合欧盟有关废旧电子和电气设备 (WEEE) 以及电池的 2012/19/EU 和 2006/66/
EC 号指令所规定的相关要求。有关回收选项的信息，请登录泰克网站 (www.tek.com/
productrecycling) 查看。

高氯酸盐材料. 此产品包含一个或多个 CR 型锂电池。按照加州规定，CR 锂电池被归类为高氯酸盐材料，需
要特殊处理。详情参阅 。

 EMC 安全和环境合规性
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Index
A
A 旋钮, 9
Acquisition（采集）控件, 9
AFG

选件, 17
AFG out（后面板）, 15
Autoset（自动设置）

按钮, 9
AUX Out

后面板, 15

B
B 旋钮, 9
Bus（总线）按钮, 9

C
Channel（通道）按钮（前面板）, 9
Clear（清除）按钮, 9
Cursors（光标）按钮, 9
Cursors（光标）按钮（触摸屏）, 16

D
Default Setup（默认设置）按钮, 9
DVM 选件, 17

E
e*Scope, 6

F
Fast Acq（快速采集）按钮, 9
Force（强制）按钮, 9

G
GPIB 发/收地址, 7

H
HDMI 输出（后面板）, 15

High Res（高分辨率）按钮, 9
Horizontal（水平）控件, 9

L
LAN 端口（后面板）, 15
LAN，连接到, 34
Level（电平）旋钮, 9
LXI, 6

M
Math（数学）按钮, 9
Measure（测量）按钮, 16
Mode（模式）按钮（前面板）, 9

P
position（位置）

旋钮, 9
旋钮（水平）, 9

R
Ref（参考）按钮, 9
Results Table（结果表）按钮, 16
RM3 机架安装, 6
Run/Stop（运行/停止）按钮, 9

S
Save（保存）按钮, 9
Scale（刻度）旋钮, 9
Scale（刻度）旋钮（水平）, 9
Search（搜索）按钮, 16
Single/Seq（单次/序列）按钮, 9
Slope（斜率）按钮（前面板）, 9
SPC（信号路径补偿）, 32

T
TekVPI 输入连接器, 9
Touch Off（触摸关闭）按钮, 9
Trigger（触发）控件, 9
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U
USB 主控端口（后面板）, 15
USB 电缆，连接到 PC, 7
USB 端口（前面板）, 9
USB 设备端口（后面板）, 15

V
Vertical（垂直）控件, 9

W
Waveform View（波形视图）, 16
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